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Preface

Audience
Anyone who uses the Action Request System (AR System) client tools will be
interested in the information in this manual. It describes the operations that are
performed regularly by those using:

• The User Tool.

• The Notification Tool.

It assumes familiarity with UNIX and Motif environments and mouse and
menu-driven applications on UNIX workstations.

Overview of this Document
Chapter 1, Overview of the Action Request System, provides a general
description of Action Request System Tools and how they are used.

Chapter 2, Getting Started with the User Tool, tells you how to start and be
productive with the User Tool. (See Chapter 8, Using the Notification Tool, for
information on using the Notification Tool.)

Chapter 3, Submitting an Action Request, tells you how to submit a new
action request (AR) to the Action Request System database.

Chapter 4, Reviewing and Modifying Action Requests, tells you how to
perform queries to retrieve specific ARs and list, review, modify, or delete
them.
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Chapter 5, Reports, describes how you can generate reports and statistics from
the AR System database. The chapter also includes a discussion of full text
search (FTS).

Chapter 6, Using Macros, tells you how to use the macro facility to automate
operations.

Chapter 7, Customizing the Environment, tells you how to personalize your
view of AR System schemas and how to set field properties and defaults.

Chapter 8, Using the Notification Tool, tells you how to start and use the
Action Request System Notification Tool.

Chapter 9, Using Electronic Mail, tells you how to use electronic mail to
submit action requests and receive notifications.

Appendix A, Command Line Options, tells you how to use command line
options to start the User Tool.

Appendix B, Changing Colors and Fonts, describes how to change the colors,
fonts, and other behaviors of the User Tool and Notification Tool.

Appendix C, AR System File Locations, describes how to change the colors,
fonts, and other behaviors of the User Tool and Notification Tool.

Appendix D, Procedures, describes a list of procedures.

Glossary, lists and describes terms that you will need to be familiar with as
you use the AR System.

Action Request System Documents
The Action Request System Installation Guide is a guide to installing the AR
System software for all operating environments. There are separate installation
chapters in the guide for the UNIX and Windows NT environments.

The Action Request System User’s Guide (this guide) is a how-to description of
the operations performed by all users of the AR System. There are separate
User’s Guides for environments supporting the Motif, Macintosh, and
Windows graphical user interfaces (GUIs) and for ASCII terminals.
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The Action Request System Getting Started Guide and Sample
Schemas provides an online demonstration showing the use of the AR System
in a sample help desk environment and describes how you can use the sample
schemas provided with the AR System.

The Action Request System Administrator’s Guide describes how the AR System
Administrator can use the Administrator Tool to set up the AR System and
define its local operations. This manual is also a reference of advanced AR
System concepts. There are separate Administrator’s Guides for the UNIX and
Windows environments.

The Action Request System Programmer’s Guide is a reference guide for
programming with the application programming interfaces (APIs) that come
with the AR System.

The Action Request System Troubleshooting and Error Messages Guide provides
information to help you identify and solve problems with the AR System.

The Action Request System Distributed Server Option Administrator’s Guide
provides information about operating the AR System in a distributed, multi-
server environment. Included are instructions for creating all of the necessary
mappings and filters that you use along with the Distributed Server Option to
keep AR System entries synchronized across multiple servers.

The Action Request System Help Desk Template Guide describes the Helpdesk
application that runs in conjunction with the AR System to help you manage
your internal help desk organization. The template takes full advantage of the
rich feature set of the AR System and implements workflow and reporting
mechanisms to simplify the task of working in or managing a help desk.

The ARWeb Administrator’s Guide provides details about installing, using, and
customizing the ARWeb application, so that you can provide access to your
company’s AR System applications through the World-Wide Web.

The Action Request System Workflow Demonstration and Guide to Sample Schemas
leads you through an online demonstration showing the use of the AR System
in a sample help desk environment and describes how you can use the sample
schemas supplied with the AR System.

The Action Request System Help Desk Template Guide describes the Help Desk
application that runs in conjunction with the AR System to help you manage
your internal help desk organization.
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The Action Request System Accessories binder provides a place to keep
documentation for utilities and peripheral add-ons to the AR System. As
shipped, the Accessories binder includes the documentation for the Network
Management Platforms Integration Accessory.

Conventions Used in this Manual
bold font

Indicates that a word is a new or important term.
Example: filters.

Initial Caps
Button and menu names and items have the first letter capitalized.
Example: File.

computer font
Indicates computer output, including UNIX prompts, an explicit directory, or a
file name.
Example: prompt%.
Indicates data to be entered by the user.
Example: aruser & .

<small italic  font>
Indicates a variable directory, file name, or string that you replace with an
appropriate directory, file name, or string.
Example: <ar_config_dir>.

italics
Indicates a reference to another manual or to a different section within the
current manual.
Example: see Action Request System Documents.
Italic type is also used for emphasis.
Example: All users will be affected.
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Overview of the Action Request
System 1

The Action Request System (AR System) provides you with all of the tools
you need to quickly and easily manage support requests and problems. Using
the AR System, your AR administrator can create a flexible, customizable
workflow process for you. As you make entries into the AR System, you are
automatically capturing a database of problem solving experience. You can
efficiently track and report a variety of issues, information, and problems. Both
end users and support staff can take advantage of the interactive access to the
AR System database.

This chapter introduces all users to the concepts and features of the AR
System. It provides an overview of:

• The roles that various people play in the operation of the AR System.

• The tools provided by the AR System.

• The activities that users of the AR System are involved in.

AR System Users
There are four types of users who are involved with the operations of the AR
System:

• AR System administrators.

• AR System subadministrators.

• Support staff.
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• End users.

AR System administrators are responsible for the management of the AR
System. They set up database schemas (the definitions of AR System
databases), set access rights for users, and design the workflow process.

AR System Subadministrators are responsible for the set up, design, and
access rights of a given set of schemas as permitted by the AR System
Administrator.

Members of the support staff resolve action requests (ARs) using the AR
System as set up by the AR System administrator. They assign and are
assigned ARs, and log their progress in the appropriate fields. Support staff
members are able to use information stored in previous ARs to avoid
redundant effort and to expedite the resolution of current ARs.

End users are individuals with problems and support requests who initiate
ARs. End users ideally have direct access to the AR System, although it is not a
requirement. End users with direct access submit ARs using the User Tool.
Users without direct access may use electronic mail templates generated by
their AR administrator to submit ARs or they may simply place a trouble call
to a support staff member who initiates the AR.

AR System Tools
The Action Request System provides four tools that help administrators,
support staff, and end users perform their jobs: the User Tool, the Notification
Tool, the Administrator Tool, and the Import Tool.

User Tool

The User Tool is generally used by everyone involved in the workflow process.
It allows you to:

• Submit ARs describing problems or support requests.

• Query AR databases either for information or to keep track of previously
submitted ARs.

• Modify one or multiple previously submitted ARs.

• Report on and calculate statistical information on ARs that share similar
query criteria (information).
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• Delete ARs (if you are an AR System administrator or subadministrator).

• Create user commands.

• Run user and administrator commands.

• Create macros.

• Run user macros to help automate the steps involved in complex queries
and other operations.

• Customize schema view.

• Define field values.

The User Tool is described in this document.

Notification Tool

Like the User Tool, the Notification Tool can be used by anyone involved in the
workflow process. The Notification Tool provides a means of alerting users of
progress being made in the resolution of an action request. Through filters built
into the AR System schemas by the administrator, users may be notified of any
change of state of an AR. For example, the administrator may have defined a
filter that sends a notification to the support staff when new ARs are assigned
and another filter that notifies end users when an AR is closed. (In a user
environment that does not run the Notification Tool, users can be notified of
progress through electronic mail. See Chapter 9, for more information.) The
Notification Tool is described in Chapter 8, of this document.

Administrator Tool

The Administrator Tool is used exclusively by AR System administrators to set
up the AR System for use by support staff and end users. This includes:

• Setting up schemas (the definitions of AR System databases).

• Setting access permissions on the fields within the schemas.

• Setting up access on schemas themselves.

• Creating both dynamic and static menus.

• Setting up AR System filters, escalations, and active links that define the
workflow processes.
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• Creating administrator commands. (Administrator commands only work on
UNIX workstations.)

The Administrator Tool is available on UNIX workstations or PCs running
Windows and is described in the Action Request System Administrator’s Guide.

Import Tool

The Import Tool allows users to transfer data from databases on other servers
to the AR System database on the local server.

If the data you want to import already exists in a AR Export file, you can use
the AR System Import Tool to import data into your server.The Import Tool
can handle files in CSV or ASCII format.

The Import Tool is described in the Action Request System Administrator’s Guide.

Action Request System Activities
AR System activities include setting up schemas, submitting ARs, querying the
database to find similar ARs or to check on the progress being made on a
specific AR, and resolving ARs. Figure 1-1 shows the flow of these activities
through the AR System.
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Figure 1-1 Flow of AR System Activities

The AR System administrator is responsible for setting up schemas.
Subadministrators are users that have been granted administrator permission
to a subset of schemas by the AR System administrator. Once a schema is
established, end users and support staff can submit ARs and query the
database as needed, within their allowed permissions.

ARs can enter the system in several ways:

• Through support staff when end users call on the telephone.
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• Directly from the end user’s desktop through the Submit window of the
User Tool.

• Through electronic mail. For more information, see Chapter 9.

• Through APIs that allow integration with other processes (like network
management platforms). APIs are only available as UNIX clients.

Typically end users notify support staff of problems and service requests by
submitting ARs. Submitters can be notified of actions taken on their request
and can also query the database for the status of their request. Support staff
can be alerted at their workstation (or any workstation where they are logged
in) of the arrival of new ARs. Incoming ARs are assigned by the manager, or
they can be automatically assigned based on field values in the AR. The
assignment of ARs can be changed if necessary.

ARs can be automatically submitted by other programs, such as network
management systems like HP OpenView, IBM NetView/6000, and SunNet
Manager, or programs that periodically submit preventative maintenance
reports using the provided API.

The query facility assists support staff in resolving ARs by providing a
versatile tap into a growing knowledge and experience base. As problems are
resolved, the staff can keep a history in diary fields. This history can help
provide answers to future problems.

The AR System macro facility lets the support staff automate frequently
performed operations, such as creating daily reports or performing a query
that produces a list of high priority problems.

When an AR is resolved, the end user can be notified through either the
Notification Tool, electronic mail, or the telephone. The AR is now part of an
experience base to be drawn upon in the future.
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Getting Started with the User Tool 2

The Action Request System (AR System) User Tool is the tool you use to
perform most of the day-to-day AR System functions. You use the tool to
submit information to the AR System in the form of action requests (ARs) and
to find specific ARs so that you can view or modify them. You also use the tool
to create and run reports as your needs require. Given the proper permissions,
you may use the tool to customize what you see when you look at a particular
schema (that is, customize your view of the schema).

This chapter helps you get started in the daily operations of the User Tool. It
covers the following topics:

• Starting and exiting the User Tool.

• Working in the User Tool Windows (includes information on making menu
selections).

• Changing current login information.

• Using Schemas.

• Displaying help.

• Displaying server information.

• Setting preferences that determine how the User Tool looks and acts.

• Displaying version information.

• Setting an alternate configuration directory for the User Tool.

• Sharing macros, user commands and custom reports.
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• Defining your ARDATE environment variable.

See Chapter 8 for information on the Notification Tool.

Using the Mouse with the AR System
Mouse operations in the AR System tools are much like those in other
OSF/Motif applications you are familiar with. The following terminology is
used in this manual to describe the operations you perform using the mouse.

Select means to click once on an item with the left mouse button.

Double-click means to click the left mouse button twice in quick succession.

Drag means while pointing on an object, hold down the left mouse button and
move the mouse.

Press means hold down the left mouse button without moving the mouse.

Pull-right means to click and hold the left mouse button on the character menu
symbol (to the right of a field) to display the menu items. Continue to hold the
left mouse button as you move the pointer over the menu items. (An arrow to
the right of a selection means that there are sub-menu items for that selection.
To display and select the items from a sub-menu, move the mouse to the right
with that choice highlighted.) When your choice is highlighted, release the
mouse button and your selection is made. (If you release the button outside of
the menu, the menu closes and nothing is selected.)

Controlling Window Size and Position
You can manipulate windows in the AR System in the same way that you can
for most OSF/Motif applications. You can control the size of a window by
clicking on the Resize Border (the outer edge of the screen) and dragging with
the mouse.

OSF/Motif User Conventions in the AR System
Remember the rules below as you work with the Action Request System client
tools:
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• The AR System is case-sensitive. The only exceptions where the AR System is
not case-sensitive is if you are using the Sybase database configured to be
case insensitive or if you are using the full text search (FTS) option
configured case-insensitive.

• The window that is active (selected) is the one whose title bar is highlighted.

• In some windows with selection buttons, pressing the Return or Enter key
performs the default action. The default action is the action performed by
the button that has the focus rectangle (a heavy black border) around it.

Starting the User Tool
You can start the User Tool from any machine (or machines) on the network
with access to the AR System server. Before you start the User Tool, make sure
you have the following information from your AR System administrator:

• The directory that contains the executables for the User Tool (by default, this
directory is /usr/ar/bin ). We refer to this directory as <ar_run_dir> in this
document.

• Your registered AR System user name and password.

If you install the AR System on a client running OpenWindows, your keyboard
mapping is updated automatically during the installation process. The
XKeysymDB file is copied from the <ar_run_dir>/bin  directory to your
/usr/ar/X11  and $OPENWINHOME/lib directories. If you don’t have the correct
privileges to these directories, see your System Administrator for help.

Copying the XKeysymDB file prevents a substantial amount of text from
appearing in the shelltool  window each time you start the AR System, and
enables you to use the Del and Backspace keys in a field.

User Name and Password

Your user name and password identify you to the AR System and give you the
appropriate access permissions. Whenever you use the AR System, you should
make sure you are logged in with the correct user name and password to
assure that you have access to the fields, schemas, and functions required to
help you do your job.
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Users are set up in the AR System by the AR System administrator. If you do
not know the login you should be using for the AR System, see your AR
System administrator before you continue.

Note – If you are not a registered user, and unregistered users are allowed at
your site, the User Tool starts with a “guest” set of capabilities. A guest user
can retrieve any public information in the system. In addition, a guest user
may be allowed to submit ARs, record a macro, generate a report, specify user
defaults, and review ARs.

To start the User Tool:
• Enter the following command line at any UNIX prompt:

Note – If you are running OpenWindows 3.0 on a Sun SPARCstation and you
are remotely displaying the User Tool from an HP system, it may take awhile
for the User Tool to display. If this happens, add the following line to your
.Xdefaults  file.

ARSystem*useColorObj: false

Table 2-1 lists the possible actions when you attempt to start the User Tool.

% <ar_run_dir> /aruser &
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For more information about preferences, see “Setting User Preferences” on
page 27.

Figure 2-1 Login Window

Table 2-2 lists the possible actions when you attempt to log in to the User Tool.

Table 2-1 Starting the User Tool

When you... and... Then...

Start the User
Tool for the first
time

The login window appears as shown
in Figure 2-1.
* Enter your registered user name
and password then select the Apply
button.

Start the User Tool You selected Prompt
in the Always prompt
for Login preferences
setting

The login window appears as shown
in Figure 2-1.
* Enter your registered user name
and password then select the Apply
button.

Start the User Tool You selected Don’t
prompt in the Always
prompt for Login
preferences setting

Your user name and password are
saved in your .config  file and you
are automatically logged in when you
start the User Tool.
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The kind of license that your user name is allowed determines what you can
do in the User Tool. If you have a Read license, you can read and submit ARs
within the limitations specified by your AR System administrator, but will not
be allowed to update existing entries.

If you have a Fixed license, you can read, submit and update existing ARs
within the limitations specified by your AR System administrator. Fixed
licenses are permanently associated with a single user name. With this type of
license, you can always access the User Tool.

If you have a Floating license, you have the same privileges as with the Fixed
license. Floating licenses are not attached to any single user name. With
Floating licenses, there are only a certain number of licenses available for use.
If no license is available when you try to log in, you will receive a warning
telling you that no license token is currently available and you are being
allowed access to the system with Read Only permission. If a token becomes
available, it will be allocated to you. You will receive a note indicating you
have been allocated a token when it becomes available. (The default “timeout”
value for Floating licenses is two hours. For information on specifying
timeouts, see the Action Request System Administrator’s Guide.)

Table 2-2 Logging in to the User Tool

If you entered... and Then...

A valid user name A valid
password

* The Login window is removed.
* The query window is displayed.
* You are ready to begin working.

An invalid
password

You receive an error message and are
not logged in.

An unknown or
invalid user name

Guests are
allowed to
use your AR
System

You are successfully logged in with a
warning telling you that you only have
guest privileges.

Guests are not
allowed to
use your AR
System

You receive an error message and are
not logged in.
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You may also be assigned a Fixed or Floating Full Text license. A Full Text
License grants you the ability to use the full Text Search capacity supported by
the AR System. If you are assigned a Floating license, you will grab one of the
tokens available in the license pool. If no license is available, you will receive a
warning and be allowed to access the system without using the full text search
capability (the system will use the default database search capability). When a
token becomes available, it will be allocated to you; you will receive a note,
and will then be able to perform full text searches. (The default “timeout”
value for Floating Full Text licenses is two hours. For information on
specifying timeouts, see the Action Request System Administrator’s Guide.)

The first time you log in, the Query window appears, as shown in Figure 2-2,
and a message tells you to select a schema (See “Using Schemas” on page 22.)

Note – If you are using the AR System on an RS/6000 running AIX 3.2.0 with
a monochromatic monitor, and the Query window appears black, you can
change the default colors using the information provided in Appendix B,
Changing Colors and Fonts.

Figure 2-2 User Tool Query Window
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The AR System Windows
The Action Request System User Tool windows are the Query, Submit, Query
List, Display, Modify Individual, Modify All Selected, and Report windows.

Query Window

The Query window is the main window of the AR System User Tool. You use
the menus and menu items available from the menu bar on the Query window
to select and control the operations you need to perform. From the Query
window, you can open and close the other windows that let you display,
modify, and submit action requests, or generate reports on action requests that
match specific query criteria.

The Query window includes a title bar at the top, a menu bar, and an optional
query bar. The menu bar provides access to the User Tool menus that allow
you to select the operations you want to perform. The query bar allows you to
easily “build” complex query criteria. In addition, messages are displayed at
the bottom of the window that let you know the status of the operation in
progress. You can specify whether or not to display the query bar by setting
the appropriate preferences for the Query window. See “Setting User
Preferences” on page 27 for information.

Submit Window

The Submit window allows you to enter information into input fields to
describe a problem or request. Using the Open Submit menu item from the File
menu, you can open more than one Submit window at any one time. You can
open multiple Submit windows for one schema, or you can open a Submit
window for more than one schema. This is useful if you need to submit more
than one AR at the same time, or if you get interrupted and need to stop
working on one task to begin working on another before finishing the first
submit task.

Query List Window

The Query List window displays a one-line summary of every AR that matches
the query criteria. By default, the list displays the contents of the Entry ID and
Short Description fields, but your AR System administrator may have chosen
other fields for display on the schemas you are using. Displaying a Query List
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window is a convenient way to determine if the query criteria you have
specified produces too many irrelevant ARs. From the Query List window, you
can return to the Query window to change your query criteria to narrow down
the list of matching ARs. You can also open Display, Modify Individual,
Modify All Selected, and Report windows related to all ARs or only for the
ARs selected in the Query List window.

Display and Modify Windows

The Display window displays a read-only view of ARs while the Modify
Individual and Modify All Selected windows allow you to edit ARs provided
you have the appropriate access. The Modify Individual window displays one
AR at a time allowing you to make changes to a single AR. The Modify All
Selected window displays a blank schema template allowing you to make
changes to multiple ARs at one time.

Report Window

The Report window allows you to generate a formatted report of all ARs that
match the specified query criteria. From the Report window’s Define menu,
you can choose how to format the report, which fields to include in the report,
and what statistics to include.

Circulating Through all Open Windows

Like the Submit window, you can open multiple Query List, Display, Modify
Individual, Modify All Selected, and Report windows. Since you can have
many windows open at the same time, the Submit, Query List, Display, Modify
Individual, Modify All Selected, and Report windows can all be iconized. This
way, you can keep open only the windows you are currently working on while
keeping other windows (job tasks) available to you without cluttering your
work area.

You can circulate through all open windows using the Windows menu on the
Query window. When just the Query window is open, the Windows menu is
grayed out. When more than just the Query window is open, the Windows
menu is available and lists all open windows. You can make a window active
by selecting it from the Windows menu. If the window is iconized, it is opened
and made active.
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Making Menu Selections

You can choose items from the menu bar at the top of the Query window in
any of four ways:

• Display the menu and select the desired menu item using the mouse.

• Type the shortcut key sequences that are shown beside many of the items in
the menus. These key sequences are also called accelerator keys. For
example, type Ctrl+S to open a Submit window.

• Type F10 and then type the letter that is underscored in the menu and menu
item. For example, type F10, F , and then S to open a Submit window.

• Hold down the Alt key (on Sun systems running Motif, use the Meta  key.
On HP 300/400/700 series keyboards use Extend Char key) and then type
the letter that is underscored in the menu and menu item. For example, type
Alt+F , and S to open a Submit window.

Table 2-3 shows the menu items available from each menu along with their
corresponding accelerator key sequences.

Table 2-3 User Tool Menu Items  (1 of 5)

Menu Item Function
Key
Sequence

File Login Opens a Login window.

Open Schema Displays the Open Schema window
allowing you to display a particular
schema.

Ctrl+O

Open Submit Opens a Submit window of the
current schema allowing you to enter
a new action request (AR) into the
system.

Ctrl+S
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Server
Information

Displays licensing information about
the servers you are currently
connected to. This means the servers
listed in your /etc/ar  file unless
you use the -x option, then it is the
ones identified there. The Server
Information window shows the
server names and versions. It also
shows what type of license is
available from each server (assigned
and current).

Preferences Set options that control the
appearance and behavior of the User
Tool for your user login. These
options affect query and submit
operations, among other things.

Ctrl+P

Exit Exits the User Tool. Alt+F4

‘Active
Schema List’

Lists your most recently used
schemas allowing you to quickly
return to a schema by selecting its
name displayed at the bottom of the
File menu. You can specify the
maximum number of schemas that
are displayed in this list using the
Max in active schema list preference
on the Preferences window.

Edit Clear All Clears the contents of all fields in the
Query window.

Ctrl+E

Set to Defaults Sets the value of the fields in the
Query window to the default values.

Ctrl+U

Table 2-3 User Tool Menu Items  (2 of 5)

Menu Item Function
Key
Sequence
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Query List Opens a Query List window
containing a one-line summary of
ARs meeting current query criteria.

Ctrl+L

Display Opens a Display window to show the
ARs that meet current query criteria.
ARs are displayed one at a time. Use
the Next and Previous buttons to
move from one AR to another.

Ctrl+D

Modify
Individual

Opens a Modify Individual window
to make changes to each AR that
meets current query criteria. ARs are
displayed for modification one at a
time. Use the Next and Previous
buttons to move from one AR to
another.

Ctrl+M

Modify All Opens a Modify All Selected window
that contains a blank copy of the
current schema so that you can make
bulk changes that affect every AR
that meets current query criteria.

Report Generates a report for the entries that
meet current query criteria. You can
also calculate statistical data for the
entries, display the report to the
screen, send it to a printer, or save it
to a file.

Ctrl+R

Delete Deletes all ARs that meet current
query criteria. This function is
available only to users with
Administrator permission or
Subadministrator permission.

Table 2-3 User Tool Menu Items  (3 of 5)

Menu Item Function
Key
Sequence
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Actions Customize
Defaults

Set default values for the fields of a
schema.

Customize
View

Customize the appearance of a
schema viewed on this User Tool.

Sort Options Specify sorting for the results of all
Query menu operations. Sorting can
include up to five fields and you can
specify whether each field is sorted in
ascending or descending order. You
can specify a different sort order for
each schema.

Ctrl+A

Create
Command

Create a user command to perform a
function outside of the User Tool.

Run
Command

Execute an existing user command.

Run Admin
Command

Execute an administrator command.

Copy to
Submit

Opens a Submit window that
contains the same field values as the
Query window.

Ctrl+T

Macros Start
Recording

Begins recording a macro for later
execution. Actions you perform after
selecting Start Recording and before
selecting Stop Recording from the
Macros menu are recorded as part of
the macro.

Stop
Recording

Stops recording a macro that you are
recording for later use. The Stop
Recording window appears so that
you can name and save the macro
you have just recorded.

Edit Macros Opens the Edit Macro window. You
can then select an existing macro to
modify its name or help text or to
delete the macro.

Run Macro Execute an existing macro. The
Execute Macro window appears.

Ctrl+I

Table 2-3 User Tool Menu Items  (4 of 5)

Menu Item Function
Key
Sequence
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Changing the Current Login Information
If the User Tool was previously started by another user, you can change the
user information and log in as yourself. You can log in at any machine on the
network that has access to the AR server.

Windows Lists all open windows. The selected
window becomes active.

Help Index Opens a window that contains a list
of help topics for selection. Each help
topic may have one or more levels of
subtopics available.

F1

Using Help Displays help information on using
the application level help accessed
from the Index choice.

On Context Displays context-sensitive help.
When the pointer is on a field or
active link, this help includes the
characteristics and any administrator
defined help text for that field or
active link. When the pointer is on
the schema and not on any field or
active link, this help displays any
help provided by your AR System
administrator for the active schema.

On Window Displays help provided by your AR
System administrator for the active
schema.

On Version Displays information about the AR
System User Tool. This information
includes the tool name, version
number, copyright information, and
the host name of the machine where
the tool is running.

Ctrl+V

Table 2-3 User Tool Menu Items  (5 of 5)

Menu Item Function
Key
Sequence
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Note – If you log into the User Tool on a system where someone else is logged
into the UNIX operating system, before you change the user information and
log in as yourself in the User Tool you might want to change the ARHOME

environment variable to point to your arHome directory. If you don’t, any files
that are normally saved in the directory specified by your ARHOME environment
variable (custom reports, macros, user commands, changes made to your
configuration file, etc.) are saved in the directory specified by the ARHOME

environment variable of the user who is logged in at the UNIX operating
system level. For more information about changing the ARHOME environment
variable, see “Setting an Alternate Configuration Directory” on page 33

To change the current login:
1. Select Login from the File menu.

A Login window (shown in Figure 2-1) appears.

2. Type the name and password for the new login.

3. Select the Apply button to complete the login. (The Query window is
reopened for the new login with the appropriate permissions. Any other
previously opened windows are closed.)

Exiting the User Tool
To exit the User Tool, select Exit from the File menu, as shown in Figure 2-3.
You can also exit the tool by selecting the Quit item from the window menu
box in the upper left hand corner of the Query window, typing Alt+F4 , or
double-clicking on the window menu.

If you select Confirm for the Confirm to exit AR System preference on the
Preferences window, you are asked to verify that you really want to exit each
time you exit the User Tool. For more information about preferences, see
“Setting User Preferences” on page 27.
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Figure 2-3 Exiting the Tool

Working with Action Requests
An action request (AR) is a collection of information that describes a single
event or incident, such as a problem or a service request. Each AR represents a
single entry in an AR System database.

As a user of the Action Request System, you are involved in two primary
activities:

• Creating and submitting new action requests.

• Looking at or modifying existing action requests.

You create ARs by opening a Submit window. See Chapter 3, Submitting an
Action Request, for detailed instructions on using the Submit window.

You look at or modify ARs by selecting the schema that holds the information
you want to view. See Chapter 4, Reviewing and Modifying Action Requests,
for detailed instructions on using the Query window.

Using Schemas
A schema is the definition of an AR System database. Each schema is designed
to help you perform a different type of activity. The schemas from which you
can select were implemented by your AR System administrator to help manage
the work flow of your daily operations.
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For example, your AR System administrator may have implemented one
schema to help keep track of calls coming in to the help desk. The
administrator may have also implemented a schema that contains a record of
the equipment that each user has. You may need one or both of these schemas
to perform your job tasks.

The administrator can implement as many (or as few) schemas as needed. The
administrator can also control whether or not a specific user has full, limited,
or no access to a schema and to the information it contains. If you don’t have
access to the schema at all, it does not appear in your list of available schemas.

Each schema contains a set of fields. Each field contains a certain type of
information and has its own set of rules about who can look at or modify the
information in the field.

Note – Since it is possible for you to have access to a schema but not to any of
its fields, you could display a schema that appears to not have any fields.

For more information on fields see Chapter 3, Submitting an Action Request.

Figure 2-4 shows the fields that you might see in a typical schema designed to
track trouble reports. The schema shown is one of the schemas that is supplied
as a sample schema with the AR System. Your AR System administrator may
have implemented this schema for use at your job site. (Each sample schema
may be used as it exists or modified to fit local requirements.)
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Figure 2-4 Sample Trouble Ticket Schema

Selecting a Schema

When you start the User Tool, you need to select the schema that you want to
use.

To select a schema:
1. Select Open Schema from the File menu (or type Ctrl+O ). The Open

Schema window appears as shown in Figure 2-5.
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Figure 2-5 Selecting a Schema

2. In the Open Schema window, select the schema you want from the
Available Schemas list. Then, select the Apply button. Alternatively, you
can enter the name of the schema and server in the Selection box. Make
sure you include the two spaces between the schema name and the server
name if you do. (You can also select the schema by simply double-clicking
on the schema name.)
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3. fcufc
Each schema is uniquely identified by a name and the server where it
resides. (The same schema name may appear on more than one server.) If a
schema was available to you at one time, and for some reason the schema is
not available to you now (for example, the server is down), the schema
name will be followed by an asterisk.

If you log in on someone else’s machine, any schema you don’t have access
to from the previous user’s list will be followed by an asterisk.

The Query window displays the selected schema and the title bar displays
the schema name. Any actions you perform when this window is active
affect the schema you have selected.

Note – If a schema is larger than the window, you can use the scroll bars to
view the portions of the form that are not displayed or you can resize the
window.

Server Information
The Server Information menu item from the File menu displays licensing
information about the servers listed in your /etc/ar  file or, if using the -x

command line option, the servers you listed when you logged on. The Server
Information window shows the server names and versions (see Figure 2-6). It
also shows what type of license is available from each server (assigned and
current).

Figure 2-6 Server Information window
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Setting User Preferences
The Preferences menu item from the File menu sets options that control the
appearance and behavior of various aspects of the User Tool. The next time
you open the User Tool, the AR System remembers the preferences you set.

You can select preference settings for the Query, Query List, and Submit
windows. Instructions for setting preferences are provided in this section.

To set user preferences:
1. Select Preferences from the File menu (or type Ctrl+P ).

The Preferences window appears, as shown in Figure 2-7.

Figure 2-7 Preferences

End User PC
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2. Select or request an option by either clicking in the field and entering a
numeric value or clicking on the radio button to the left of the option. You
can increment or decrement the numeric values by clicking on the up and
down arrow to the right of the fields.
You can set any of the following options:

Max in active schema list Specifies the maximum number of schemas kept
in the active schema list displayed at the bottom
of the File menu. The default value is 4. The
minimum accepted value is 0 and the maximum
accepted value is 9.

Max in query Specifies the maximum number of ARs that can
be returned when doing one of the query menu
operations. If your query matches more than this
number, only the number specified here are
displayed and you receive a warning message
that there are more ARs that match but are not
returned in your results. If you want to have all
matching results returned, you would have to
increment this Max in query value and then
reissue your query operation. The default value is
1,000. To specify an unlimited number of ARs,
enter 0. (You should be aware that returning large
numbers of ARs in query requests can impact the
performance of the AR System.)

Prior to new Query Clear Select to clear all information from the fields on
the schema. This is the default.

Set to
Defaults

Select to load the schema fields with any existing
default information. If no
administrator or user default is defined for a
field, the field is cleared.

Keep
Previous

Select to retain information from the last query.
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Note – Any default values defined for hidden fields are also loaded when you
select Set to Defaults. This can cause unexpected query results since the query
attempts to match the value in the hidden field as well as the query criteria
you define. For more information about default values, see Chapter 7,
Customizing the Environment.

Query Bar Show Select to make the query bar visible. This
is the default.

Hide Select to hide the query bar. You may want
to hide the query bar if you rarely perform
complex queries.

Double-click action on query Display Select to cause a Display window to open
after double-clicking a Query List item.
This is the default.

Modify Select to cause a Modify Individual
window to open after double-clicking a
Query List item.

Report Select to cause a Report window to open
after double-clicking a Query List item.

Prior to new
submission

Clear Select to clear all information from the
fields on the schema. This is the default.

Set to
Defaults

Select to load the schema fields with any
existing default information. If no
administrator or user default is defined for
a field, the field is cleared.

Keep Previous Select to retain information from the last
submitted AR.

Confirmation upon
successful submit

Footer only Select to display only a footer message
after a successful AR submission. This is
the default.

Confirmation
box and Footer

Select to display both a footer message and
a confirmation box after a successful AR
submission.
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Submit window -
Text Edit/Diary entry window
Apply action

Leave
window up

Select if you want to leave the window
displayed after you select Apply on a Text
Edit or Diary window opened from a
Submit window.

Close
window

Select if you want to close the window
after you select Apply on a Text Edit or
Diary window opened from a Submit
window. This is the default.

Other windows -
Text Edit/Diary Entry window
Apply action

Leave
window up

Select if you want to leave the window
displayed after you select Apply on a Text
Edit or Diary Entry window opened from
a Query, Modify Individual, or Modify All
Selected window. This is the default.

Close
window

Select if you want to close the window
after you select Apply on a Text Edit or
Diary Entry window opened from a Query,
Modify Individual, or Modify All Selected
window.

Confirm to exit AR
System

Confirm Select if you want to be prompted to
confirm that you want to exit the User Tool
after you select the Exit command on the
File menu. This is the default.

Don’t
confirm

Select if you don’t want to be prompted to
confirm that you really want to exit the
User Tool after you select the Exit
command on the File menu.

Always prompt for Login Prompt This means that your user name and
password will not be saved in your
config  file. Select to be prompted to
supply your user name and password each
time you run the User, Admin and
Notification Tools.

Don’t prompt This means that your user name and
password will be saved in your config
file. Select to not be prompted to supply
your user name and password each time
you run the User, Admin and Notification
Tools. This is the default value.
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3. Select the Apply button to accept the options as set.

Displaying Help
Help information is available on the context of the current field in the window,
on the window (schema) itself, on using the AR System application, and on the
software version information. To get access to the online help Index for the AR
System application help, add the following line to your .cshrc  file:

setenv ARHELP <ar_install_dir>/help

We also provide you with UNIX manual pages that you can access from the
UNIX command line.

Displaying Help on Help

To display help on using the help function, select Using Help from the Help
menu. doing so brings up a window that includes the Index to Using
HyperHelp. Topics covered include:

• HyperHelp Basics.

• HyperHelp Buttons.

• HyperHelp Commands.

• HyperHelp Keys.

• HyperHelp Procedures.

Menu Style Popup Menu Select if you want to display popup menus
when displaying menus.

Popup List Select if you want to display popup lists.
You should choose this option if you want
to display large menus.

Default Schema View The name of the view to use as the default
view for each schema selected. See your
AR System administrator for information
on whether or not a customized view
exists that would be appropriate for your
use.
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Displaying Help for the Current Field or Active Link

To display help on the current field or active link, select On Context from the
Help menu. The cursor changes to a question mark. Then, select the field or
active link button that you want help on. You can also display help by placing
the cursor (keyboard focus) on the field or active link button and then pressing
the F1 key. (If you are using a Sun SPARCstation, you may need to use the
Help  key instead of the F1 key.) This help contains such information as the
name of the field, the field ID, the data type, the maximum length of the field
as well as any help text supplied by your AR System administrator. To display
help on an active link tied to a field, select the field. To display help on an
active link tied to the schema (an active link that triggers when you submit an
AR or when you issue a query), select anywhere within the schema.

Displaying Help for the Current Window

If your AR System administrator created help for your schemas, you can
display this help for the currently displayed schema. Select On Window from
the Help menu. You can also select On Context from the Help menu. The
cursor changes to a question mark. Then, place the pointer anywhere on the
schema not on a field or active link and click the mouse button.

Displaying Version and Environment Information

To display information about the product, select On Version from the Help
menu (or type Ctrl+V ). Figure 2-8 illustrates the About box which includes the
tool name, version number, and copyright information.

You should be prepared to provide this information whenever you call
Customer Support.
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Figure 2-8 About Box

Displaying the AR System Man Pages

We provide you with UNIX manual pages for all AR System user commands.
The UNIX manual pages are placed in a directory (man) under the AR System
installation directory (<ar_install_dir>) when the AR System is installed. In order
to be able to display our manual pages from any directory, you need to add
this directory to your MANPATH environment variable. For more information
about the UNIX manual pages that we provide, see Chapter 5 in the Action
Request System Programmer’s Guide.

To get access to the UNIX manual pages add the following line to your .login

file:

setenv MANPATH <ar_install_dir>/man

Setting an Alternate Configuration Directory
The AR System uses a directory to hold your personalized configuration
information for the User Tool. By default, this directory is named arHome and is
stored under your home directory. If you do not want to use the default
directory, you can set an alternate configuration directory either during
installation or at a later time. Follow the instructions below to set an alternate
configuration directory at any time after installation.
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To set an alternate configuration directory:
1. Create the new directory where you want your AR System-related

information stored. For example, to create the directory myhome, enter the
following command:

2. Change the variable ARHOME to reference the new directory. For example,
enter the following command:

The ARHOME variable tells the User Tool where its local configuration
information is stored. The NTHOMEvariable tells the Notification Tool where
its configuration information resides. You may set the ARHOME and NTHOME

variables to point to separate directories; however, they are usually set to
the same directory for simplicity. (See Chapter 8, Using the Notification
Tool, for more information on setting an alternate configuration directory
for the Notification Tool.)

Note – If the environment variables are not set, the configuration information
is stored in the directory arHome under your home directory.

3. You must restart the User Tool in order for the change to take effect.

Note – Throughout this document, the configuration directory is referred to as
<ar_config_dir>.

Sharing Macros, User Commands and Custom Reports
There are two ways that you can share macros, user commands, and custom
reports. The first way is for you to copy the macro, user command, or custom
report files and place them in your <ar_config_dir>/arcmds  directory. The second
way is to give the appropriate access to the directory where the macro, user
command, and custom report files are located. This directory can be any
directory. It doesn’t have to be <ar_config_dir>/arcmds.  Then, any user can add
this directory to their ARPATH environment variable. Using this second way
allows many users access to the same macros, user commands, and custom
reports without having to always copy files.

% mkdir /user/myhome

% setenv ARHOME /user/myhome
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Note – In general, you can share macros with users running on different
platforms. The one exception is that macros that include report printing cannot
be used on hardware platforms other than the one they were created on.

Copying Files

By default, the AR System creates macros, user commands and custom reports
in your <ar_config_dir>/arcmds  directory. Their default file names are:

Note – The name you give a macro, user command, or custom report is used to
construct the name of the file holding the macro, user command, or custom
report respectively. The file name can be up to eight characters long and is
appended with the appropriate suffix (.arq  for macros, .arc  for user
commands, and .arr  for custom reports).

If the name is identical to an existing file, the last three characters are replaced
with numbers. Also, all blanks and special characters are replaced with a lower
case x . For example, if you already have a custom report named Daily Income
Totals (DailyxIn.arr ) and you create another custom report named Daily
Income Summary, this second custom report’s file name will be Daily001.arr .

Once you copy the files and place them into your <ar_config_dir>/arcmds

directory, you can access them after restarting your User Tool.

Defining your ARPATH environment variable

The second way you can share macros, user commands, and custom reports is
to first change the file protections at the UNIX system level to the directory
where the files are located (<ar_config_dir>/arcmds  or any directory containing
the files) and to the existing files (macros, user commands, and custom

Macros <macro_name>.arq

User Commands <user_command_name>.arc

Custom Reports <custom_report_name>.arr
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reports). Using the ARPATH environment variable, you can place macros, user
commands, and custom reports in directories other than
<ar_config_dir>/arcmds .

The UNIX file protections needed to allow specific access are as follows:

Note – If you try to modify a macro that you only have Read and Execute
access to, but not Write access, you will receive an AR System error message.

Once the file protections are set appropriately, you need to include the
directory in your ARPATH environment variable definition. If you don’t define
this environment variable, your personal <ar_config_dir>/arcmds  directory is the
only directory where you can create and execute macros, user commands, and
custom reports. You define the ARPATH environment variable like other UNIX
environment variables specifying directory path names separated by colons (:).
You don’t have to add your own <ar_config_dir>/arcmds  directory to your
ARPATH environment variable since it is automatically included. The following
example gives you access to all files in both Sue’s and Jay’s default
<ar_config_dir>/arcmds  directory, provided the file protections were set
appropriately:

After changing the file protections and specifying your ARPATH environment
variable, you need to re-start your User Tool to be able to access these macros,
user commands, and custom reports.

To allow other users to... Give them...

Access your directory Execute and Read access to all
directories in the path name.

Read and execute your files Read access to your files.

Create a new file in your directory Write access to your directory.

Modify any of your files Read and Write access to your files.

Delete your files Write access to your directory.

%setenv ARPATH /home/sue/arHome/arcmds:/home/jay/arHome/arcmds
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Defining your ARDATE Environmental Variable

What is ARDATE?

ARDATE is an AR System environment variable that allows you to customize the
display of dates and times. ARDATE is set on a per-user basis. The format you
specify using ARDATE is used by the AR System during displays and reads of
date/time fields.

To set ARDATE, use the following syntax:

When to Use ARDATE?

The ARDATE environment variable is useful when you:

• Need a particular date format.

• Need a local date format, and there is no systemwide locale setting
available.

• Would like to create reports which contain a different date format than the
format you usually see on the screen.

ARDATE affects dates in date/time fields, diary fields, and Change History
fields. ARDATE does not affect dates displayed in the query list.

Note – If you want to change date and time format sitewide, instead of per-
user, your administrator will need to change your operating-specific locale
settings.

%setenv ARDATE " <your_format> "
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Customizing Date/time Formats

Field Descriptors

You may create whatever date formats you want by combining field
descriptors. Field descriptors represent different components of dates and
times. Available field descriptors may differ depending on your UNIX machine
type. By default, the AR System uses the format "%x %X".

Table 2-4 lists the field descriptors that you can use with ARDATE.
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Table 2-4 ARDATE Field Descriptors

Field
Descriptor Function

%% Same as %.

%a Day of week, using locale’s abbreviated weekday names.

%A Day of week, using locale’s full weekday names.

%b or %h Month, using locale’s abbreviated month names.

%B Month using locale’s full month names.

%d Day of month (01-31).

%D Date as %m/%d/%y.

%e Day of month (1-31; single digits are preceded by a blank).

%H Hour (00-23).

%I Hour (00-12).

%k Hour (0-23; single digits are preceded by a blank). (Sun only)

%m Month number (01-12).

%M Minute (00-59).

%p Locale’s equivalent of AM or PM, whichever is appropriate.

%r Time as %I:%M:%S %p.

%R Time as %H:%M.

%S Seconds (00-59).

%T Time as %H:%M:%S.

%w Day of week; Sunday is day 0.

%x Date, using locale’s date format.

%X Time, using locale’s time format.

%y Year within century (00-99).

%Y Year, including century (for example, 1995).
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The format you specify can contain any characters (including the field
descriptors in Table 2-4.), in any combination that you choose. So, if you want
to put a comma in your date, include the comma in the appropriate place in
the format.

You are not required to type dates using the format given in ARDATE. For
example, if you set ARDATE to display dates in the format
"11 Sep 1995, 1:00:00 P.M."  you could still type "9/11/95 13:00"

Examples

The following are examples of ARDATE settings:

Note – The wording of the second example may differ according to the LANG

environment variable or your system’s default language. For example, the %B

descriptor, meaning full month name, may differ according to the language
defined by the LANG environment variable or according to the system’s default
language (also known as the locale) .

Errors in Formatting ARDATE

If you set up an incorrectly formatted ARDATE environment variable, the AR
System will parse the correctly formatted parts and return the invalid parts as
a literal string in the date/time.

Check Table 2-4 on page -39 for a list of valid field descriptors.

It is possible to write an ARDATE environment variable that is correctly
formatted but doesn’t make sense. For example, repeating a valid descriptor
excessively (%B %B %B %B %B) is something to be avoided. If a format like this
is chosen, dates will be formatted correctly on output, but the system will not
be able to interpret any date you specify as input.

To Display the Format... Set ARDATE to...
01/31/95 setenv ARDATE "%m/%d/%y"

11 January 1995 16:30:00 setenv ARDATE "%d %B %Y %X"
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An action request (AR) is a collection of information that describes an incident,
such as a problem or a service request.

You submit an AR by entering the appropriate information in the Submit
window of the User Tool. The AR is added to the database and, normally, a
member of the support staff is assigned the AR. After the AR is resolved, it
remains in the database where other users managing similar ARs are able to
reference it.

You can open more than one Submit window at any time. You can open
multiple Submit windows for the same schema, or you can open Submit
windows for multiple schemas.

This chapter describes the features of the Submit window and tells you how to
use the Submit window to submit an AR. It covers the following topics:

• Submitting an AR.

• Filling in fields of different data types.

• Using keywords when filling in fields.

• Using Text Edit and Diary Entry windows.

• Using active links.
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General Steps for Submitting an Action Request
The steps below describe the process of submitting an action request to the AR
System using the User Tool. (To review or modify information in an AR once it
is submitted, you must use the Query window, as described in Chapter 4,
Reviewing and Modifying Action Requests.)

To submit an action request:
1. Select the schema you want to work with by selecting Open Schema from

the File menu. The Open Schema window opens, as shown in Figure 3-1.

2. Select the schema name, and then select the Apply button, or double-click
on the schema name (or type Ctrl+O).
For more information, see Selecting a Schema in Chapter 2.

Figure 3-1 Schema List Window
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3. Open a Submit window by selecting Open Submit from the File menu (or
typing Ctrl+S).
The Submit window opens displaying the selected schema, as shown in
Figure 3-2.

Figure 3-2 Submit Window

• Select and fill in fields as appropriate to describe the problem or request.
For details, see “Filling in Fields” on page 45.

• Select the Clear button to clear all fields.
• Select the Set to Defaults button to fill in fields with pre-set default

information. For information on how to specify default values, see
Chapter 7, Customizing the Environment.
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4. Select the Apply button to submit the completed AR.
The system checks to ensure that all required information has been entered
and all values are valid. If any required information is missing or an error is
found, an error message appears in a window and the AR is not submitted.
Make the necessary corrections and resubmit the AR.

If there are no errors, the AR is added to the database. You receive a
confirmation message either in the footer area at the bottom of the window
or in both the footer area and in a confirmation box, depending on how you
set the Confirmation upon successful submit preference. For more
information about preferences, see Chapter 2, Getting Started with the User
Tool.

Note – If a schema is larger than the window, use the scroll bars to view the
undisplayed portions or resize the window.

When You Can Access Fields
Your schema view shows only fields to which you have complete or conditional
access. The AR System Administrator determines which fields you can access
and when access is allowed. If you do not have permission to a field, the field
is not visible, or it is read only (you cannot change the value).

If a field is protected, you must be a member of a group with write access to
that field and have a fixed or floating write license. If you want users to be able
to set the field at Submit time without write access, you must set the Create
Mode to Open. Refer to Create Mode in Chapter 4 of the AR System
Administrator’s Guide for more information.

Filling in Fields
Figure 3-3 on page -46 shows an example of a Submit window with a typical
schema view. Field labels may appear either to the left of or on top of the field.
You can move from field to field by selecting a field with the mouse or by
pressing the Tab key. Note the different font styles used for the field labels. The
font style provides you with some information about the field:

• Bold text means the field is required. You must enter appropriate data in
required fields.
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• Plain text means the field is optional. You may enter data or leave the field
empty.

• Italic text means the field is managed automatically by the system and
cannot be filled in during AR submission. It is a read-only field.

Note – If you have permission to do so, you can change the field labels that
appear on your view of the schema by customizing your view of the schema.
(See Chapter 7, Customizing the Environment.)

Figure 3-3 Example of the Submit Window

Optional
fields are
shown in
regular
typeface.

System
maintained
fields are
shown in
italic
typeface.

Required
fields are
shown in
bold
typeface.
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Field Data Types

A field is characterized by its data type, which determines the kind of
information you can enter in the field. The following list describes the field
data types.

Data Type Description
Character Character fields can contain any characters that you can

type or copy. The AR System administrator sets the
maximum length of each field and (optionally) a pattern
defining allowable characters. A character field can be
set to a maximum of 65,000 characters. A character field
can include a pull-right menu that serves as a fill-in aid.
Depending on how your AR System administrator
defines this menu, selecting an item from the menu may
either overwrite or append to any existing field contents.
Character menus can be created from a static list of
items, from the contents of a file, or from the result of a
query on another schema. Since changes to the file or to
the other schema might change the items contained in
the menu, your AR System administrator can choose
whether to update the menu when the schema is first
read, when the menu is first displayed, or after a specific
period of time. Therefore, the contents of a character
menu might change from time to time. A good use of
this type of menu is one that contains a list of all of your
employees which may change over time.
If a character field is 70 characters or more, you can open
a Text Edit window by either clicking in the field with
the MENU button, displaying a menu and then selecting
the Text Edit Window option, or by selecting the text edit
pop-up symbol to the right of the field. For more
information, see “Using the Text Edit Window” on
page 52.
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Diary Diary fields contain multiple character entries that are
automatically stamped with the date, time, and the name
of the user who entered the item. Each diary item can
contain any characters that can be typed or copied. You
can open a Diary Entry window for the field by either
clicking in the field with the MENU button, displaying a
menu and then selecting the Open Diary option, or
selecting the diary pop-up symbol to the right of the
field. A diary field can be set to a maximum of 65,000
characters. For more information, see “Using the Diary
Entry Window” on page 54.

Integer Integer fields contain a number between -2147483648
and 2147483647, though their range may be limited by
the AR System administrator. For integer fields with a
display property field type of numeric text, up and down
arrows appear to the right of the field to allow you to
increment and decrement the value in the field.

Real Real fields contain a floating-point number. You can
enter numbers either with a decimal point or in scientific
notation (for example, 1.43 or 2.9e-9). The AR System
administrator sets the range of real fields. If your AR
System administrator set up a real field to be a precision
field, the number that is displayed is rounded off. The
number stored in the database is not changed, only the
number that you see is either rounded up or down.

Selection Selection fields provide a list of exclusive, named
choices. The possible choices are displayed as radio
buttons or as a menu.

Date/Time Date/time fields contain numerics, characters for
months, time/date punctuation, and AM/PM
designations. You must enter the date first when entering
both date and time.

Note: If the date is not entered, the current date is assumed. If
the time is not entered, 0:0:0 (12:00 midnight) is assumed.
You can enter the month as text as a full word or as an
abbreviation (February or Feb) or numerically with or
without leading zero (02 or 2).
You can enter the day with or without a comma or
leading zero:
October 4, 1994; Oct 04 94; 10/04/94
The year is optional. You can enter it as two digits (94) or
four digits (1994). If you do not enter the year, the
current year is assumed.
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Field Data Entry Operations

The following summarizes the ways in which you enter data and select choices
in schemas. Refer also to the illustration in Figure 3-4.

Figure 3-4 Entering Data into Fields

Note: If your hardware platform allows for the localization of
the date format, your date format might be day, month,
year as opposed to month, day, year. For information
about what date format your platform uses, see your
system administrator.
You can enter the time in either 24 or 12 hour format,
using a colon to separate hours, minutes, and seconds
(minutes and seconds are optional):
13:30:28 or 1:30:28 PM

Character menus.
Note the menu sym-
bol to the right of the
field.

Radio
buttons in a
selection
field.

Selection
menu in a
selection field.
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To type and edit information in a field:
• Select the field and begin typing.

The type of information you can enter in a field depends on that field’s data
type, as described previously. For example, in date/time fields information
must be entered in a specific format. You can continue typing up to the
maximum length allowed for the field. In diary fields and character fields of
70 characters or more, you can open a Text Edit or Diary Entry window that
lets you enter more information by selecting the pop-up symbol to the right
of the field. Some fields may have a character menu associated with them
providing suggestions. Press the menu pop-up symbol to the right of the
field and then drag the pointer over the item you want and release the
mouse. Your selection either replaces or appends to any existing text
depending on how your AR System administrator defines this field.

To use selection menus:
• Press the selection menu symbol to the right of the field and then drag the

pointer over the item you want and release the mouse. Your selection
replaces any text already in the field.
You can also display a selection menu by placing the pointer on the
selection menu field and pressing the right mouse button or by placing the
cursor (keyboard focus) in the selection menu field and pressing F4.

To use selection radio buttons:
• Select the radio button you want (you can select only one button at a time).

To de-select a button, simply select it again. To change your selection, select
another button.
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Using Keywords
You can enter keywords any place that you can enter character values.
Keywords used to fill in fields on an AR are replaced with their corresponding
values when you submit the AR. The available keywords are shown in
Table 3-1:

Table 3-1 Keywords  (1 of 2)

Keyword Substituted Value

$DATE$ Current date. In a date/time field, the time defaults to
midnight (0:0:0).

$DEFAULT$ Default value for the associated field (only used when
assigning a value to a field).

$GROUP$ The group of which the current user is a member.

$HARDWARE$ Hardware platform the current process is running on.
The information that is included is the same value that
is returned by the UNIX uname -m command string.

$NULL$ A null value (mainly used during modify operations or
when selecting the Set to Default button on a Query or
Submit window to remove a value). For more informa-
tion on how to remove a value when selecting the Set to
Default button, see Chapter 7, Customizing the Envi-
ronment.

$OPERATION$ Current operation being performed. One of the following
values is returned:
* CREATE is returned for a Submit operation.
* DELETE is returned for a Delete operation.
* GET is returned for a Display operation.
* GETLIST is returned for a Query List operation.
* SET is returned for a Modify operation.
* QUERY is returned for a Query operation.

$OS$ Operating system that the current process is running
under.

$SCHEMA$ Schema currently operating on.

$SERVER$ Server currently operating on.

$TIME$ Current time. In a date/time field, the date defaults to
the current date.
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Note – These keywords are especially useful for specifying default values (see
Chapter 7, Customizing the Environment), in query definitions (see Chapter 4,
Reviewing and Modifying Action Requests), and in macro definitions (see
Chapter 6, Using Macros).

Special Data Entry Operations
The Text Edit and Diary Entry windows provide the means for compiling
narrative information about the condition described in an AR.

Using the Text Edit Window

If a character field has a maximum length of 70 characters or more, you are
able to open a Text Edit window in which you can enter up to a maximum of
65,000 characters. Simply select the text edit pop-up symbol to display the Text
Edit window, as described as follows and shown in Figure 3-6 on page 54.

$TIMESTAMP$ Current date/time stamp.

$USER$ Name of the user who is currently logged in.

$WEEKDAY$ Current day of the week.

Table 3-1 Keywords  (2 of 2)

Keyword Substituted Value
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Figure 3-5 Text Edit Window

To use the Text Edit window:
If your text entry is short enough to be visible in the field, simply type into the
field. Otherwise, do the following:

1. Select the text edit pop-up symbol to the right of the field to open the Text
Edit window. A Text Edit window appears (Figure 3-5).

Text Edit
Window.

Select the text
edit pop-up
symbol next
to a long
character
field to open
the Text Edit
window.
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Note – If there is no text edit pop-up symbol beside the field it is because the
field is shorter than 70 characters.

2. Select anywhere in the Text Edit window and begin typing or copying
from other windows.

3. When you have finished, select the Apply button.
If you selected Leave window up for the Submit window -
Text Edit/Diary window Apply action preference on the Preferences
window, the Text Edit window remains up until you select the Dismiss
button. If you selected Close window for the Submit window - Text
Edit/Diary window Apply action preference, the Text Edit window closes.
For more information about preferences, see Chapter 2, Getting Started with
the User Tool.

Selecting the Dismiss button before selecting the Apply button removes the
Text Edit window without saving any edits.

Using the Diary Entry Window

Diary type fields are where you keep a narrative history of actions taken on an
AR. They allow you to open a Diary Entry window where you can add a
comment about actions taken on the AR. Each addition to the diary is name,
date, and time stamped. A diary field can be set to a maximum of 65,000
characters. Select the diary pop-up symbol as described as follows and shown
in Figure 3-6 on page 54.

Typically, you would update a diary field any time a notable change has
occurred that is not automatically captured in the Status History or in another
field. See Adding a New Diary Entry in Chapter 4 for information on how to
update the diary field on an existing AR.

On the Display and Modify Individual windows, the diary pop-up symbol
appears different when the diary entry field contains information. The pages in
the diary pop-up symbol appear to contain text. This way, you can tell at a
glance if the field contains any information.

Note – You can make additional diary entries after an AR is submitted.
Previous entries cannot be edited; they can only be reviewed.
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Figure 3-6 Diary Entry Window

To use the Diary Entry window:
If your text entry is short enough to be visible in the field, simply type into the
field. Otherwise:

1. Select the diary pop-up symbol to open a Diary Entry window
(Figure 3-6).

2. Select in the Diary Entry window to enter text and begin typing or
copying from other windows.

3. When you are finished, select the Apply button.
If you selected Leave window up for the Submit window -
Text Edit/Diary window Apply action on the Preferences window, the Diary
Entry window remains up until you select the Dismiss button. If you

Diary Entry
window.

Select the diary
pop-up symbol to
open a Diary
Entry window.
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selected Close window for the Submit window - Text Edit/Diary window
Apply action preference, the Text Edit window closes. For more information
about preferences, see Chapter 2, Getting Started with the User Tool.

Selecting the Dismiss button before selecting the Apply button removes the
Diary Entry window without saving any edits.

Using Active Links

An active link is an operation that the AR System administrator has set up to
execute automatically when you perform certain actions while filling in,
viewing or modifying an AR. Since your AR System administrator can set up
an active link to execute only when certain conditions are met, an active link
may not always execute. An active link may cause one of the following actions:

• Execute a macro.

• Open a Submit window.

• Fill in fields automatically.

• Run another program.

• Move the focus to a different field.

• Change the type of field. (Read, Write, or Disabled).

• Display a Note, Warning, or Error message.

• Change the items on a menu.

Depending on how the AR System administrator has set up the active link, you
may trigger the operation by one of the following actions:

• Selecting a button.

• Selecting a radio button.

• Selecting an item on a character menu.

• Submitting, displaying or modifying an AR.

• Setting default field values on either the Submit or Query window.

• Pressing Return in a field.
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Note – In a multi-line text field, you need to press Shift+Return to activate this
type of active link.

Your AR System administrator may have attached more than one active link to
any of these actions. In this case, performing an action can trigger more than
one operation.

In the example shown in Figure 3-7, selecting the active link button called “Get
Similar” caused a macro to be executed that produced a Query List window
containing entries that were similar to the problem being entered using the
TroubleTicket schema. For more information about Query List windows, see
Chapter 4, Reviewing and Modifying Action Requests.

Figure 3-7 Active Link Example

Active Link button.
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Note – Active links designed to execute on a different platform may generate
unexpected results. Contact your AR System administrator if you experience
problems while using a schema that includes an active link that was designed
for a different platform.

Selection Lists

If you activate an active link that does a query and then fills a field with the
value it finds as a result of the query, and if the query returns more than one
possible result, a Selection List window (pick list) is displayed letting you
select which value you want entered into the field. The Selection List window
contains the query list description of all of the ARs that match the query
criteria.

Note – Your AR System administrator can specify which fields are displayed in
a query list description for each schema and the order they are displayed. Also
any sorting options that you specify affect your Query List and Selection List
windows. So, if you activate an active link that returns a query list on two
different schemas, the selection list in the two Selection List windows might
not display the same field contents. For more information about Query List
windows and how your AR System administrator can customize them, see
Chapter 4, Reviewing and Modifying Action Requests and the Action Request
System Administrator’s Guide.

A good example of where you might see a Selection List window is if you have
an active link on your Job Requisition schema that queries your Recruiting
schema for all names of those candidates who interviewed for a particular job.
Suppose you have already interviewed three people for a secretarial position
entered in the Job Requisition schema. An AR has been entered in the
Recruiting schema for each of the three candidates.

When displaying the secretarial position in the Job Requisition schema in a
Modify Individual window, you can select the active link that queries the
Recruiting schema searching for all ARs listing people who interviewed for
this secretarial position. A Selection List window is displayed, as shown in
Figure 3-8, listing the three people previously interviewed and you can now
select the name you want entered into the Hired field on the Job Requisition
AR.
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Figure 3-8 Selection List Window

To use a Selection List window:
1. Select the value you want in the selection list and then select the Apply

button.

2. Selecting the Dismiss button removes the Selection List window without
filling a value in the field.

Setting Submit Window Preferences
You can control several aspects of how the Submit window looks and acts by
selecting Preferences from the File menu in the Query window. You can set
fields to be cleared, loaded with your defaults, or retained with their previous
contents after each successful submission. You can also specify whether you
receive a confirmation box and a footer or only a footer when you successfully
submit an AR. For more information on how to set Submit window
preferences, see Setting User Preferences in Chapter 2.
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You can use the Query window of the User Tool to look at or modify any AR or
set of ARs that your AR System administrator has given you permission to
look at or modify. For example, you might want to look at all the ARs that
were submitted during the last month for a particular piece of equipment. You
can do so by defining a query that locates the ARs you are interested in and
performing an operation to display those ARs.

To find specific ARs, you query the database; that is, you specify a set of search
criteria that define the set of ARs in which you are interested. You specify
query criteria in one of two ways: by using a simple query-by-example
method, or, for more complex search conditions, by using the query bar. You
can also combine the two query methods to search for results that match both.

Once you have found an AR or a set of ARs, you can perform many different
operations on them, including listing, displaying, modifying, deleting, and
generating reports or statistics based on their contents.

This chapter describes the Query window and tells you how to use it to review
and modify ARs. It covers the following topics:

• Defining query criteria using query-by-example (QBE).

• Defining query criteria using the query bar.

• Listing ARs in a one-line summary.

• Displaying ARs one by one.

• Modifying one or more existing ARs.
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• Deleting ARs.

• Using full text search.

Chapter 5, Reports describes how to create reports based on the contents of the
ARs.

General Steps for Querying the Database
When you query the database, you are searching for ARs that meet a specific
set of criteria. The following describes the general steps you use to query the
database.

To query the database:
1. In the Query window, select the schema you want to work with.

You select a schema by selecting Open Schema from the File menu, then
selecting the schema and the Apply button or double-clicking on the schema
you want in the list box (or typing Ctrl+O ).

2. Define the query criteria to be applied to the search by filling in fields in
the Query window or by using the query bar. (The query bar is an area at
the bottom of the Query window that allows you to easily “build”
complex query criteria.) See “Defining Query Criteria” on page 62 for
more detailed information.

3. Select the operation that you want to perform on the ARs from the Query
menu. See “Using a Null Value in a Query” on page 189 for more detailed
information.
The Query menu is shown in Figure 4-1.
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Figure 4-1 Query Menu

Defining Query Criteria
The query criteria you specify determine which AR or set of ARs the system
selects for a query operation. There are two ways that you can specify query
criteria, creating a query-by-example and using the query bar, as shown in
Figure 4-2.

Define the
query
criteria.

Then
select a
query
operation
.
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Figure 4-2 Specifying Query Criteria

Query-by-Example

The simplest way to specify query criteria is to fill in fields and select choices
and radio buttons in the Query window that match the ARs you want to find.
This is called creating a query-by-example.

When filling in character fields, you need to be aware of the default search
style that your AR System administrator specified for the field. The three
different search styles are: Equal, Leading, and Anywhere.

The Equal search style means that whatever you enter into the field is searched
for exactly. For example, if you enter Bob Smith  in the Submitter field you only
find all ARs submitted by Bob Smith, but not any submitted by Bob Smithe.

Query-
by-
Example:
 fill in this
part of
the
window
to
“match”
the ARs

Query Bar: use when you want to define more complex search
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The Leading search style means that whatever you enter into the field is
searched for at the beginning of the field with any number of trailing
characters. This means that the query will return every AR with this field that
contains the first characters exactly as you entered plus any characters that
may follow. For example, if you enter Bob in the Submitter field you will find
all ARs submitted by Bob Smith, as well as those submitted by Bobby Jones.

The Anywhere search style means that whatever you enter into the field is
searched for anywhere within the field. For example, if you enter Bob in the
Submitter field you find all ARs submitted by Bob Smith, as well as those
submitted by Bobby Jones and Jill Bobbington.

Equal and Leading searches are faster than Anywhere searches since
Anywhere searches have to compare each character in the field while Equal
and Leading searches do not.

You can override your administrator’s default search style by entering exactly
what you are searching for using relational operators and wild card characters.
However, doing this you lose any performance gains that would result from
using the Equal or Leading search styles. For more information, see “Using
Relational Operators in the Query Window” on page 65 and “Using Wild Card
Symbols” on page 67.

To find out what search style your AR System administrator specified for a
particular character field, display the context sensitive help for that particular
field. For more information on context sensitive help, see “Displaying Help” on
page 31 in Chapter 2, Getting Started with the User Tool.

You can perform an unqualified query by first clearing all fields and then
querying for all ARs that match anything in every field. This type of query
returns all ARs submitted using this schema. While this is useful for some
schemas, if the schema contains a large number of ARs, this type of query
could overload your server. In this case, your AR System administrator might
specify that you can’t perform an unqualified query for all schemas on a
particular server. If you try to perform an unqualified query on a protected
server, you receive an error message informing you that this is not allowed and
that you need to specify some query criteria.

For a more precise query, you can specify values for more than one field. The
system searches for ARs that meet all of the criteria (logical AND), so the more
fields you fill in the more specific your query becomes.
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Query Bar

The second method for specifying query criteria is to use the query bar at the
bottom of the window. The query bar lets you define a more complex set of
criteria. It also allows you to use a Status History field item in a query, which
is not possible in a query-by-example. For more information, see “Using the
Query Bar” on page 69.

You can use both the query-by-example style and the query bar at the same
time. However, it is important to remember that any criteria you enter in the
query bar is used in addition to the criteria you have defined in the query-by-
example section of the window. That is, the two sets of criteria are logically
ANDed.

Note – You can record and save frequently used and complex queries as
macros that can be run automatically at any time. For more information, see
Chapter 6.

To define query criteria:
1. Fill in fields in the query-by-example section of the Query window or use

the query bar to define a query statement.
You can use relational operators (<, >,!= , <=, >=, =) and wild card symbols to
further define query criteria. For more information, see “Using Relational
Operators in the Query Window” on page 65 and “Using Wild Card Symbols”
on page 67.

Select Clear All from the Edit menu (or type Ctrl-E ) to clear all fields.

Select Set to Defaults from the Edit menu (or type Ctrl-U ) to fill in fields
with pre-set default information. For information on specifying default
values, see Chapter 7.

2. After you have finished defining query criteria, select a query operation.
For more information, see “Using a Null Value in a Query” on page 189.

Using Relational Operators in the Query Window

You can use the relational operators shown in Table 4-1 anywhere in the Query
window. Relational operators are especially useful in non-text fields (such as
date and time fields) when you want to query for a value within a numerical
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range. (See Table 4-3 on page -72 in the section titled “Using Operators in the
Query Bar for the list of additional operators you can use only in the query
bar.)

Note – You can override the search style specified by your AR System
administrator using relational operators. For example, you can use = (an equals
sign) to search for an exact match even if your AR System administrator
specified the search style to be Anywhere. For more information about the
different search styles, see “Query-by-Example” on page 63.

The example shown in Figure 4-3 uses the “=” (exactly equal to) relational
operator. In the example, Open Ticket Status is selected and =Bob is entered in
the Submitter field. The resulting search finds all open ARs with an exact
match for “Bob” in the Submitter field.

Note – By entering =Bob into the Submitter field you override the default
search method specified by your AR System administrator for that field.
Entering =Bob into the Submitter field means that an Equal search method is
done in that field.

Table 4-1 Relational Operators Used in the Query Window

Operator Action

< Match contents that are less than the value.

> Match contents that are greater than the value.

!= Match contents that are not equal to the value.

<= Match contents that are less than or equal to the value.

>= Match contents that are greater than or equal to the value.

= Match contents that are exactly equal to the value.
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Figure 4-3 Using a Relational Operator

To search for all ARs created after a date or time, simply use the “>” (greater
than) relational operator and one of the date and time formats discussed in
“Filling in Fields” on page 45 in Chapter 3. For example, set Modified Date to
> June 5, 1992  to select all ARs modified after June 5, 1992 12 am.

Using Wild Card Symbols

You can use wild card symbols when you are defining query criteria in
character and diary fields. The available wild card symbols and their meanings
are shown in Table 4-2.

Table 4-2 Wild Card Symbols  (1 of 2)

Wild Card Meaning

% Use to match any string of 0 or more characters.
For example: J%son matches Jackson, Johnson, Jason, and Json.

_ (Underbar). Use to match any single character.
For example: B_b matches Bab, Bob, and Bub.
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You can force interpretation of wild card characters as explicit characters. To
use the percent symbol (%), underbar ( _ ) or open bracket ( [ ) as an explicit
text character, you must enclose the character in brackets. For example, [%]
matches the % character, and does not find 0 or more characters.

The close bracket ( ] ) functions as a wild card only when it is accompanied by
an open bracket ( [ ). The hyphen functions as a wild card character only when
preceded by an open bracket ( [ ) or ( [^ ).

In the query-by-example section, the %, underbar ( _ ), and open bracket ( [ )
symbols always function as wild card symbols except in the following
scenarios where they function as explicit characters:

• When you specify one of the relational operators (for example: >, =).

• When your AR System administrator specified a default search style of
Equal and you do not use any leading or trailing % (percent signs).

- (Hyphen). Use to indicate a range. Always use within brackets ( [ ] ).
See next example.

[ ] Use to match any single character within a specified range or set. For
example: [a-f ] matches the range of characters a through f while
[abcf ] matches the set of characters
a, b, c , or f .
Note, using square brackets and the LIKE  operator works for flat
files, Sybase, and Ingress. Using square brackets and the LIKE
operator does not work with Oracle or Informix. Refer to Database
Considerations in Chapter 4 of the Action Request System Installation
Guide for more information.

[^] Use to match any single character not within a specified range or set.
For example: [^a-f ] matches all characters except the range a
through f while [^abcf ] matches all characters except a, b, c , or f .

Table 4-2 Wild Card Symbols  (2 of 2)

Wild Card Meaning
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Note – You can override the search style specified by your AR System
administrator by using a leading %. For example, if your AR System
administrator specified the search style to be Equal, and you enter %Rob into
the Submitter field, your search finds Robert Smith as well as Jim Robertson
and not only any exact or equal matches to %Rob. However, if you use a leading
%, you lose any performance gains that would result from using the Equal or
Leading search styles. For more information about the different search styles,
“Query-by-Example” on page 63.

In the query bar, wild card symbols are only interpreted as wild cards when
used with the LIKE  operator; otherwise they are interpreted as explicit
characters. The query bar also requires that you use the % symbol when you
want to include leading or trailing characters in your query. For example, if
you want to find Jill Bobbington, Bobby Fenton, and Bob Compton, you would
enter the following in the query bar:

'Submitter' LIKE ''%Bob%ton%''

To execute this same query in the query-by-example section when the search
style for the field is “Anywhere”, you would simply enter Bob%ton in the
Submitter field, taking advantage of the fact that the system assumes you want
to allow for leading and/or trailing characters.

Using the Query Bar

Use the query bar, as shown in Figure 4-4 on page -70, when you want to
define a query that does more than simply find ARs with fields that match an
example. The query bar lets you define more complex logical statements. For
example, you may want to match one field or another. You also use the query
bar whenever you want to use a Status History field item in your query.
Remember that the criteria you enter in the query bar are used in conjunction
with any criteria defined in the query-by-example section of the window.
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Figure 4-4 The Query Bar

You can define a query statement in the query bar by using any of the
following techniques:

• Type information in the Query field.

• Click on a field label in the query-by-example area to add a field.

• Select a field label or a keyword from the Fields menu to add a field, a status
history item, or a keyword.

• Select an operator from the query bar palette to add an operator.

Add operators by selecting from the palette. Add field names
from the Fields
menu.
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Note – You can hide the query bar from view if it is not used. To hide (or
display) the query bar, select Preferences from the File menu. See “Setting User
Preferences” on page 27 in Chapter 2.

You must follow certain formatting conventions in constructing the query
statement. The sections that follow describe these conventions as well as the
logical and arithmetic operators that you can use.

To enter information in the query bar:
1. Add a field name to the query bar using any of the following methods:

• Select the Fields pop-up symbol to the right of the Fields label to display
the menu that contains a list of all the fields on the schema. You can then
select any listed field name. You can also select a Status History field item
or keyword from the list.

• Click on a field label in the query-by-example area to add it to the query
bar within single quotes.

• Type the field name, enclosed in single quotes, in the query bar. (Field
labels that use spaces or special characters must be enclosed in single
quotes. You may want to establish the habit of using single quotes even
when they are not specifically required for the field specification.)

For example, if you select the field name ‘Ticket Status’, you see:

'Ticket Status'

2. Type an operator or select the appropriate operator from the palette in the
query bar.
The operator is added to the query bar.

For example, if you select (or type) the equals sign (=), you see:

'Ticket Status' =

3. Select another field or type a field value.
When typing in a field value, non-numeric values must be enclosed in double
quotes. These values are case and space-sensitive.

For example, you could type “Open” in the query bar.

'Ticket Status' = ''Open''
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4. Continue adding operators, field names and field values until you have
completed the search statement. You can put spaces between operators,
field names and field values, but you don’t have to.
For example:

'Ticket Status' = ''Open'' OR 'Ticket Status' = ''Escalated''

5. When you are ready to perform the query, select the query operation you
want from the Query menu. The menu selections are described in “Using
a Null Value in a Query” on page 189.

Query Bar Format and Syntax

You must follow a set of formatting conventions when you build a query in the
query bar. You can use the relational operators and wild card symbols shown
in Table 4-1 on page 66 and Table 4-2 on page 67 in the query bar. You can also
use the operators shown in Table 4-3 on page 72.

The preceding example, 'Ticket Status'= ''Open'', finds only the ARs with a
status of “Open”. By itself, this may be the lowest common denominator in
your search but it may also provide you with far too many matches. To avoid
the frustration of going through all of them, you can refine your search by
using the query bar operators. Refining your query criteria helps you narrow
down the number of ARs you need to deal with when searching for a specific
answer.

Using Operators in the Query Bar

You can use the operators shown in Table 4-3 in the query bar in addition to
the wild card characters described earlier in Using Wild Card Symbols

.
Table 4-3 Operators Used in the Query Bar  (1 of 3)

Operator Action

AND

&&

Logical AND of the result of two conditions (the result is true only if both conditions are
true). For example, 'Status'=''New'' AND 'Assigned-to'=''Andy''  would find
all new ARs assigned to Andy. You can use the symbol && or the word AND.
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OR

||

Logical OR of the result of two conditions (the result is true if either condition is true). For
example, 'Status'=''New'' OR 'Assigned-to'=''Andy''  would find all new
ARs or all ARs assigned to Andy (no matter what their status). You can use the symbol
||  (two vertical lines) or the word OR.

NOT

!

Negates the condition that follows (if the condition is false, the result is true). For
example, NOT 'Status'=''New''  would find all ARs that are not new. You can use the
symbol ! or the word NOT.

LIKE Performs a pattern search. For example, 'Submitter' LIKE ''Bob%ton''  would find
all ARs with a submitter name that begins with the letters “Bob” and ends with the
letters “ton” — such as Bob Compton and Bobby Fenton. The LIKE  operator is useful
only with character and diary type fields.
Note, using square brackets and the LIKE  operator works for flat files, Sybase, and
Ingress. Using square brackets and the LIKE  operator does not work with Oracle or
Informix. Refer to Database Considerations in Chapter 4 of the Action Request System
Installation Guide for more information.

+ * Adds two integer or real values.
* Adds an integer interval to a time value.
* Concatenates two character strings.
For example, 'Create-date' > $DATE$ + 28800  would find all ARs that were
created after 8:00 am today. (28800 is the number of seconds in 8 hours.)

- * Subtracts two integer or real values.
* Subtracts two time values (resulting in an integer).
* Subtracts an integer interval from a time value.
For example, 'Create-date' > $DATE$ - 604800 would find all ARs that were
created within the past week. (604800 is the number of seconds in one week.) This is
useful in a weekly custom report of all ARs created in the past week.

* Multiplies two integer or real values. For example,
'Quantity' * 'Price' > 50  finds all ARs where the contents of the Quantity field
times the contents of the Price field is over 50.

/ Divides two integer or real values. For example,
'Total Expenses' / 'Total Income' = 1  would find all ARs where the total
amount spent for expenses equaled the total amount brought in as income.

Table 4-3 Operators Used in the Query Bar  (2 of 3)

Operator Action
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Operator Precedence

When you use multiple operators in constructing qualification criteria, they are
executed in the following order of precedence (in the following order that they
appear within the qualification):

1. ( )

2. !, NOT, - (unary minus)

3. *, /, %

4. +, -

5. <, <=, >, >=, =, !=

6. && (AND)

% Modulo of two integer values (the remainder of a divide of the values). Since a percent
sign is also a valid wild card symbol, the context when using a percent sign determines
how it is interpreted. For example,
'ID' % 2 = 1  finds all ARs with an odd number in the ID field.

< Matches contents that are less than the value. For example,
'Create-date' < ($DATE$ - 86400)  would find all ARs created more than 24
hours ago. (86400 is the number of seconds in 24 hours.)

> Matches contents that are greater than the value. For example,
'Create-date' > "06/10/93 00:00:00"  would find all ARs with Create-dates that
are newer than June 10, 1993 at midnight.

!= Matches contents that are not equal to the value. For example,
'Status' != "Closed"  finds all ARs that aren’t closed.

<= Matches contents that are less than or equal to the value. For example,
'Salary'<= 10000 would find all ARs where the contents of the Salary field is less
than or equal to 10000.

>= Matches contents that are greater than or equal to the value. For example, 'Create-date'
>= "10/31/94"  would find all ARs with Create-dates equal to or more recent than
October 31, 1994.

= Matches contents that are exactly equal to the value. For example,
'Status' = 0  would find all ARs with a status value equal to the first selection value.

Table 4-3 Operators Used in the Query Bar  (3 of 3)

Operator Action
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7. || (OR)

If the same operator is included more than once in the same qualification (or
two operators of the same precedence are used in the same qualification), the
first time each operator is found going from left to right it is performed.

Query Bar Statement Conventions

Use the following conventions to construct a query statement in the query bar.

Fields Enclose field labels in single quotes. Single quotes are automatically added
when you select fields from the Fields menu or when you select fields by
clicking on them in the query-by-example part of the window. For example:
'Short Description'

You can also reference fields by using their internal field ID. If you use the ID,
you must enclose it in single quotes. For more information about the field ID,
see the Action Request System Administrator’s Guide.

Note – If a field name contains a single quote, you must double the embedded
single quote (that is, use two single quotes). For example, if the field is named
“Submitter’s Phone Number” you need to enter it as 'Submitter''s Phone

Number' . This is done for you automatically if you select the field name from
the Fields menu or by selecting the label in the query-by-example section.

Values Enclose non-numeric values (including time and selection values) in double
quotes. For example: ''07/01/92''

You can use the special value $NULL$ (without quotes) to query for ARs that
have no value in a field. For example, to query for ARs that have not been
assigned (fields with no value in the Assigned-to field), you would enter:
'Assigned-to' = $NULL$

Selection field values can either be specified as the text value in quotes or the
numeric value not in quotes. For instance, if you have a Status field with the
following radio buttons: Open, Fixed, and Verified, to specify the value of Open
you can either enter Open or 0, since Open is the first selection value in the
selection field.

Status Status History field items must have the following
History information and format enclosed within single quotes:

• The name or ID of the Status History field (followed by a period).
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• The name or index of the status value you want to match (followed by a
period).

• The keyword USER (for the user who changed the AR to that status) or TIME

(for the time last changed to that status).

• For example: 'Status-History.Fixed.TIME' < ''07/01/92''

or using field IDs: '15.3.1' < ''07/01/92''

The correct syntax is entered for you automatically if you choose the status
history reference from the Fields menu.

Examples of Query Statements
• Find all ARs that were submitted by someone other than the current user.

The example uses the not equal to operator (!= ) to find instances where the
value in the Submitter field is not equal to the currently logged in user. Note
the use of the $USER$ keyword.

'Submitter' != $USER$

• Find all ARs that were submitted after 10:00 am on the current day. The
example uses the greater than operator (>) to find ARs where the value of
the Create-date field is greater than the current day at 10:00.

'Create-date' > ''10:00:00''

• Find all ARs that have been submitted for any problem having to do with
printing. The example uses the LIKE  operator to perform a pattern search
that finds ARs with the word “Print” or “print” anywhere in the Submitted
Problem Type field.

'Submitted Problem Type' LIKE ''% [Pp]rint%''

• Find all ARs with a Status of Released. Notice the spaces after the word
“Status” in the field specification. In this case, the spaces exist in the field
label as defined on the schema being used. Because the AR System
recognizes any spaces that exist, the spaces must also be included in any
qualification statement for that field. If you use the Fields menu, by
selecting the Fields menu on the qualification bar, the spaces (and single
quotation marks) are added for you automatically.

'Status' = ''Released''
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Query Operations
Once you specify the query criteria to select the ARs on which you want to
perform an operation, you use the Query menu to select the operation. The
Query menu is shown in Figure 4-5.

Figure 4-5 Query Menu

You can select any of the following operations:

Table 4-4 Query Operations

Operation Action

List Displays a one-line summary of each AR.

Display Displays a read-only view of each AR.

Modify
Individual

Displays an editable view of each AR.

Modify All Displays a blank schema that allows you to make
modifications to all ARs that match the query criteria or
were selected.

Report Opens a Report window that allows you to generate a
formatted report on the ARs that match the query criteria or
were selected.

Delete Deletes ARs (administrator and subadministrator only).
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When you select an operation, the system executes the search according to the
criteria you specified and opens a window that relates to the operation you
selected. Depending on the operation, you may need to perform additional
tasks. For example, if you select Report, you need to specify the report format.
(See Chapter 5, Reports, for more information on report formats.)

You can specify how your query operation results are sorted by selecting the
Sort Options menu item on the Actions menu.You can also specify the
maximum number of ARs to return in your query operation using the Max in
query preference on the Preference window which you can display by selecting
the Preferences menu item on the File menu.

After performing an operation, you can return to the Query window and select
another operation (changing the criteria if you wish).

The results of each new query appear in a separate window, as illustrated in
Figure 4-6 on page -79. All windows remain open until you dismiss them or
log in as a different user. You can also iconify any window.
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Figure 4-6 Results of Multiple Query Operations

The following sections describe how to sort your query operation results as
well as how to specify the maximum number of ARs to return in your query
operation. They also describe the List, Display, Modify Individual, Modify All,
and Delete operations in detail. For more information about the Report
operation, see Chapter 5, Reports.

Sorting Query Operation Results

You can specify a sorting order that affects how the results of your query
operations are displayed. You can specify up to five fields with each field
ordered either in ascending or descending order and you can define a different
sort order for each schema. Once you specify a sorting order, it remains in
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effect until you change it. You can sort by any field with the exception of Status
History, Diary Entry fields, or Text Edit fields (fields with a maximum length of
over 255 bytes).

Once you specify a sorting order, the next time any open Query List window
with the Polling field set to On automatically reissues the query, the Query List
window changes to reflect the new sorting order. The next time you manually
reissue a query from a Query List window by selecting Refresh on the Query
menu, the Query List window changes to reflect the new sorting order. Also,
any Query List windows that you open after you specify or change the sorting
order reflect this new sorting order. For more information about opening new
Query List windows, or about automatically and manually reissuing a query
from a Query List window, see “Listing Action Requests” on page 84.

By default, all ARs are sorted by entry ID in ascending order, thereby listing all
ARs in ascending order by create date (oldest AR first with the newest AR
last). One example where you might want to sort the results of your query
operation is if you want the most recently entered AR at the top of your query
list, or to be the first AR in the Display or Modify window. To do this, you can
list all ARs in descending order by entry ID or create date. Figure 4-7 on page -
81 illustrates a Query List window with this type of sorting.
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Figure 4-7 Query List Results in Descending Order

Another example would be if you were an Engineering Manager and you
needed to produce a report that sorted all bug report ARs first by product, then
under each product by the responsible engineer, then by the priority, and
finally under each engineer by the status of the AR (whether it is still open or
closed) and then sort them in descending order by date (most recent AR first).
To accomplish this, first sort by the Product field, then by the Responsible
Engineer field, then by priority, then by the Status field, and finally by the Date
field in descending order. (To see all of these fields in your Query List window,
see your AR System administrator.) Sorting like this allows you to see quickly
how the engineers for each of your products are doing, how many ARs they
have in each priority setting and how many of them are still open or have been
closed. Figure 4-8 on page -82 illustrates this type of sorting.
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Figure 4-8 Sorted Results

As a slight variation, you could check on the overall status of a particular
product by first sorting by the Product field, then by the Priority field, and
finally on the Status field.

If you needed to produce this report on a regular basis, you could create a
custom report and specify these sorting options to go into effect only when the
custom report is run. This way you can specify one sorting order for your
normal query operations and a separate sorting order for each of your custom
reports. For more information about specifying sorting options when creating
custom reports, see Chapter 5, Reports.

To specify query operations sorting order:
1. Select Sort Options from the Actions menu to display the Field Sort Order

window (or type Ctrl+A ), as shown in Figure 4-9.



83 Action Request System User’s Guide for OSF/Motif—January 1996

4

Figure 4-9  Field Sort Order Window

2. Select the menu symbol to the right of the Field Name field.
All of the fields on the current schema that you can sort by are displayed.

3. Select the field you want to sort by.

4. Select either the Ascending or Descending Sort Order radio button next to
the Field Name field you just edited.

5. Continue specifying up to five fields with their sort order.
The first field you select to sort by is the first criteria used for sorting, the
second field is the second criteria, the third field is the third criteria, the
fourth field is the fourth criteria, and the fifth field is the fifth criteria used
for sorting.

6. Select Permanent in the Status field to apply this sorting order to all
operations.
Select Next Operation to apply this sorting order to the next query operation
only, and then return to the current sort order.

Select Disable to return to the default sort order. If no sort options are
specified or if Disabled is selected, the items in the query operations are
sorted in ascending order by entry ID.

7. Once you are finished specifying your field sort order, select the Apply
button.
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8. Select the Dismiss button to remove the Field Sort Order window and
return to the Query window.

Specifying a Maximum Number of ARs

You can specify a maximum number of ARs that you want displayed when
doing one of the query operations. By doing this, you can control the number
of ARs that match your query criteria that are displayed at any one time.
Should you perform a query operation that matches more than this specified
maximum value, you receive a warning message letting you know that there
are more ARs that match your specified query criteria that are not being
returned in your results. Specifying a maximum number of ARs is useful if
issuing an unqualified query would return too many ARs and impact the
performance of your AR System by slowing down the server. For more
information about specifying a maximum number of ARs, see the section
entitled “Setting User Preferences” on page 27 in Chapter 2.

Listing Action Requests

Select List from the Query menu (or type Ctrl+L ) to display each AR that
matches the query criteria you have defined, as shown in Figure 4-10 on page -
84.

Figure 4-10 Query List Window
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Your AR System administrator can specify which fields are displayed in the
Query List window for each schema and the order in which they are displayed.
Also any sorting options that you specify affect your Query List window. So, if
you perform a query list on two different schemas, they might not display the
same field contents. If aurora System administrator has not specified different
fields for display, and you haven’t specified any sorting options, you will see
the contents of the Entry ID and Short Description fields. (The Entry ID and the
Short Description are required fields and therefore exist on all schemas. Your
AR System administrator may have changed the name of the Short Description
field, but its contents still appear in the results of the list operation when the
default list fields appear.)

The number of matching ARs appears below the list of matching entries in the
Query List window along with the time at which the list was retrieved.

Selecting List is a convenient way to determine if the query criteria you have
specified produces too many ARs. If the number of ARs shown in the list is
unmanageable, you can return to the Query window to refine the query criteria
and re-display the query list until the list contains only the ARs you want to
work with.

You can manually or automatically update the list of ARs in a Query List
window to indicate any changes to the ARs that match the query criteria. You
can automatically update the list by selecting On in the Poll field and then
specifying after how many minutes you want the Query re-issued and a new
Query List displayed. You can manually update the list by selecting the
Refresh button. This is useful if you use the list of matching ARs in a Query
List window as your list of things to do. For instance, by updating this list on
a regular basis, it will always contain all new ARs that are assigned to you.
Also, by updating this list, you remove any ARs that have been assigned to
someone else and are now no longer your responsibility.

Note – Since updating your query list affects the performance of your server, we
recommend that under normal circumstances you automatically update your
query list at five minutes or greater intervals. If you find that you need to
update your query list more frequently, you can manually update it at any
time.



Reviewing and Modifying Action Requests 86

4

You cannot update a query list if the Query List window was opened by
selecting the To Query List command from a Display, Modify, Report, or Delete
window when those windows were opened by selecting a subset of items on a
previous Query List window. In other words, you cannot update a Query List
window when the window is not a direct result of a query.

You can select specific ARs from the list and perform further Query operations
(Display, Modify Individual, Modify All, Report, or Delete) on just those
selected.

Note – You cannot edit information in the Query List window.

To use the Query List window:
• To select an item in the list, click on the item. Selected items are highlighted.

• To de-select an item, click on the item again.

• To select more than one item, just move the pointer onto the items you want
to select and click on the items.

• To perform another operation on selected items (or the entire list of items if
no specific items are selected), select the operation you want from the Query
menu with the items highlighted. You can also open a Display, Modify
Individual, or Report window for an item by double-clicking on the item.
The item you double-click on is the first item displayed in the Display,
Modify Individual, or Report window. (Whether the double-click action
opens a Display, Modify Individual, or Report window is determined by
your Double-click action on query preference setting. See “Setting User
Preferences” on page 27 in Chapter 2.)

• To re-display the query criteria for this list, select Show Query from the
Actions menu (or type Ctrl+B ). This reloads the query criteria into the
Query window.
You may want to further refine the query criteria if you found the list
included too many irrelevant ARs.

• To manually update the query list to reflect any changes made to the ARs
that match the query criteria, select the Refresh button.

• To automatically update the query list to reflect any changes made to the list
of ARs that match the query criteria, select the Poll On radio button and
then specify in the Minutes field the number of minutes after which you
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want the query re-issued and the list updated. You can change the value in
the Minutes field either by first selecting the field and then typing, or by
using the up and down arrow keys to increment or decrement the field
value. The query list is automatically updated at the specified time interval
as long as the Query List window is displayed. Since you cannot update a
Query List window when the window is not a direct result of a query the Poll
field is grayed out in these Query List windows. The minimum number of
minutes you can specify in the Minutes field is 1 while the maximum number
of minutes is 59. The default number of minutes is 10.

• To dismiss the Query List window, select the Dismiss button.

Displaying Action Requests

Select Display from the Query menu (or type Ctrl+D ) to view ARs that match
the query criteria defined in the active Query window or that are selected in an
active Query List window, as shown in Figure 4-11 on page -88.

In a Query List window, you can display a subset of the listed items by
selecting only the items you want to display.



Reviewing and Modifying Action Requests 88

4

Figure 4-11 Action Request Display Window

The Display window shows one AR at a time. Use the Previous and Next
buttons to page through the list of ARs. The total number of ARs to be
displayed appears at the bottom of the window. If the number of ARs ready for
display is too large to be manageable, you can return to the Query window to
refine the query criteria and then re-display the ARs.
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The Display window allows you to view the status history for each AR. The
status history shows the progress that has been made since the AR was
submitted. Select Show Status History from the Actions menu (or type Ctrl+H )
to view the status history.

You can trigger active links set up by the AR System administrator from within
the Display window. However, since the screen is read-only, the Set Fields
operation of active links will not be performed. For more information, see
“Using Active Links” on page 55 in Chapter 3.

Note – You cannot change information in the Display window. To modify an
AR, you must use the Modify Individual or Modify All operation (see
“Modifying Action Requests” on page 92).

To use the Display Window:
• To display the previous or next AR, select the Previous or Next button. If

there is only one AR, these buttons are not available (grayed out).

• To re-display the query criteria in the Query window, select Show Query
from the Actions menu (or type Ctrl+B ). This reloads the query criteria into
the Query window.
You may want to further refine the query criteria if you found the list
included too many irrelevant ARs.

• To display the Query List window, select Goto Query List from the Actions
menu (or type Ctrl+L ). The Display window is dismissed and a Query List
window is opened containing all of the ARs from the Display window.

• To review the history of status changes for the AR, select Show Status
History from the Actions menu (or type Ctrl+H ).

• To copy the contents of the Display window to a Submit window to submit
a new entry just like the current one, select Copy to Submit from the Actions
menu (or type Ctrl+T ). A Submit window is opened and all field contents
except any Diary fields are copied from the Display window to the Submit
window.
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Viewing the Status History

You can select Show Status History from the Actions menu to see what
progress has been made on the AR. The Status History window opens, as
shown in Figure 4-12 on page -90, showing the time the AR was last changed
to each of the states defined by the Status field and the name of the user who
made the change. You can leave the Status History window open and use
Previous and Next to view the status history of additional ARs.

Figure 4-12 Viewing Status History

To view the status history of an AR:
1. Display the AR in a Modify Individual or a Display window.

2. Select Show Status History from the Actions menu (or type Ctrl+H ).
The Status History window appears, as shown in Figure 4-12.

3. To view the status history for other ARs, select the Previous and Next
buttons on the Display window while the Status History window is still
open. The Status History window changes to reflect the status of the
currently displayed AR.
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Reviewing Diary Entries

The Display window also lets you review all existing entries for a Diary field,
as shown in Figure 4-13 on page -91. Diary type fields are used to keep a
history of actions taken on an AR. Typically, you might want to update a diary
field any time a notable change has occurred that is not automatically captured
in the Status History or in another field.

Figure 4-13 Viewing Diary Entries

If the Diary field contains existing entries the diary pop-up symbol looks like
there is writing on the pages of the icon. If the Diary field is empty the pages of
the diary pop-up symbol are blank. To display existing diary entries for a
Diary field, select the diary pop-up symbol to the right of the field.

Select the Diary Entry pop-
up symbol.

The Diary Entry window on
Display windows provides a
view-only display of
previously entered diary
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Modifying Action Requests

Select Modify Individual (or type Ctrl+M ) or Modify All from the Query menu
to modify the contents of ARs that match the criteria defined in an active
Query window or that are selected in an active Query List window, as shown
in Figure 4-14.

In the Query List window, you can select a subset of the listed items for
modification by highlighting only the items you want.

Figure 4-14 Action Request Modify Window

You can choose to modify individual ARs or the entire group of ARs that
match the query criteria. The techniques used to modify information in an AR
are the same as the techniques for entering information in the Submit window.
For a detailed description, see “Filling in Fields” on page 45 in Chapter 3.

If you choose to modify individual ARs, the Modify Individual window shows
one AR at a time. Use the Previous and Next buttons to page through the list of
ARs to display the ones you want to edit.
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If you choose to modify all selected ARs, a blank AR template is displayed in
the Modify All Selected window. Fill in only the fields that you want updated
on every AR that meets the specified query criteria. For example, you may
want to change the status of all the selected ARs to “Fixed”.

Note – Most active links set up by the AR System administrator may be
triggered from within either Modify window. However, active links that are
triggered when an AR is modified do not trigger from Modify All windows.
For more information, see “Using Active Links” on page 55 in Chapter 3.

To modify individual ARs:
1. After defining the query criteria or selecting ARs from the Query List,

select Modify Individual from the Query menu (or type Ctrl+M ).
The Modify Individual window appears (Figure 4-14).

2. Use the Previous or Next buttons to display the AR you want.

3. Edit the AR as necessary.

4. When you have finished editing the AR, select the Apply button to save
your changes.

Note – If you try to look at another AR by using the Previous or Next buttons
without first saving your changes, the system warns that your changes will be
lost.

If you have not made any changes, the error message does not appear and
the Apply button is grayed (not available).

5. After applying changes to an AR, you can use the Previous and Next
buttons to display another AR to edit.

To show the status history of an AR:
• To show the status history of the ARs in the Modify Individual window,

select Show Status History from the Actions menu (or type Ctrl+H ).
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To modify all selected ARs:
1. After defining the query criteria or selecting ARs from the Query List,

select Modify All from the Query menu.
The Modify All Selected window appears showing a blank AR template.
The number of entries being modified appears at the bottom of the window.

2. Fill in the fields you want changed on every AR that meets the query
criteria or that is selected on the Query List.

3. When you have finished filling in the fields you want changed, select the
Apply button.

4. A message box appears warning that you are about to update multiple
entries. To complete the operation, select the Continue button. To exit
without changing the ARs, select the Cancel Modify button.

Note – The values you entered replace the currently defined values for every AR
that meets the query criteria or that is selected on the Query List.

To re-display query criteria:
• To re-display the query criteria in the Query window, select Show Query

from the Actions menu (or type Ctrl+B ) on either the Modify Individual or
Modify All window. This reloads the query criteria into the Query window.

You may want to further refine the query criteria if you found the list
included too many irrelevant ARs.

To display query list:
• To display the ARs in a Query List window, select Goto Query List from the

Actions menu (or type Ctrl+L ). The Modify Individual or Modify All
windows is dismissed and a Query List window is opened containing all of
the ARs from the respective Modify window.

To submit a similar AR:
• To copy the contents of the Modify window to a Submit window to submit

a new entry just like the current one, select Copy to Submit from the Actions
menu (or type Ctrl+T ). A Submit window is opened and all field contents
except any Diary fields are copied from the respective Modify window to
the Submit window.
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Adding a New Diary Entry

Diary type fields are used to keep a history of actions taken on an AR.
Typically, you might want to update a diary field any time a notable change
has occurred that is not automatically captured in the Status History or in
another field.

Note – Diary entries from previous modifications of the AR cannot be edited;
they may only be viewed. If a diary field contains information, the diary pop-
up symbol looks like there is text written on the pages. If a diary field is empty,
the pages in the diary pop-up symbol look blank.

You can add new diary entries when you are modifying an AR using the Diary
Entry window shown in Figure 4-15.

Figure 4-15 Diary Entry Window

To add a new diary entry:
If your text entry is short enough to be visible in the field, simply type into the
field. Otherwise:

1. Select the diary pop-up symbol to the right of a field.
A Diary Entry window appears (Figure 4-15).

2. To enter text, click in the Edit portion (bottom panel in the window) of the
Diary Entry window and begin typing.

Sash
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Note – The diary text portion displays existing Diary entries and cannot be
edited.

3. If you need to resize either the bottom or top panel of the window, place
the pointer on the sash (the small square that is between the upper and
lower vertical scroll bars). Then, drag the box either up or down to enlarge
the lower or upper panel of the window respectively.

4. When you have finished, select the Apply button to save the new diary
entry.

Deleting Action Requests

Select Delete from the Query menu to remove ARs from the database that
match the query criteria defined in an active Query window or that are
selected in an active Query List window. To specify the query criteria, see
“Defining Query Criteria” on page 62.

Note – Only the system administrator or a subadministrator for a schema can
delete ARs. The Delete menu item is not available to you unless you have
administrator permission.

The Delete operation permanently removes ARs from the database. Deleted ARs
cannot be recovered unless a backup copy of the database is restored. This is
why we strongly recommend that your network or database administrator
backs up your database on a regular basis in case, among other things, an AR
is accidently deleted from the database.

To delete ARs:
1. After defining the query criteria, select Delete from the Query menu.

The Delete confirmation box appears, as shown in Figure 4-16, showing you
how many ARs will be deleted.
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Figure 4-16 Delete Window

You can re-display the query criteria by selecting Show Query from the
Actions menu (or typing Ctrl+B ). The Query window displays the query
criteria.

You can dismiss the Delete confirmation box and display the Query List
window containing all ARs that match the query criteria by selecting Goto
Query List from the Actions menu (or type Ctrl+L ).

2. Select the Apply button to permanently remove the selected ARs from the
database.
Selecting the Dismiss button cancels the Delete operation and removes the
Delete confirmation box. If you select the Dismiss button, no records are
removed from the database.

Using Full Text Search
This section discusses capabilities, performance, and administration issues of
the full text search (FTS) option. The topics covered include the following:

• Introduction to FTS.

• Who can perform a full text search.

• How to use FTS to retrieve records, especially using the accrue operator (the
LIKE  operator and comma separators) to search for matches.
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Note – If your site has not purchased the full text search option, or if you do
not currently have a full text search fixed or floating license, you will not be
able to take advantage of the full text search feature.

What is Full Text Search?

Full text search (FTS) is an important and extremely useful feature of the AR
System. The FTS option lets the AR System administrator index character and
diary fields for faster searches. During a search operation, FTS matches entries
from FTS-indexed fields against the search criteria you specify. Like database
indexes, an FTS index can greatly decrease the time required for a database
search.

Having FTS capability allows you to search for specific words regardless of the
underlying database, whether flat-file or relational. In contrast to only
searching fields in schemas that contain numeric data (for example, ID
numbers) or names (for example, submitters of tickets), indexing character and
diary fields for FTS lets you do searches of work diaries and long descriptions
of problems which some databases do not allow you to do directly.

Who Can Perform a Full Text Search?

Users must have a floating or fixed FTS license to do searches in fields indexed
for FTS. Full text licenses are separate from AR System write licenses.

If you have a fixed FTS license, you can perform a search in an FTS-indexed
field without worrying about licenses not being available or license time-outs.

If you have a floating FTS license but no floating FTS licenses are currently
available, you will get a warning the first time they perform a database
operation in the User Tool. The system will then use the search capabilities of
the underlying database (if available). When a floating license becomes
available, users will be alerted with a note and they will then be able to
perform a full text search.

Note – Users can tell if a field is indexed for FTS by looking in context-
sensitive help. See Figure 4-17 on page -99.
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Figure 4-17 Context-Sensitive Help Showing Full Text Options

How Do I Use FTS?

To use FTS to retrieve records, enter the search term in any field indexed for
FTS, just like an ordinary query. The big difference you will immediately notice
is how quickly the FTS operation retrieves records that match the search term.

Accruing and Weighting Results in an FTS

As mentioned earlier, accruing results of a search is a powerful FTS feature.
FTS does not limit you to searches for key words in FTS-indexed fields. You
also can use a special accrue operator (the LIKE  operator with comma
separated words) to cause the AR System to “accrue” and retrieve from the
database all the ARs that contain any or all of the comma separated words. For
more information, see “Using the Accrue Operator.

Records that are retrieved in an FTS are assigned a “weight” by the FTS engine.
WEIGHT is a number that varies from 0 to 100. With WEIGHT, the AR System sorts
the ARs in a query list using a “the more, the better” approach: if you set the

If field is
indexed, then
Full Text
Options reads
as shown.

The Help Text
will be blank
unless your AR
System
administrator
fills it in.

Your AR
System
administrator
sets the QBE
match,
choosing
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Field Sort Order in the User Tool to include WEIGHT in descending order, the
more search terms found in an AR, the earlier in the list it appears in the set of
retrieved ARs. The closer the weight number is to 100, the better it matched the
search criteria.

Sorting Records by Weight

Users can sort records retrieved in an FTS by weight, in descending or
ascending order, by selecting WEIGHT and the sort order in the Field Sort Order
window. For more information on setting the sort order, “Sorting Query
Operation Results” on page 79.

Using the Accrue Operator

You can use the accrue operator (the LIKE  operator with comma separators) to
search either in the Query bar or in any field indexed for FTS, as in the
following examples.

Note – You can use the accrue operator only with FTS-indexed fields.

Query Bar Method

Use the accrue operator in the Query bar, according to the following syntax:
<field> LIKE "ntclientd, notifier, ntserverd"

The accrue operator causes the AR System to retrieve ARs that contain one or
more of the search terms, ntclientd or notifier or ntserverd. Remember that an
FTS also returns weight information that is a function of the number of
occurrences found.

You can also use the % wildcard for an FTS with the accrue operator, according
to the following syntax:

<field> LIKE "ntcli%, notifier, ntserv%"

You can include FTS and non-FTS fields in a query, as in the following:
<field> LIKE " ntclientd, notifier, ntserverd"  AND ‘Create-date’ >

"01/01/95"

This query would retrieve all ARs that contained any of the search terms
ntclientd or notifier or ntserverd and that were created after January 1, 1995.
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Note – Remember that some queries work better than others. If you receive
unexpected results or an RPC time-out, try reformulating your query.

For more information, see Efficient Full Text Searching on page -102.

Query-by-Example Method

Enter a QBE in any field indexed for FTS, according to the following syntax:
ntclientd, notifier, ntserverd

Be aware that if the QBE Match property is set to Equal in the Field Properties
window, you must do one of the following to use the accrue operator:

• Add a wildcard to the value, for example, ntclientd%, notifier%, ntserverd%.

• Use the Query bar to enter the accrue operator.

Limits in Doing an FTS

There are certain limits in doing an FTS, including the following:

• You cannot do an FTS search on periods, exclamation marks, question marks,
or double quotes.

• Your search phrase cannot use words from the Ignore Words List. For
example, if the word the  is in the Ignore Words List, searching on the
phrase the database  in the Short-Description field would not return any
records. For more information, see Ignore Words List on page -102.

• If searching for punctuation like commas or dashes, you must use double-
quotes to include them in the search string. For example, if you are
searching for the phrase “database, remedy”  from the Short-Description
field, you would enter the following in the Query bar:

‘Short-Description’ LIKE "%" "database, remedy" "%"

Using Query By Example, you would enter the following:

"database, remedy"

An FTS treats any phrase in double quotes, including commas or dashes, as
a literal string and retrieves them accordingly.
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• In queries that use FTS, be aware that newly submitted or modified ARs
might not appear immediately in the query list. There are sometimes brief
delays from the time the AR is submitted or modified to the time that the
AR is available to access.

Ignore Words List

The AR System administrator can tell the FTS engine to ignore frequently-used
words (such as and , the , because , and so on) or words that you do not want
indexed. Adding entries to the Ignore Words List saves space in the index
directory as well as speeds up full text searches. The FTS option comes with a
default set of ignore words that you can modify as needed.

Be aware that searching for phrases that contain words from the Ignore Words
List will not find any matching entries. For restrictions on full text search, refer
to the Action Request System Administrator’s Guide.

Before Importing Data

Because sizeable performance impacts can occur if you are importing a lot of
data into a schema with Full Text Search (FTS) fields, the AR System
administrator should shut down FTS from the AR Admin Tool before you
import the data. Refer to the Action Request System Administrator’s Guide for
instructions.

Efficient Full Text Searching

When searches involve a combination of Full Text and fields not Full Text
indexed, it is most efficient to group the search clauses on Full Text indexed
fields together using parenthesis.

For example, the query:
('Status' = "New" AND 'Short Description' LIKE
"network%") AND 'Long Description' LIKE "network%"

would be more efficient if arranged as follows:
'Status' = "New" AND ('Short Description' LIKE
"network%" AND 'Long Description' LIKE "network%")

For more information, see Query Bar Method on page -100.
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Setting Query Window Preferences
You can control several aspects of how the Query window looks and acts by
selecting Preferences from the File menu. Using the Query preferences, you can
specify how many active schemas you want displayed in the active schema list
at the bottom of the File menu, the maximum number of items you want
displayed in a query operation, how you want the window to behave before a
new query, control whether or not the query bar is visible, and specify whether
a Display, Modify Individual or Report window is opened after double-
clicking on a query list item. For more information on how to set Query
window preferences, see “Setting User Preferences” on page 27 in Chapter 2.
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In addition to the query operations described in the previous chapter, you can
also generate reports and statistics based on the ARs that match your search
criteria. This chapter describes how to define the format for a report you want
to generate and how to send the report to the screen, to a printer, or to a file. It
also describes how to define a set of statistics you are interested in and
generate a report of those results.

This chapter includes information about the following topics:

• Setting the page style.

• Setting report layout.

• Specifying the sorting and grouping of fields.

• Generating statistics.

• Saving, using, and modifying custom reports.

Generating Reports
For any query that returns at least one entry, you can generate a report by
selecting Report from the Query menu (or typing Ctrl+R) .

A Report window appears containing a list of all of the fields in the current
schema as well as any existing custom report names, as shown in Figure 5-1.
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Figure 5-1 Report Window

The Report window lets you create a new custom report, modify an existing
custom report, specify the layout of your report, and specify the type of output
you want. You can choose an existing custom report or experiment with a new
report until you are satisfied with it. Once you are happy with your report, you
can save the format as a custom report or create your output and send it to the
screen, a file, or a printer.

Note – If you want to create a report with a more sophisticated format, you can
export the report to a file and import the resulting file into a desktop
publishing application. See “Formatting a Report to use in Another Application” on
page 110.

Report Prototype
containing all fields
in the current
schema.

List of Custom
Reports.

Sash
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resize
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upper
and
lower
windows
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To generate a report:
1. After defining the query criteria or selecting ARs from the Query List,

select Report from the Query menu (or type Ctrl+R) .
The Report window appears (Figure 5-1).

2. To use a previously saved custom report, select the report name from the
Custom Report Name list. See “Using Custom Reports” on page 123 for
more information.

3. To create a new report, select <<<New Report>>>  from the Custom Report
Name list and then select Field Selection from the Define menu (or type
Ctrl+F ) to specify the fields to be included as described in “Designing
Reports” on page 106.

4. To change the default settings for the page layout of a report, as well as to
specify page breaks, column title separators, and column and record
separators, select Report Preferences from the Define menu (or type
Ctrl+P ) and see “Defining Report Preferences” on page 112.

5. To specify how to sort and group the fields in your report, select Report
Sort Options from the Define menu (or type Ctrl+A ) and see “Sorting and
Grouping Records in a Report” on page 115.

6. To generate statistical information about the ARs that match the query
criteria, select Statistics Options from the Define menu (or type Ctrl+T ).
See “Generating Statistics” on page 119.

7. When you have completed defining the report, you can send the report
output to the screen, to a file, or to a printer. See “Generating Report
Output” on page 129 for details.

Designing Reports
Each time you generate a new report you can select the fields that you want to
include in the report and choose whether to display the information about the
fields you select as a list of records, in columns, in a compressed text format, in
comma separated format, or in an AR export format. You can also determine
what each page of your report will look like by specifying fields to sort and
group by, generating statistics on the fields in your report, defining margins,
heading, footers, and other page layout specifications and output options. You
design reports using the Report Selected Fields window, shown in Figure 5-2.
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Figure 5-2 Report Selected Fields Window

Selecting Fields

The Report Selected Fields window shows a list of the fields from the current
schema in the upper half of the window. As you select the fields that you want
to include in the report you are designing, the selected fields appear in the
Selected Fields list in the lower half of the window. As you select and add
fields to be included in the report, you can also specify an alternate label to be
used for the field or an alternate output width for the field.

To select fields for a report:
1. In the Report window, select Field Selection from the Define menu (or

type Ctrl+F ). The Report Selected Fields window appears (Figure 5-2).

2. Select the fields you want to include in the report from the list of fields in
the upper half of the window. The fields appear in the Selected Fields list
in the lower half of the window.
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• To select all of the fields in the schema, select Select All. All of the fields in
the upper half of the window appear in the Selected Fields list in the
lower half of the window. If some fields were already selected and in the
lower half of the window, they only appear once.

• To change the field order, use the up and down arrows to move the
selected field within the list. Double-clicking the up or down arrow moves
the selected field to the top or bottom of the list.

3. To modify the field Report Label or the width of the field to be used in the
report, first select the field in the Selected Fields list. Then, modify the
Report Label and Width fields to the right of the Modify button. The
width value is only needed in a columnar report. If you want a blank
label, delete the current label. Select the Modify button. The new Report
Label and Width are displayed in the Selected Fields list.

4. To delete fields from the Selected Fields list, select the field in the
Selected Fields list and then select the Delete button.

5. When you have finished setting up the report format, select the Apply
button.

6. To remove the Report Selected Fields Window, select the Dismiss button.
The Report window appears with a prototype of your report format so far.
To specify sorting and grouping of the selected fields, see “Sorting and
Grouping Records in a Report” on page 115.

Specifying the Report Layout

You can format a report as a list of records, in columns by field name, in a
compressed text format, as a comma separated file formatted for use in a
desktop publishing application, or in AR export format. You determine which
format is used by selecting the Record, Column, Compressed Text, CSV, or AR
Export radio button in the Layout field on the Report window.

Formatting a Report by Records

The Record format lists the fields for each AR (record), using a blank line, a
record separator character, or a page break to separate each AR or each group
of ARs, as specified on the Report Preferences window. You can select the
fields that you want to include in the report. Records appear as a list of field
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labels followed by the field contents for that AR, as shown in the example in
Figure 5-3. If the field contents are longer than the specified Chars per line
report preference, the field contents wrap to another line.

Figure 5-3 Report Formatted by Record

Formatting a Report in Columns

The Column format displays the field labels as column headings and displays
information for each AR in a separate row, as shown in the example in
Figure 5-4. You can select the fields that you want to include in the report. If
you specify Wrap for the Long field format preference on the Report
Preferences window, any information that does not fit on a single line is
continued on the next line within the same column. Therefore, a “row” may
consist of more than one line of actual output. If you specify Truncate for the
Long field format preference and the information in a field does not fit in the
column width you defined for the report, the information is truncated.
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Figure 5-4 Report Formatted in Columns

Formatting a Report to use in Another Application

If you want to create a report with a more sophisticated format, you can export
the report to a file and import the resulting file into another application, such
as a desktop publishing or spreadsheet application. All report output files are
in plain ASCII format and are suitable for loading or importing into another
application. Many desktop publishing applications accept comma separated
files as input. You can save your custom report in either a compressed format
or in a comma separated file by selecting either Compressed Text or CSV in the
Layout field on the Report window. Figure 5-5 illustrates a comma separated
report. Once you select Compressed Text or CSV, the report prototype appears
in the appropriate format in the Report window.
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Figure 5-5 Report Formatted in Comma Separated Format

Formatting a Report in Order to Export ARs

If you want to create a report in order to export ARs, select AR Export in the
Layout field. This exports the records that match the query criteria. The records
are in an archive format that is compatible with the arimport  program. For
more information about the arimport program, see the Action Request System
Administrator’s Guide.

To specify the report layout:
1. In the Report window, select the Record, Column, Compressed Text, CSV,

or AR Export radio button in the Layout field at the bottom of the screen.

2. A prototype of your report format appears in the Report window, as
shown in Figure 5-6. If you want to see more of the prototype in the
bottom panel of the window, place the pointer on the sash (the small
square that is between the upper and lower vertical scroll bars). Then,
drag the box up to enlarge the lower panel containing the prototype.
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Figure 5-6 Report Window with Prototype of Formatted Report

You are now ready to define your report preferences.

3. To define report preferences such as the report title, lines per page, and
the column or record separator, refer to the section that follows, Defining
Report Preferences.

Defining Report Preferences

You can define your report preferences independently for each report you
generate. Report preferences are basic page layout controls, such as the title for
the report, margin specifications, and page length and width as well as column
and report separators, page breaks, and a column title separator.

Sash
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To define report preferences:
1. In the Report window, select Report Preferences from the Define menu (or

type Ctrl+P ). The Report Preferences window appears, as shown in
Figure 5-7.

Figure 5-7 Report Preferences Window

2. Specify the report preferences that you want for your report.
The Report Preferences window allows you to specify report preferences for
column-oriented reports only, with the following exceptions:

• Long field format (column only).
• Column title separator (column only).
• Column separator (column and compressed text only).
• Record separator (column and record).
• Column titles per (CSV, compressed text, and column).
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Note – When defining the header, footer, and title, you can use the keywords
mentioned in “Using Keywords” on page 51 in Chapter 3, with the exception
of $DEFAULT$ and $NULL$. In addition, a special reporting keyword, $PAGE$, is
available so that you can include a page number.

Title The report title that appears only on the first page of your report
(centered). The maximum is 1024 characters.

Header The information that appears at the top of each page in your report.
The header may be a maximum of 1024 characters and is left justified
on the page.

Footer The information that appears at the bottom of each page in your
report. The footer may be a maximum of 1024 characters and is left
justified on the page.

Lines per Page The number of lines for each page. This setting determines the
location of the header and footer on the page.

Char per Line The line length (specified in character units).
Top Margin The number of blank lines at the top of each page of your report

(including the header and title, if any).
Bottom Margin The number of blank lines at the bottom of each page of your report

(including any footers).
Left Margin The left text margin (the number of blank character units from the

left edge of the page).
Right
Margin

The right text margin (the number of blank character units from the
right edge of the page).

Page break per This setting specifies whether or not to force a page break (include a
form feed character) after each AR, after groups (Group1, Group2,
Group3, Group4, or Group5), after each Page as defined by the Lines
per Page preference, or none at all (None). None is the default value.

Long field format This setting specifies whether or not long fields are wrapped to the
next line within the same column. Specifying Wrap causes long fields
to wrap to the next line within the same column, while Truncate cuts
off long field contents once it fills up the specified width of the field
as specified on the Report Selected Fields window. This setting only
works in column-formatted reports.

Column title
separator

The character that is used for this report as the separator between the
column title and the rest of the report. This setting only works in
column-formatted reports. The default value is a - (hyphen).

Column
separator

The character that is used for this report as the separator between
columns in a column- or compressed-formatted report. The default
value is a space. Besides any alphanumeric character, you can use
any of the following special characters:
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3. When you have finished specifying report preferences, select the Apply
button. (Selecting the Dismiss button closes the window without saving
any changes.)

Sorting and Grouping Records in a Report

By default, the ARs in a report are sorted using the sorting order defined by
Sort Options from the Actions menu on the Query window. You can change the
sorting order or specify grouping by using the Report Sort Options from the
Define menu of the Report window. This is useful if you want to create a
custom report that sorts fields a certain way or if you want to visually separate
each group or perform statistical calculations on each group.

You can sort on up to five fields in your reports with each field ordered either
in ascending or descending order.

You can also group by the same five fields that you can sort on. Grouping lets
you visually separate each group and lets you perform statistical calculations
on each group. This creates a more readable and therefore more usable report.
If you want to group by any of the subordinate fields, all of the superior fields
are also grouped (Group1 is the most superior field while Group5 is the most
subordinate field).

\b Backspace
\n Return
\t Tab
\\ Backslash
\< nnn> ASCII Character <nnn> (this number is decimal,
not octal)

Record
separator

The character that is used for this report as the separator between
records (ARs) in a record- and column-formatted report. The default
value is a blank line. In a column-oriented report, this value is used
to separate records which may occupy multiple lines in a wrapped
report. Specify “\n” as a separator to cause double spacing between
records.

Column titles per This setting specifies whether to provide a column title at the
beginning of each page (Page), each AR, each Group (Group1,
Group2, Group3, Group4 or Group5), or not at all (None). If you
choose None, your prototype report in the Report window appears
blank. This setting works in Column, CSV, and Compressed Text
entry.
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Using the Page break per Report Preferences option, you can create a report
that places all ARs with the same field value specified by Group1, Group2,
Group3, Group4 or Group5 on the same or separate page.

Using the Column titles per Report Preferences option, you can create a
column-formatted report that prints column titles above each group, each AR,
or at the top of each page. The column titles are the field labels of the fields
you selected to include in your report. For more information about report
preferences, see “Defining Report Preferences” on page 112.

Along with being able to print different groups on different pages, you can
perform statistical calculations on the ARs within each group. You can perform
any of the five statistical operations on any of the five groups and you can
specify that the statistical results be printed on one line, on more than one line,
or under the appropriate column in the report. For more information about
calculating statistics, see “Generating Statistics” on page 119.

A good example of where grouping and performing statistical calculations
would be very useful is if you needed to check on the overall status of a
particular product. You could group first by the product (SW Version field),
then by the priority (Assigned-Priority field), and finally on the status (Ticket
Status field), and then you could print the total number of ARs in each
specified Status setting. You can do all of this by specifying the SW Version
field as the first field to sort on and then to be Group1, then sort on the
Assigned-Priority field and select it to be Group2, and finally sort on the Ticket
Status field and select it to be Group3. You can then specify that the statistical
Count operation be performed for each Status setting and that those results be
printed after the third group (Group3 being the Ticket Status field) in the
report. You can also specify that all ARs with the same Ticket Status setting be
printed on a separate page.
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Figure 5-8 illustrates this type of report. It places ARs with the same status
value on separate pages and prints the total number of ARs that have the same
status value at the bottom of the page.

Figure 5-8 Grouping Query Results in a Report

The sorting and grouping options specified by the Report Sort Options
window are stored as part of the custom report which guarantees that the
custom report will be sorted the same way each time it is used regardless of
what the query sorting order is set to at the time the report is created. For more
information on specifying the query sort order see Chapter 4.

To specify report sorting and grouping order:
1. Select Report Sort Options from the Define menu (or type Ctrl+A ) to

display the Report Field Sort Order window, as shown in Figure 5-9.
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Figure 5-9 Report Field Sort Order Window

2. Select the menu pop-up symbol to the right of the Field Name field.
All of the fields on the current schema that you can sort on are displayed.

3. Select the field you want to sort on.

4. Select either the Ascending or Descending Sort Order radio button next to
the Field Name field you just edited.

5. If you want to group by this field, select the box under Group By (Group1,
Group2, Group3, Group4, or Group5) next to the Field Name field you just
edited.

6. Continue specifying up to five fields.

7. Once you are finished, select the Apply button.

8. Select the Dismiss button to remove the Report Field Sort Order window
and return to the Report window.
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Generating Statistics

For any query that returns at least one entry, you can generate a statistical
summary by selecting Statistics Options from the Define menu, as shown in
Figure 5-10.

Figure 5-10 Statistics Options Command

There are five statistical operations you can perform:
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Count Tallies the number of ARs that were selected by the query criteria.

Sum Sums specified fields or the arithmetic relationship between fields.

Average Averages specified fields or an arithmetic relationship between fields.

Minimum Provides the minimum value for a specified field or an arithmetic relationship
between fields.

Maximum Provides the maximum value for a specified field or an arithmetic relationship
between fields.

If you do specify a field and you specify Column for the report layout, the
statistical count result is displayed under the corresponding column. For all
other statistical operations, if the field is an expression with at least one
variable and you specify Column for the report layout, the statistical results are
displayed under the first field in the expression.

The other four operations can only be applied to numeric and date and time
fields. The arithmetic operators (+, - , * , / , and %) are used the same way as in
the query bar (see “Using Operators in the Query Bar” on page 72 in
Chapter 4).

Specifying Statistics

You define statistics one at a time using the procedures that follow.

To specify statistics:
1. From the Report window, select Statistics Options from the Define menu

(or type Ctrl+T ).
The Statistics window appears, as shown in Figure 5-11.
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Figure 5-11 Specifying Statistics

2. Select an Operation (Count, Sum, Average, Minimum, Maximum).

3. Select the fields you want as part of the statistic by selecting the pop-up
symbol to the right of the field and selecting the field. The selected field
appears in the Field field. Enter arithmetic operators, if appropriate,
between fields.
For example if you are finding the average time it took for an AR to go from
the New to Fixed status, you would specify:

'Status-History.Fixed.TIME' - 'Status-History.New.TIME'

Select the
operator.

Select the fields you
want from the Fields
menu.

Type a label
for the
statistic.

Select to
specify what to
compute the
statistics on.

Type
arithmetic
operators,
if needed.

Select Add
to add the
new
statistic to
the list.

Select to specify how
to display the
statistical results.
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4. In the Label field, type the label for this statistic.
For example:

Average Time to Fix =

Labels can be a maximum of 128 characters and can include any characters
(including blanks). Include blank spaces after the label to provide space
between the label text and the statistic in the actual display or printout. You
cannot use tabs since they take you to the next field. But you can include a
tab in the label by using the special tab character. You can use any of the
following special characters in the Label field:

You can specify the value of a field by specifying the field name within
dollar signs ($fieldname$ ). This is especially good to show field values
when you have grouped by a field and are reporting statistics per group.

5. You can specify that the statistics be computed for the entire report, or for
any one of the five possible groups. Select the appropriate radio button in
the Compute on field.

6. Select Single Line in the Layout field to display the statistical results on
one line. Select Multiple Lines to display each statistical results on its
own line. Select Column to display the statistical results at the bottom of
the column of the field specified by the Field field. Column is only valid
for a column-formatted report.

7. Select the Add button to add the statistic to the list of statistics you are
specifying.
The definition for the statistic is added to the window in the top half of the
screen.

8. To delete a statistic you have specified, select the statistic in the list in the
window and select the Delete button.

9. When you have finished specifying the statistics you want, select the
Apply button.

\b
\n
\t
\\
\< nnn>

Backspace
Return
Tab
Backslash
ASCII character < nnn>
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10. Select the Dismiss button to remove the Statistics window.

Note – Only fields with values are included in the statistical results. If some
ARs do not have a value for a field specified in a statistic, a message warns you
that one or more fields contain a NULL value. It means that the statistic result
you receive is computed only for entries that had valid data for the fields in
your statistic request.

Exporting Statistics

If you are preparing to export a report to a spreadsheet or desktop publishing
application, you should choose labels and line spacing appropriately. Commas,
tabs, and spaces are commonly used field delimiters for data to be imported
into a spreadsheet.

Using Custom Reports
Custom reports are reports that you design for a specific purpose and save so
that you can generate a report in that custom format at any time you desire.
You can create a new custom report any time you define a new report or after
you modify an existing custom report. Once you create a custom report, you
can use it any time you are in the Report window.

You create a custom report simply by defining a report as you normally would,
and then selecting Save Custom from the Edit menu on the Report window.
The Save Custom Report Format window appears, allowing you to save your
report. The new report is added to the Custom Report Name list in the Report
window. You can then select and run the custom report at any time.

You can allow other users to access your custom reports by either letting them
copy your custom report files or by saving your custom reports in any
directory specified by your ARPATH environment variable that other users have
access to. For more information about sharing custom reports and the ARPATH

environment variable, see the section entitled “Sharing Macros, User
Commands and Custom Reports” on page 34 in Chapter 2.
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Saving a Custom Report

At any time during the process of defining a report, even after viewing the
report output, you can save a report as a custom report.

To save a custom report:
1. In the Report window, select Save Custom from the Edit menu (or type

Ctrl+S ). The Save Custom Report Format window appears, as shown in
Figure 5-12.

Figure 5-12 Save Custom Report Format Window

2. Enter the report name in the Report Name field.
If you use the name of an existing report, you receive a prompt asking if you
want to overwrite the existing file.If you say yes, the existing report will be
overwritten when you apply. If you say no, the custom report is not saved
and you must supply a different report name.

3. Display the Directory menu by selecting the pop-up symbol to the right
of the field. Select the appropriate directory where you want to save your
custom report.
All of the directory path names defined by your ARPATH environment
variable are listed on the Directory menu.
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4. Enter information that describes the report in the Help Text field.
Help text is useful for telling other users what the custom report does, as
well as reminding yourself what it does.

5. Select the Apply button to save the new custom report format. (Selecting
the Dismiss button removes the Save Custom Report Format window
without saving the custom report format.)
The report appears with other custom reports in the Report window, as
shown in Figure 5-13.

Figure 5-13 Report Window

Note – The saved custom report includes the fields to be included in the report,
their order, labels, and size information, and any report preferences, sorting
options, grouping options and statistics that you have defined.
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Using a Custom Report

You can use a custom report any time you are displaying the Report window.

To use a custom report:
1. Select the custom report from the Custom Report Name list by clicking on

the report name.

2. The custom report is loaded into the Report window with the report
prototype visible. If you want to see more of the prototype in the bottom
panel of the window, place the pointer on the small square that is
between the upper and lower vertical scroll bars. Then, drag the box up to
enlarge the lower panel containing the prototype.
The custom report format is applied to the set of ARs selected by your query
criteria. Any open Report windows such as the Report Selected Fields,
Report Preferences, Report Field Sort Order, and Statistics windows are
updated to reflect the values contained in the custom report.

3. Select an output option. (See “Generating Report Output” on page 129.)

Modifying a Custom Report

You can modify a custom report’s name, directory, help text, report
preferences, and sorting and grouping options at any time. Simply select the
report you want to start with and then make any changes you desire.

To modify a custom report:
1. Select the custom report from the Custom Report Name list by clicking on

the report name.

2. The custom report is loaded into the Report window, with the report
prototype visible. If you want to see more of the prototype in the bottom
panel of the window, place the pointer on the small square that is
between the upper and lower vertical scroll bars. Then, drag the box up to
enlarge the lower panel containing the prototype.
The custom report format is applied to the set of ARs selected by your query
criteria.

3. Modify any aspects of the report as you would when first specifying a
report.
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4. Select Save Custom from the Edit menu (or type Ctrl+S ) to display the
Save Custom Report Format window.

5. Enter a report name in the Report Name field for this new custom report.
You can enter an existing report’s name, if you are modifying it.

6. Display the Directory menu by selecting the pop-up symbol to the right
of the field. Select the appropriate directory where you want to save your
custom report.
All of the directory path names defined by your ARPATH environment
variable are listed on the Directory menu.

7. Enter information that describes the report in the Help Text field.
Help text is useful for telling other users what the custom report does, as
well as reminding yourself what it does. Five lines of text are displayed by
default.

8. Select the Apply button to save the new custom report format. (Selecting
the Dismiss button removes the Save Custom Report Format window
without saving the custom report format.)
If you use the name of an existing report, you receive a prompt asking if you
want to overwrite the existing file. If you say no, the custom report is not
saved and you must supply a different report name.

A new report with the changes you just made is added to the Custom
Report Name list on the Report window.

To modify a report’s name or help text:
1. Select Manage Custom Report from the Edit menu on the Report window

(or type Ctrl+M ). The Manage Custom Reports window appears, as shown
in Figure 5-14.
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Figure 5-14 Edit Custom Report Formats Window

2. Display the Directory to search menu by selecting the pop-up symbol to
the right of the field.
The Directory to search menu contains all directories defined by your
ARPATH environment variable, your <ar_config_dir>/arcmds  directory, and the
word All . If you select a directory from the menu, only those custom
reports stored in that directory appear in the Custom Reports list. If you
select All,  all custom reports contained in all directories available to you
appear in the Custom Reports list.

3. Select the report in the Custom Reports list whose name or help text you
want to modify. The current name and help text appears in the New Name
and Help Text fields.

4. Modify the name and help text as appropriate and select the Modify
button.
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5. When you have finished, select the Dismiss button to close the Manage
Custom Reports window. The new report name appears in the Custom
Report Name list on the Report window.

Deleting a Custom Report

You can delete a custom report any time you are displaying the Report
window.

To delete a custom report:
1. Select Manage Custom Report from the Edit menu (or type Ctrl+M ) to

display the Manage Custom Reports window as previously described.

2. Display the Directory to search menu by selecting the pop-up symbol to
the right of the field. Select the directory containing the custom report or
select All .

3. Select the report you want to delete from the Custom Reports list and
select the Delete button to delete the custom report. You will be asked to
confirm your action (Motif only). The report is no longer listed in the
Custom Report Name list on the Report window.

Generating Report Output
You can send reports to the screen, to a file or to a printer. When you send a
report to the screen, a report appears in a scrollable window, as shown in
Figure 5-15. When you send reports to a file, you can create a new file or you
can choose to append to or overwrite an existing file.
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Figure 5-15 Report to Screen Window

To display a report to the screen:
1. Select Report to Screen on the Report window.

The report appears in a Report to Screen window (Figure 5-15).

2. Select the Dismiss button to close the Report to Screen window.

To send the report to a file:
1. Select Report to File on the Report window.

The Report to File window appears, as shown in Figure 5-16.
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Figure 5-16 Report to File Window

2. Specify the directory and file name for the report file in the Selection
field.

3. You can use the Filter button and the Directories window to select the
directory path name where you want to put the report file.
To specify your default directory (<arHome_dir>/arcmds), select
<arHome_dir>/arcmds/. in the Directories window and then select the Filter
button (or double-click on <arHome_dir>/arcmds/.).

The Files window displays all files found under your
<arHome_dir>/arcmds directory and the selection window is filled in with the
pathname of your default directory.

4. To move around your UNIX directory tree structure, select
<arHome_dir>/arcmds/.. in the Directories window and then select the Filter
button (or double-click on <arHome_dir>/arcmds/..).
The Files window displays all directories and files found under your
<arHome_dir> directory and the selection window is filled in with the
pathname of <arHome_dir>.

5. To specify a new file name, enter the file name in the Selection field after
the directory path name and then select the Apply button.
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6. To overwrite or append to an existing file, select the file name in the Files
window and then select the Apply button. You can also double-click on
the filename in the Files window.
A warning message is displayed telling you that the specified file already
exists. To overwrite the existing file, select the Overwrite button. To append
to the existing file, select the Append button. To not save this custom report
with the existing file name, select the Cancel button.

7. To remove the Report to File window without saving your report in a file,
select the Dismiss button.

To print a report:
1. Select Report to Printer on the Report window.

The Report Print window appears, as shown in Figure 5-17.

Figure 5-17 Report Print Window

2. Select the printer from the Printer list.

3. Specify the number of copies you want printed.
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4. If you want to run the report through a print filter before it is printed,
enter the filter name and appropriate path information.
See Print filters below for more information on filtering the print job.

Select the Print button to send your report to the printer. (Selecting the
Dismiss button closes the Report Print window without sending anything to
the printer.)

Print filters

You invoke the print filter with the file name you want filtered as its argument.
For example, if the filter is fold -70, then the command line you would pass to
the shell to execute would be:

fold -70 <temp-filename> | lpr -d <num-copies>

The User Tool will supply <temp-filename> and <num-copies>.

The print filter can only be one command, not a sequence of commands
separated by the pipe (|) symbol. If you want to use a more complex print
filter, write a small script that includes the sequence of commands, and have
the script take a filename argument.

For example, if the filter you want is cat | fold -70 , then you could write a
script like this:

#!/bin/sh
cat $* | fold -70

If you named this script myfilter , then you would just type myfilter  as the
print filter.
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Using Macros 6

A macro is a set of operations recorded for later execution. A macro can
include any operation that the User Tool can perform: querying the database
(with an optional sorting order), submitting ARs, modifying ARs, changing
user defaults, or even setting user defaults, running macros, running user
commands, creating a report, changing schemas, and specifying preferences.
You may want to create macros to automate frequently used or complex query
or submit operations.

You can execute a macro by selecting Run Macro from the Macros menu and
then selecting the macro from the Select Macro window or by entering it as a
command line parameter when you start the User Tool.

This chapter provides information about the following:

• Recording macros.

• Executing macros.

• Changing a macro’s name and help text.

• Deleting macros.

• Sharing macros with other users.

Recording Macros
When you create a macro, you assign it a name and enter a description of its
function. The next time you select Run Macro from the Macros menu, the new
macro is listed along with any other macros you have created.
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Before recording a macro, it is a good idea to try the operation you intend to
record to make sure it produces the results you expect.

You can create a macro that leaves the contents in a Query window when the
macro ends. You might want to create a macro that does this if you find that
you perform many queries with much of the same criteria. By running a macro
that displays the query contents, you are left with the Query window filled in
with the common criteria waiting for you to add any additional criteria specific
to your current query task.

You can also create a macro that leaves a Submit window open containing
some field values. This is useful if you submit many ARs with some similar
information. By running a macro that leaves a Submit window open that
contains some field values, when the macro ends you are left with the Submit
window filled in with common field information waiting for you to add any
additional information specific to your current submit task.

This type of macro is very useful as part of an active link. It is also useful
because it allows you to select Dismiss on the Submit window, therefore,
cancelling the submit operation. For instance, suppose your AR System
administrator created an active link on your Customer Support Call Tracking
schema that copies the field contents of the customer call AR to a Submit
window containing the Bug Tracking schema. This is very useful if your
customer support call results in the submission of a software bug. For more
information about creating active links, see the Action Request System
Administrator’s Guide.

Note – When you record a macro that submits an AR, you receive a warning
message informing you that the macro recording is active and that the
operation was recorded but that no database operation was performed (no AR
was submitted).

You can allow other users to access your macros by either letting them copy
your macro files or by saving your macros in any directory specified by your
ARPATH environment variable that other users have access to. For more
information about sharing macros and the ARPATH environment variable, see
the section entitled “Sharing Macros, User Commands and Custom Reports”
on page 34 in Chapter 2.
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Note – You can create a macro that executes other macros. While recording,
simply select the macro you want to execute by selecting Run Macro from the
Macros menu. In this way, you can create powerful macros that can perform a
series of complex tasks.

While the following sections take you through the steps to record a macro that
performs a query operation, you can create a macro to do any task that you can
do using the User Tool.

To record a macro that performs a query:
1. Select Start Recording from the Macros menu.

RECORDING appears in the status area at the bottom of the Query window,
as shown in Figure 6-1.

Figure 6-1 Recording in Progress

2. Display the appropriate schema in the Query window.
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3. With the appropriate schema displayed, select Clear All from the Edit
menu (or type Ctrl+E) to clear the schema’s fields.

4. Specify the search criteria you want as you would for any query
operation.

5. Select the operation(s) to be performed.

6. Select Stop Recording from the Macros menu to stop the recording
process.
A Stop Recording window appears, as shown in Figure 6-2.

Figure 6-2 Stop Recording Window

If you want to continue recording, select the Dismiss button.

If you want to cancel the recording operation, select the Cancel Recording
button.

7. Enter a name for the macro in the Macro Name field.
You might want to use a name that helps you to remember what the macro
does.
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8. Display the Directory menu by selecting the pop-up symbol to the right
of the field and select the appropriate directory where you want to save
your macro.
All of the directory pathnames defined by your ARPATH environment
variable as well as your <ar_config_dir>/arcmds directory are listed on the
Directory pull-right menu.

9. Enter a description of the macro in the Help Text field.
Help text is useful for telling other users what the macro does, as well as
reminding yourself what it does. This text is displayed when the macro is
selected to play back or in the Execute macro window, the help text of the
currently selected macro is displayed.

10. Select Yes for the Record final Query window contents option to store the
final contents of the Query window as part of the macro.
Then after the macro is executed, the Query window will contain the values
specified by the macro.

If No is selected, after the macro is executed, the Query window will contain
the last query ran.

11. Select Yes for the Record open Submit windows to store any Submit
windows left open when the macro ended.
This allows you an additional way to record submissions. The macro records
any open Submit windows opened after the start of the macro along with
their contents. After the macro is run, the Submit window is left open and
you can finish supplying information before submitting the AR.

12. Select the Store Macro button to save the macro.
The name of the new macro now appears in the Select Macro window when
you select Run Macro from the Macros menu.

Note – The macro remembers the size and position of any window it displays
during playback. Take advantage of this feature by sizing and positioning the
final result windows before dismissing them or before stopping the recording
(whichever occurs first).
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Recording Macros with Variables

You can record a more generic macro that lets you change some of the values
each time you execute the macro. These are macros which provide user-
specified variables to be entered during the macro’s execution.

For example, suppose you want to create a macro that displays “Assigned”
ARs that have a “Critical” priority, but you want to specify the “Submitter”
each time you run the macro. To create this macro with variables, you record
the query operations as usual, but for variable information you type the
prompt text enclosed by dollar signs. In this example, to allow yourself to
specify the Submitter when you run the macro, you enter the prompt text $User
Name$ in the Submitter field instead of entering a specific name.

Note – You cannot use dollar signs as part of your variable.

As you continue recording the query, you are prompted to enter an example
value for this variable. Note that the values you enter are used in the recording
session, but are not retained as part of the macro.

Note – You cannot use the query-by-example section of the screen to specify
variable values for selection fields. You must use the query bar for this task.

Figure 6-3 on page -140 shows a Query window with a variable specified in the
Submitter field.
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Figure 6-3 Specifying a Variable

To record a macro with variables:
1. Select Start Recording from the Macros menu.

RECORDING appears in the status area at the bottom of the Query window.

2. Select the desired schema in the Query window.

3. Select Clear All from the Edit menu (or type Ctrl+E) to clear the schema’s
fields.

Variable in
Submitter field
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4. Specify the search criteria you want. For criteria that have variable
information, enter the prompt text that the user sees when the macro
executes enclosed by dollar signs ($). For example, if the Submitter field
value will vary, you could enter
$User Name$

as the prompt text in the Submitter field, as shown in Figure 6-3 on page -
140.

5. Select the operation(s) to be performed from the Query menu.
The Macro Parameters window appears, prompting you to enter example
value(s) for any variables you have designated, as shown in Figure 6-4.

Figure 6-4 Prompt to Enter Example Value

6. Enter an example for each of the prompted variables.
The examples you enter are not stored with the macro. They only allow you
to continue with the recording session.

7. To stop the recording process, select the Stop Recording button from the
Macros menu. A Stop Recording window appears.
If you want to continue recording, select the Dismiss button.

If you want to cancel the recording operation, select the Cancel Recording
button.
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8. Enter a name for the macro in the Macro Name field and a description of
its function in the Help Text field.
Help text is useful for telling other users what the macro does, as well as
reminding yourself what it does.

9. Display the Directory menu by selecting the pop-up symbol to the right
of the field. Select the directory where you want to save your macro.
All of the directory path names defined by your ARPATH environment
variable are listed on the Directory menu.

10. Select Yes for the Record final Query window contents option to store the
final contents of the Query window when the macro ended as part of the
macro.
Then after the macro is run, the Query window will contain the values
specified by the macro.

11. Select Yes for the Record open Submit windows to store any Submit
windows left open when the macro ended.
This allows you an additional way to record submissions. The macro records
any open Submit windows and their contents. After the macro is run, the
Submit window is left open containing information allowing you to finish
supplying information before submitting the AR or to cancel the
submission.

12. Then select the Store Macro button to save the macro.
The name of the new macro now appears in the Select Macro window when
you select Run Macro from the Macros menu.

Executing Macros
Follow these steps to execute a macro from the Query window.

To execute a macro:
1. Select Run Macro from the Macros menu (or type Ctrl+I). The Select Macro

window appears, as shown in Figure 6-5.
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Figure 6-5 Select Macro Window

2. Display the Directory to search menu by selecting the pop-up symbol to
the right of the field.
To display all of the macros in the Available Macros list that you have access
to, select All from the Directory to search menu. To display only the macros
contained in one directory, select that directory from the Directory to search
menu.

3. Select the macro that you want to run from the Available Macros list and
then select the Apply button or double-click on the macro name.
If the currently active window contains the schema required by the macro,
the macro operation occurs in the active window. Otherwise, the macro
changes the schema in the Query window.

4. If you execute a macro with variables, a window appears for you to enter
the values to be used for the current query, as shown in Figure 6-6. Enter
the values, then select the Apply button to continue executing the macro.
Selecting the Dismiss button cancels the macro.
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Figure 6-6 Entering Variables for a Macro

If you do not supply a value for a prompted variable, an empty string is
substituted in the macro. If the variable is in the query-by-example section of
the Query window, it simply means that no qualification for the corresponding
field is specified. If the variable is in the query bar, however, failure to specify
a value often leads to a syntax error or unexpected results due to bad
comparisons.

Changing the Macro Name or Description
Follow these steps to rename a macro or change its description. The name
identifies the macro in the Macro list. The help text can include additional
information about the macro operations.

Note – To change any of the operations performed by the macro, you must re-
record the macro.

To edit the name or description:
1. Select Edit Macros from the Macros menu. The Edit Macros window

appears, as shown in Figure 6-7.
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Figure 6-7 Edit Macros Window

2. Display the Directory to search menu by selecting the pop-up symbol to
the right of the field.
The Directory to search menu contains all directories defined by your
ARPATH environment variable, your <ar_config_dir>/arcmds directory, and
the word All. If you a directory from the menu, only those macros stored in
that directory appear in the Macros list. If you select All, all macros
contained in all directories available to you appear in the Macros list.

3. Select the macro you want to edit from the Macros list.

4. Edit the New Name and Help Text fields as needed.

5. Select the Modify button to save the changes.
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Deleting Macros
Deleting a macro permanently removes it from the Macros list in the Select
Macros and Edit Macros windows.

To delete a macro:
1. Select Edit Macros from the Macros menu.

The Edit Macros window appears (Figure 6-7).

2. Display the Directory to search menu by selecting the pop-up symbol to
the right of the field.
The Directory to search menu contains all directories defined by your
ARPATH environment variable, your <ar_config_dir>/arcmds directory, and
the word All. If you select a directory from the menu, only those macros
stored in that directory appear in the Macros list. If you select All, all macros
contained in all directories available to you appear in the Macros list.

3. Select the macro you want to delete.

4. Select the Delete button to delete the macro. UNIX only, will confirm
whether you want to delete.

Sharing Macros with Other Users
There are two ways that you can share macros. The first way is to copy the
macro files and place them in your <ar_config_dir>/arcmds directory. The
second way is to specify the directory that contains the files you want to access
in your AR Path desktop preference. For more information about sharing
macros, “Sharing Macros, User Commands and Custom Reports” on page 34.
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This chapter provides information about customizing your environment.
Customizing can include setting defaults for fields, adjusting the layout of
fields on your view of a schema (your view), or changing the display
properties of fields and creating system commands. You can customize your
environment only if your AR System administrator has given you customize
permission (placed you in a group that has customize privileges). However,
you do not need special permissions to define default values.

This chapter provides information about the following:

• Defining default field values.

• Personalizing views.

• Saving and restoring views.

• Exporting views.

• Creating user commands.

• Executing user and administrator commands.

Defining Default Field Values
You can assign default values to any field for which you have been given
access privileges by the AR System administrator. Your default values override
any defaults the AR System administrator may have defined when setting up
the schema. If your AR System administrator has specified a default value for
a field that you want to be clear (empty), you need to specify a default value of
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$NULL$ for your user default value. You can use the $NULL$ keyword in any
field except for a selection field (radio button or selection menu). Your defaults
are saved in a file named <ar_config_dir>/<schema_name>.ard  and can be
exchanged with other AR System users by copying the file.

These default values are automatically loaded when you select Set to Defaults
from the Edit menu (or type Ctrl-U ) on the Query window, select the Set To
Defaults button on the Submit window, or when the Preferences setting for the
Submit or Query window is set to display default values prior to a new
submission or query, respectively.

Note – When the default values are loaded into the Query or Submit window,
any AR System administrator default values are loaded as well as your own. If
you specified a default value for a field that your AR System administrator
also specified, your default value takes precedence.

To define default field values:
1. Select Customize Defaults from the Actions menu. The Customize User

Defaults window appears, as shown in Figure 7-1.

Figure 7-1 Customize User Defaults Window
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2. To clear all field values, select the Clear Values button.

3. Enter new default values or replace existing values.

Note – Fields that are normally hidden on your view are shown in gray text.
Even though these fields are not normally visible, they exist in the database
and you may want to assign a default value to them (if you have write access).
Any default values you assign to hidden fields are preserved and applied
when performing any operation where default values are used (selecting Set to
Defaults from the Edit menu on the Query window or the Set to Defaults
button from the Submit window).

4. To save these defaults, select the Apply button.

5. To dismiss the Customize User Defaults window, select the Dismiss
button.
If you try to dismiss the Customize User Defaults window without first
saving your changes, you are warned that you haven’t saved your changes.
If you want to continue dismissing the Customize User Defaults window,
select the Continue button. To cancel the dismiss operation and return to the
Customize User Defaults window to then save your changes, select the
Cancel Dismiss button.

Customizing Your Schema View
The AR System allows you to create your own custom view of each schema.
Your customizations can include changing the physical layout of your view
and changing various field properties, such as the field label, location, and
length. Your custom view characteristics are saved in a file named
<ar_config_dir>/<schema_name>.arv  and can be exchanged with other AR System
users by copying the file.

When you customize a view on the Customize User View window, the system
keeps a copy of the previous version of the view (the view that appeared when
the window was first opened) so that you can restore it if necessary. You can
also restore a view you have saved in a backup file. (See Restoring Views, later
in this chapter.) You should always save valuable views in a backup file.
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Note – Not all users have permission to customize their view of a schema. If
you do not have customize permission for a schema, the Customize View item
under the Actions menu is not available. You can use a view created by
another user by copying their view file into your arHome directory, but you
cannot create a new view yourself.

Changing the Layout

If you have customize permission, you can change the physical layout of your
view of a schema by dragging fields to reposition them within the schema, as
illustrated by Figure 7-2. You can drag the field past the bottom (or top) of the
visible window to move the field onto the next (or previous) page.

Note – You can reposition a field more precisely by specifying X and Y
coordinates. Or you can align fields to a grid line by turning on the Enable
Grid and Display Grid features in the View Preferences. For more information,
see the following section, Changing Field and Active Link Properties.
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Figure 7-2 Dragging a Field to a New Location

To change the location of fields on the schema:
1. Select Customize View from the Actions menu.

The Customize User View window appears.

2. You can do any of the following:
• Enable the grid feature by selecting View Properties from the View menu

and clicking on the Enable Grid and the Show Grid options in the Custom
View Properties dialog box. See “Customizing View Properties” on
page 152.

• Specify the grid alignment using the Alignment button. See “Selecting an
Alignment Method” on page 153.

• Reposition one field by clicking on the field and moving it to another area
on the schema.
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• Reposition all the fields on the schema at one time by selecting Select All
Fields from the Fields menu, clicking on one field, and moving it to
another area on the schema.

• Modify the display attributes for a selected field by selecting Field
Properties from the Fields menu and making changes in the Schema Item
Properties dialog box. See “Changing Field and Active Link Properties”
on page 154.

3. When you are ready to save your changes, select the Apply button.

Note – Once you select the Apply button, you can restore your old view by
selecting Previous View from the Reset View menu. But, once you select the
Dismiss button, you cannot restore your old view. You can always restore an
Administrator view. For more information see “Restoring Views” on page 156.

4. To remove the Customize User View window and return to the Query
window, select the Dismiss button.
Once you select the Apply button, the Query window immediately changes
to reflect the new view. The current view is saved in
<ar_config_dir>/<schema_name>.arv  while the previous view is saved in
<ar_config_dir>/<schema_name>.arv.bak.

Customizing View Properties

You can use the Custom View Properties dialog box shown in Figure 7-3 to
specify grid options in the Customize User View window.

Figure 7-3 Custom View Properties Dialog Box
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To set custom view properties
1. Select View Properties from the View menu in the Customize User View

window.

2. Set view options as follows:

3. Select Dismiss to remove the Custom View Properties dialog box.

Selecting an Alignment Method

You can use the Alignment selection menu to specify the way in which a field
aligns itself to an enabled grid line.

To select the alignment method:
• Select the Alignment menu and select from the following options:

Enable Grid Click to enable the grid feature in the Customize User View
window. (Note that you can enable the grid feature without
displaying the grid lines by deselecting Show Grid.)

Show Grid Click to display the grid lines in the Customize User View
window.

Horizontal Grid Size Select and hold the mouse button down on the button within
the slider bar and move to the left or right. The number above
the slider bar, which represents the horizontal spacing (in
pixels) between the lines in the grid, changes accordingly.
You can also increment or decrement the pixel value by
selecting the left or right arrows on the numeric keypad on
your keyboard.

Vertical Grid Size Select and hold the mouse button down on the button within
the slider bar and move to the left or right. The number above
the slider bar, which represents the vertical spacing (in pixels)
between the lines in the grid, changes accordingly.
You can also increment or decrement the pixel value by
selecting the left or right arrows on the numeric keypad on
your keyboard.

Left Align the left edge of the field, including the field label,
to the grid line.

Value Left Align the left edge of the data entry portion of the field
to the grid line.

Right Align the right edge of the field, including any associated
field icons, to the grid line.
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Changing Field and Active Link Properties

To change the properties of a field or active link button:
1. Select Customize View from the Actions menu.

The Customize User View window appears.

2. Select the field or active link button, then select the Properties button (or
double-click on the field or button).
A Schema Item Properties window appears with the current settings for the
selected field (or active link button), as shown in Figure 7-4.

Figure 7-4 Schema Item Properties Window

3. Change the properties as appropriate, then select the Apply button.

Value Right Align the right edge of the data entry portion of the field
to the grid line.

None Disable the alignment feature, allowing you to reposition
the field on the schema without respect to the grid line.
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4. You can continue customizing the view by selecting additional fields or
active link buttons and changing their properties or by moving fields or
buttons.

5. When you are ready to save all of your changes, select the Apply button
on the Schema Item Properties window and on the Customize User View
window.

Note – After you select the Apply button on the Customize User View window,
you can return to the previous view by restoring it. But, once you select the
Dismiss button on the Customize User View window, you cannot return to
your previous view. You can always restore an Administrator view. For more
information see “Restoring Views.

6. To remove the Customize User View window and return to the Query
window, select the Dismiss button.
When you save your changes, the Query window immediately changes to
reflect the new view. The current view is saved in the
<ar_config_dir>/<schema_name>.arv  file.

You can change some of the following properties for each selected field or
active link:

Property Description
Label Lets you change the field label to one that may be more

familiar to you. Make sure the label you specify does not
suggest a different meaning for the field or active link. A
field (or active link) label can include any characters
(including blanks) and can be up to 30 characters long.
Capitalization is retained since labels are case-sensitive.

Label Position Lets you specify whether you want the field label to
appear to the left of or on top of the field.

Display Length Sets the length of the text field line.
Number of Rows Sets the number of rows used for radio button displays

or sets the number of rows of text shown for text type
items.

Field Type Lets you select an alternative presentation for selection
or integer data types. Selection type fields may be
displayed as a selection menu or as radio buttons.
Integer type fields can be displayed with or without
increment buttons (▲▼).
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Restoring Views
When you save a customized view by selecting the Apply button, the new
view is stored in <ar_config_dir>/<schema_name>.arv . The system also keeps a copy
of the view you had when you opened the Customize User View window.
After making changes to your view, but before dismissing the Customize User
View window, you can restore your previous user view. You can restore an AR
System Administrator default view at any time. You can also restore a view
you have saved in a backup file at any time.

Note – You should always save valuable views in a backup file at the UNIX
system level. To do this, copy the appropriate
<ar_config_dir>/<schema_name>.arv  file to another file so that it won’t be
overwritten. Do not copy it to
<ar_config_dir>/<schema_name>.arv.bak  since this file name is used by the AR
System.

To restore the previous view or the administrator’s view:
1. After selecting the Apply button on the Customize User View but before

selecting the Dismiss button, you can restore your previous (original)
view by selecting Previous View from the View menu, as shown in
Figure 7-5.

Location: X and Y Repositions the field or active link button according to
the X and Y coordinates you specify. This option is often
used after dragging a field (or active link button) to the
approximate desired location. If you have a series of
fields or active links on the same line, these fields or
active links must have the same Y coordinate in order for
tabbing between them to work as you expect (tabbing
works from top to bottom, left to right).

Visible/Hidden Sets whether or not the field or active link button is
visible on the schema. A hidden field or active link
button is not deleted — it can be made visible at any
time by changing the setting again. Hidden fields and
active link buttons are shown with grayed labels in the
Customize User View and Customize User Defaults
windows. They are not visible on other windows.
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Note – Once you select the Dismiss button on the Customize User View
window, you cannot restore your previous view.

Figure 7-5 Previous View Menu
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2. To restore an AR System Administrator view, select the desired
Administrator View from the submenu under the View menu, as shown
in Figure 7-6.

Figure 7-6 Reset View Menu

3. Select the Apply button to save the restored view.

4. Select the Dismiss button to remove the Customize User View window.

To restore a view backup file:
• At the UNIX system level, copy your backed-up view file to the appropriate

<ar_config_dir>/<schema_name>.arv  schema view file. Then, from the Query
window, re-select the schema from the Open Schema window to restore this
view.
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Exporting Views
If you have Administrator capabilities in the User Tool, you can export a
customized user view. That is, you can give the view a name and make it
available on the current AR System server so that it can be opened in the
Administrator Tool for further modification or for use as an administrator
view.

To export a customized view:

1. Open the customized view in the Customize View window.

2. With the Customize View window active, select the Export View
command from the View menu, as shown in Figure 7-7.

Figure 7-7 Export View Menu Command

Note – The Export View command is available to you only if you belong to the
Administrator access control group.

The Export View dialog box appears, as shown in Figure 7-8.
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Figure 7-8 Export View Dialog Box

3. In the Server View Name field, enter a name for the customized view.

4. Select the Apply button to save the view (or select the Dismiss button to
close the Export View dialog box without saving the view).
You can open the customized view in the Administrator Tool to modify it
further or use it as an administrator view.

Selecting an Administrator View
The AR System administrator who designed the schema you are using may
have designed more than one Administrator View of the schema. This
capability is particularly important for schemas that will be viewed on more
than one type of client, for example, both Motif and MS Windows.

You can set a user preference specifying the default Administrator View you
want to use (see “Setting User Preferences” on page 27). You can override this
default and select a different Administrator View by following the procedure
below.
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To select a different Administrator View:

1. Select Customize View from the Actions menu. The Customize User View
window appears displaying the currently open schema.

2. Select the View command from the Actions menu. The View menu opens,
as shown in Figure 7-9.

Figure 7-9 Selecting a Different Administrator View

3. With the View menu open, select one of the available view names from
the list (for example, Default Support Staff View).

4. Activate the selected view by clicking the Apply button.

5. Click on the Dismiss button to close the Customize User View window.
The view you selected is now the active view for the schema and stored in
your arHome directory.

Note – Refer to the Action Request System Administrator’s Guide for instructions
on designing alternate schema views.
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User Commands
You can create user commands to invoke any UNIX command or application
capable of being run from the UNIX command line. The user command
spawns a shell from the shell where the User Tool was started. Once the UNIX
command or application is finished, the spawned shell is exited.

A good example of where a user command can be useful is if you create a
macro that generates a report and saves it in a UNIX file. Then, the same macro
can execute a user command that takes that UNIX file and uses it as input to a
word processing application running in batch mode.

In this way, by executing just one macro, you have created a report from the
AR System and input it directly into a UNIX word processing application for
formatting.

Another example of where a user command can be useful is if you create a
macro that generates a report and then executes a user command that
electronically mails the report to your boss.

You can enter more than one command in the Command Line field by
separating the commands with semicolons. You can also write a shell script
and invoke that from the Command Line of a user command.

User commands allow you to invoke these UNIX commands or applications
from the Actions menu. Your user commands are saved in files named
<ar_config_dir>/<command_name>.arc .

You can allow other users to access your user commands by either letting them
copy your user command files or by saving your user commands in any
directory specified by your ARPATH environment variable that other users have
access to. For more information about sharing user commands and the ARPATH

environment variable, see the section entitled “Sharing Macros, User
Commands and Custom Reports” on page 34 in Chapter 2.

Note – Not all users have permission to create user commands. If you do not
have customize permission, Create Command appears grayed out on the
Actions menu and you cannot create user commands.
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To create a user command:
1. Select Create Command from the Actions menu.

The User Commands window appears, as shown in Figure 7-10.

Figure 7-10 User Commands Window

2. Select the directory where you want the user command to reside from the
Directory to search menu. Display the Directory to search menu by
selecting the pop-up symbol to the right of the field.
The Directory to search menu contains all directories defined by your
ARPATH environment variable, your <ar_config_dir>/arcmds  directory, and the
word All . You need to select a directory in which to store the user
command. You will receive an error if you select Apply and the Directory to
search menu field contains the word All  and not a directory path name.

3. In the Command Name field, type the command name for your user
command.
You can use any alphanumeric character and up to 30 characters.
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4. In the Command Line field, type the command line for your user
command.
You can enter any UNIX command line up to 255 characters long.

5. In the Help Text field, enter any help text that would be useful later when
using this user command.
Help text is useful for telling other users what the user command does, as
well as reminding yourself what it does.

6. Select the Add button to create this user command and add it to the list of
user commands available from the Select User Command window.

7. Select the Dismiss button to remove the User Commands window and
return to the Query window.

To modify a user command:
1. Select Create Command from the Actions menu.

The User Commands window appears.

2. Display the Directory to search menu by selecting the pop-up symbol to
the right of the field.
To display all of the user commands in the User Commands list that you
have access to, select All  from the Directory to search menu. To display only
the user commands contained in one directory, select that directory from the
Directory to search menu.

3. Select the user command that you want to modify by selecting it in the
User Commands scroll list.

4. To de-select a selected user command, either select a different user
command, or select the selected user command again. In either case, the
originally selected user command is no longer selected.

5. Make changes to the name, command line, directory, or help text as
desired.

6. Select the Modify button to save your changes.

7. Select the Dismiss button to remove the User Commands window and
return to the Query window.
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To delete a user command:
1. Select Create Command from the Actions menu.

The User Commands window appears.

2. Display the Directory to search menu by selecting the pop-up symbol to
the right of the field.
To display all of the user commands in the User Commands list that you
have access to, select All  from the Directory to search menu. To display only
the user commands contained in one directory, select that directory from the
Directory to search menu.

3. Select the user command that you want to delete by selecting it in the
User Commands scroll list.

4. Select the Delete button to delete the user command. On UNIX, there is a
confirmation prompt.
The selected user command is removed from the list in the window and
from the list of user commands available from the Select User Command
window.

5. Select the Dismiss button to remove the User Command window.

To execute user commands:
1. Select Run Command from the Actions menu.

The Select User Command window appears, as in Figure 7-11.
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Figure 7-11 Select User Command Window

2. Select the directory where the user command resides from the Directory to
search menu. To display the Directory to search menu, select the pop-up
symbol to the right of the field.
The Directory to search menu contains all directories defined by your
ARPATH environment variable, your <ar_config_dir>/arcmds  directory, and the
word All .

3. Select the user command you want to execute.

4. Select the Apply button to execute the user command.

5. Select the Dismiss button to remove the Select User Commands window
without executing any user commands.
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Administrator Commands

Your AR System administrator may have created some administrator
commands. Administrator commands are UNIX commands that are available
to all users. These commands run on the server as opposed to user commands
which run on the client. An example of where an administrator command is
useful is if one of your tasks is to archive ARs that are older than a certain date.
Your administrator could create a macro that generates a report of all ARs
older than a certain date specifying a layout of AR Export. This report can be
saved to a file. This same macro could then run an administrator command
that copies the report file to a file that is uniquely named based on the date that
the macro is run. In this way, you could run this macro once a week and save
each week’s archived ARs in separate UNIX files.

To execute administrator commands:
1. Select Run Admin Command from the Actions menu.

The Select Admin Command window appears, as in Figure 7-12.

Figure 7-12 Select Admin Command Window

2. Select the admin command you want to execute.

3. Select the Apply button to execute the admin command.

4. Select the Dismiss button to remove the Select Admin Commands
window without executing any admin commands.
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The Notification Tool allows for the prompt notification of users who need to
know when an AR has been submitted or when progress has been made in
resolving an AR. The AR administrator determines what kinds of changes
initiate a notification when setting up filters and active links in the AR System.

The Notification Tool alerts you when specific changes are made to ARs, as
defined by your AR administrator. The tool runs in the background and waits
for notifications to arrive from any AR server. When a notification is received
for you, the Notification Tool can do any combination of the following to alert
you, depending on the options you have set: beep, flash, open the tool, or
display a notice window. The tool also maintains a notification log file for later
reference. Depending on how the filter is created, and on how your AR
administrator specifies your default notification mechanism, you can be
notified by the Notification Tool or through email. For more information about
receiving notifications through email, see Chapter 9, Using Electronic Mail.

This chapter includes information about the following Notification Tool topics:

• Starting and exiting the Notification Tool.

• Changing current login information.

• Receiving a notification.

• Reviewing the notification log.

• Deleting notifications from the log.

• Setting Notification Tool properties.
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• Setting an alternate configuration directory for the Notification Tool.

For information on starting and working with the User Tool, see Chapter 2,
Getting Started with the User Tool.

Starting the Notification Tool
You can start the Notification Tool from any machine (or machines) on the
network with access to the AR System server. Before you start the Notification
Tool, make sure you have the following information from your AR
administrator:

• The directory that contains the executables for the Notification Tool (by
default, this directory is /usr/ar/bin ).

• Your registered AR System user name and password.

Note – A configuration directory is automatically created under your login
directory for use by the Notification Tool. If you want to change its location,
you should do so before starting the tool for the first time.

Your user name and password identify you to the AR System and give you the
appropriate access permissions.

In the following steps, <ar_run_dir> refers to the directory containing the
executables for the User and Notification Tools.

To start the Notification Tool:
1. Type the following at the UNIX prompt:

2. If you are starting the Notification Tool for the first time, the Login
window appears. Enter your registered user name and password, then
select the Apply button.
Once you have logged into the Notification Tool, your login name is
included in the title of the Notification Tool window. Notifications destined
for you are sent to all machines where you are running the Notification Tool.

% <ar_run_dir> /notifier &
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Note – If there is more than one user logged in with the same user name, and
if one of these users experiences some system problem at the same time a
notification is sent out, as long as at least one user receives the notification for
that user name, the user experiencing system problems will not receive any AR
System error.

Changing the Current Login Information
If the Notification Tool was previously started by another user, you can change
the user information and log in as yourself. This means you can log in at any
machine on the network that has access to the AR server.

Note – If you log into the Notification Tool on a system where someone else is
logged, before you change the user information and log in as yourself in the
Notification Tool you might want to change the other user’s NTHOME

environment variable to point to the directory defined by your NTHOME

environment variable. If you don’t and you have specified to save your
notification messages between runs of the Notification Tool, they are saved in
the directory defined by the NTHOME environment variable of the user who is
logged in. For more information about changing the NTHOME environment
variable, see Setting an Alternate Configuration Directory later in this chapter.

To change the current login:
1. Select Login from the Notification Tool File menu (or type Ctrl-N ).

2. In the Login window, enter the correct name and password for the new
login.

3. Select the Apply button to complete the login.
Any notification messages sent to your login name are appended to the list
of the previous user’s notification messages.

4. Select the Dismiss button to dismiss the Login window without changing
the user name or password.

Exiting the Notification Tool
To exit the Notification Tool, select Exit from the File menu (or type Alt-F4 ).
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You can also exit the tool by selecting Quit from the Window menu.

Receiving a Notification
When a notification arrives, the Notification Tool responds according to the
alert options you have selected (see Setting Notification Tool Properties).
Figure 8-1 shows a notice window.

Figure 8-1 Notice Window

If you have not set an alert option, you are not alerted when a notification is
received. In either case, your notifications are stored in a notification log where
you can review them and display or modify the AR that generated the
notification (see Reviewing the Notification Log).

To use the notice window:
1. If you are alerted with a notice window (Figure 8-1), you can retrieve more

information about the notification by selecting the Get Details button.
If the notification is from the AR System, selecting the Get Details button
starts the User Tool, if it is not already running. The AR that caused the
notification to be issued appears in a Display or Modify Individual window,
depending on how you have set the Properties options (see Setting
Notification Tool Properties).

2. To simply acknowledge the Notification and delay further action, select
the Continue button in the notice window.
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Reviewing the Notification Log
The notification log, shown in Figure 8-2, lists each notification as it is received.
You can review the notification log at any time by opening the Notification
Tool. At any time you can select one or more notifications and request
additional information by selecting Get Details from the View menu (or type
Ctrl+D ).

Note – The date and time in the Notification Log window is the date that this
Notification Tool received this notification and not the date and time that the
notification was issued.

Figure 8-2 Notification Log Window

To view the AR related to a notification:
1. Open the Notification Tool to display the log.

2. Select the notification in the log.
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3. Select Get Details from the View menu or double-click on the notification
(or type Ctrl+D ).
If the notification is from the AR System (if AR is in the Source column),
selecting Get Details starts the User Tool, if it is not already started. The AR
that caused the notification appears in a Display or Modify Individual
window depending on how you have set the Properties options (see Setting
Notification Tool Properties).

If you receive any type of message from the Notification Tool itself, NT will
be in the Source column.

An error message appears if there is an error accessing additional
information, such as not being able to find a User Tool to run.

To delete notifications:
1. Open the Notification Tool to display the log.

2. To delete all notifications, select Delete All from the Edit menu.

3. To delete selected notifications, select the notifications to be deleted and
select Delete Selected from the Edit menu (or type Ctrl+S ).

Setting Notification Tool Properties
You configure the behavior of the Notification Tool by selecting Properties
from the Options menu in the Notification Tool window (or type Ctrl+P ). The
Notification Tool - Properties window appears, as shown in Figure 8-3.
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Figure 8-3 Notification Tool - Properties Window

The following list describes the Notification Tool property settings:

Action on New Allows you to configure how the Notification Tool
Message reacts when a notification arrives. You can

set the Notification Tool icon to flash, beep, open
the Notification Tool, or display a notice window.
You can select multiple options or none.

Save Notifications You can save notifications between runs of the
Between Runs Notification Tool by selecting the Save Notification

between runs option.

Maximum Allows you to specify the maximum number of
Notifications in notifications that you can save and display in the
Window Notification Tool window. After the maximum

number of notifications are displayed, any new
notifications are displayed and the oldest
notification is deleted.

Log Notifications Allows you to specify a path and filename to be
to File used as an audit trail log file. This file holds an

audit trail of all notifications received. If you do
not specify a name, no audit trail file is kept.
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If you specify a name, all notifications received
are logged to this file as well as to the local
notification log online.

Note – The audit trail log file is an append-only listing of every notification
received and is useful as an audit trail. It is different from the log that is
created when you save notifications between runs; that log is simply an image
of the list of “still active” notifications.

Command Type Allows you to specify whether a Display or a Modify Individual
window appears when you select Get Details for or double-click on
a notification that is related to an AR.

To set Notification Tool properties:
1. Open the Notification Tool icon to display the Notification Tool window.

2. Select Properties from the Options menu to display the Properties
window or type Ctrl+P . (See Figure 8-3.)

3. Select the options you want and select the Apply button.

4. Select the Dismiss button to close the window without making any
changes.

Setting an Alternate Configuration Directory
The Notification Tool uses a directory to hold your personalized configuration
information. By default, this directory is named arHome . If you do not want to
use the default arHome directory, you can set an alternate configuration
directory either during installation or at a later time. Follow the instructions
below to set an alternate configuration directory at any time after installation.

To set an alternate configuration directory:
1. Create the new directory where you want your AR System-related

information stored. For example, to create the directory /user/myhome ,
type:

% mkdir /user/myhome
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2. Set the environment variable NTHOME to reference the new directory. For
example:

Environment variables tell the AR System tools where to look for and store
information used in their operation. The ARHOME variable tells the User Tool
where its local configuration information is stored. The NTHOMEvariable
tells the Notification Tool where its configuration information is stored. You
may set the ARHOME and NTHOME variables to point to separate directories;
however, they are usually set to the same directory for simplicity. (See
Chapter 2, Getting Started with the User Tool, for more information on
setting an alternate configuration directory for the User Tool.)

Note – If the environment variables are not set, the configuration information
is stored in the directory arHome under your home directory.

To keep these settings in effect, you should put the above entries into your
shell’s start-up file (.cshrc , .profile  or other resource file). See your
system administrator for details.

Displaying Version and Environment Information
Select On Version from the Help menu (or type Ctrl+V ) to display information
about the product, as shown in Figure 8-4. The information includes the tool
name, version number, and copyright information.

You should be prepared to provide this information whenever you call for
Customer Support.

% setenv NTHOME /user/myhome
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Figure 8-4 Getting Version Information
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Using Electronic Mail 9

The Action Request System supports submitting ARs and receiving
notifications through electronic mail (email). Using email, you can submit ARs
even if you do not have access to a User Tool or if the AR System server is
inaccessible. Electronic mail is often the preferred communication tool in
environments where there is no direct high speed network link between the
user and the AR System Server.

This chapter includes information about the following topics:

• Understanding how email works with the AR System.

• Constructing email templates.

• Submitting ARs using mail templates.

• Receiving notifications through email.

Overview of the AR System’s Use of Electronic Mail
When you cannot directly access the AR System server, the AR System allows
you to query or submit action requests through email using special email
templates. Templates are generated by AR System administrators from any
existing schema using the Export facility of the Administrator Tool. If you need
an email template for a schema, request it from your AR administrator.

To query or submit ARs through email, you need:

• A mailbox address (default is ARSystem).
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• An email template containing fields to fill in.

Email is processed by the AR System mail handler (armaild ). It watches the
mailbox of the AR System user for new messages. When messages are received
and processed, ARs are created. You cannot display or modify ARs by email.
You can only submit ARs.

The Email Template
The Export operation of the Administrator Tool generates a template that can
look like the example shown in Figure 9-1.

Figure 9-1 Sample Email Template

Email templates have three components:

• Comments. (optional)

• Header block.

• Fields and values.

#
# File exported Wed Jun 26 15:34:25
1991
#
Schema: TroubleTicket
Server: gemini
Login:
Password:

Short-Description ! 8!:
Description ! 9!:
Impact !108!: Low
# Values: Low, Medium, Serious,
Critical
Submitter ! 2!:
Notify-submitter-method! 12!:None
# Values: None, Notifier, E-mail

Comments

Template
header

Fields for text
entry

Possible
selection
values as
comments



Using Electronic Mail 180

9

Comments

Comments are optional and must begin with a # in the first character column.
They can occur anywhere in the message. In the example shown in Figure 9-1,
the time stamp of the export operation and the listing of values (#
Values:... ) are comments.

Header Block

The Header block contains the primary address information needed by the AR
System to identify the sender. It includes both mandatory and optional
information:

• The header block contains a Schema: line. You can enter the name of the
schema you want to use on this line. (The schema name is often already
filled in when you get the template from your system administrator.) If you
do not enter a schema name or if the schema you enter does not exist, the mail
handler checks to see if a default schema was defined in the configuration file
specified when the mail handler was started. If not, the item is rejected since a
schema must be specified.

• The Server:  line contains the name of the server on which the schema is
located. (The server name is often already filled in when you get the
template from your administrator.) If you do not enter a server name or if the
server you enter does not exist, the mail handler first checks to see if a default
server was defined in the configuration file specified when the mail handler
was started. If not, then the machine running the armaild  process is used as
the server.

• You may enter values in the Login:  and Password: lines if you desire. You
need to fill in these fields to identify yourself as the user performing the
operation. If you omit these values, the mail handler checks to see if defaults
were defined in the configuration specified when the mail handler was
started. If not, the user “Mailer daemon” is identified as the user.

Note – Using the Login : and Password : lines may give other users access to
your AR System account since your user name and password are visible. If this
is a problem for you, we suggest you use an alternate method of identifying
yourself.
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Fields and Values

The main body of the email message consists of a set of fields that you need to
fill in. Fields that have default values are automatically filled in for you (you
can change these values if you need to).

A field reference consists of a field name and field ID. The field name is
optional. The field ID is what the AR System actually uses to process the data;
it must be specified. The field ID value is placed within exclamation points. For
example, field ID 9 would be !9! . Only digits and blank spaces are valid
characters within the exclamation points. After the last exclamation point there
is a single character, usually a colon (:), to mark the end of the field name.

Guidelines for Entering Values into Fields

There are several rules to remember when entering values into fields:

• The maximum size of any single line is 1024 bytes. If you enter a line that is
longer than 1024 bytes, it will be truncated.

• Diary type fields and character type fields with the maximum length of over
50 characters can use multiple lines of text.

• If you do not enter a value into a field but a default value is defined for the
field, then the default value is loaded. If you do not enter a value into a field
and there is no default value defined for it, and the field is a required field,
you will receive an error. See the section entitled Responses to Email
Submissions later in this chapter for information on receiving error messages.

• Values can be entered any place after the delimiting character. Leading and
trailing blanks are ignored when a value is read by the Mail daemon.

Figure 9-2 is an example of a completed template, ready to be submitted to the
AR System. Text entered by the user is shown in bold type.

# File exported Tue May 8 9:48:22 1993
#
Schema: TroubleTicket
Server: gemini
Login: Joe User, Jr.
Password: <password>

Short-Description! 8!: Lost access to the print server
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Description! 9!: Whenever I send a file to the print
server, I get a message back telling me “unknown host
print”.
Impact!108!: Serious
# Values: Low, Medium, Serious, Critical
Submitter! 2!: Joe User, Jr.
Notify-submitter-method! 12!: E-mail
# Values: None, Notifier, E-mail
Keywords!295!: Printer

Figure 9-2 Completed Email Template

Querying or Submitting via Electronic Mail
You can fill in an email template using email tools or your favorite text editor
to either query or submit Action Requests by electronic mail.

Querying via Electronic Mail

queries can be made in three formats via email:

• Query by Entry ID

• Query by Field

• Query Bar Command

Query by entry ID

The simplest method is the query by entry-id. This method requires that the
user email a specific entry-id value.

Query by Field

The query by field method allows the user to specify a selection on a field or
fields for the schema they wish to query, much like the functonality of the user
tool. This method can return multiple entries.
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Query Bar Command

The query via a query bar request is the most powerful version of the query
via email functionality. This method provides an email-based query bar facility,
anything you can enter in the query bar can also be done via email.

Formatting a Query via Electronic Mail

All matching requests are listed in the body of a message, one after another. In
full format, each entry is seperated by a line of dashes. If a request fails, an
error envelope is returned with an indication of the cause of the failure.

Submitting Email

You can fill in an email template using email tools or your favorite text editor.

Using an Email Tool:
Follow these steps to create an AR for submission using an email interface:

1. Run your email tool.

2. Open the supplied template.

Table 9-1 Email Queries

If an email query... Then the AR System...

Fails Returns an error envelope with an indication of the
cause of the failure.

Finds only one match Sends the entry to you via email.

Finds more than one match Sends:
* The entries to you via email.
* A message indicates the total number of matches.

Finds more than the
maximum allowable matches

Sends:
* The maximum allowable number of entries to
you.
* A message indicating the total number of matches.
* A message indicating that the query exceeds the
configured query match limit and what that limit is.
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3. Fill in the appropriate fields.

Note – You can add additional fields to the template if you have permission to
access these fields. If you do so, you must specify a Login:  field to have your
permissions take affect. But, be aware that using the Login : and Password :
lines may give other users access to your AR System account.

4. Direct your mail message to the user identified by your AR administrator
(usually this is simply ARSystem). Supply a subject if desired, although it
is ignored by the AR System mail handler.

5. Mail your message.

Using a Text Editor:
Follow these steps to create an AR for submission using a text editor such as vi

or ed :

1. Open the editor.

2. Load the supplied template.

3. Fill in the appropriate fields.

Note – You can add additional fields to the template if you have permission to
access these fields. If you do so, you must specify a Login:  field to have your
permissions take affect. But, be aware that using the Login : and Password :
lines may give other users access to your AR System account.

4. Save the message you created by saving the modified template to a new
file.

5. Direct your mail message to the user identified by your AR administrator
(usually this is simply ARSystem). For example, where
mailfile  is your mail message, you might use a command like this:

% mail ARSystem < mailfile
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Responses to Email Submissions

An email submission may be successfully received by the AR System or it may
be rejected and returned to you. If your submission is successful, you’ll receive
a confirmation message that includes the ID of the AR entry. If your
submission is rejected, you’ll receive a message identifying any errors and the
full text of the original submission. For example, an email submission may be
rejected because you failed to fill in a required field (and there was no default
set), because there was no Schema: line, or because the specified schema does
not exist.

Note – If you are not receiving confirmation or error messages, it may be
because the AR System administrator has set configuration values for the AR
System mail handler that cause it to send confirmation and error messages
elsewhere. If you are not receiving confirmation or error messages and believe
you should be, check with your AR System administrator.

Receiving Email Notifications
If you cannot directly access the AR System server, you may receive
notifications through email. If email is designated as the delivery mechanism
for notifications, the notification message text may be sent to your email
address. See the Action Request System Administrator’s Guide for information on
designating email as the delivery mechanism for notifications.
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You can start the User and Notification Tools from the command line. For the
User Tool, you can include any of the various command line options. For
example, you can include the -i  or -e  command line option to execute a macro
when the User Tool starts. If need be, you can even pass parameters to the
macro. You can also use most of the X11 Toolkit Intrinsics command line
options. For more information about X11 Toolkit Intrinsics command line
options, see the X11 man page or your system administrator.

Note – If you run the User or Notification Tools from within a shell or script,
be sure to set any necessary environment variables before executing the tool.

User Tool (aruser)
In UNIX manual page syntax, the command to run aruser  is:



187 Action Request System User’s Guide for OSF/Motif—January 1996

A

Note – Manual page syntax: Items between square brackets ( [ ] ) are optional.
You must choose one of the items between braces
( { } ). Vertical bars ( | ) separate the available choices. You can list more than
one server.

Names containing spaces or special characters must be entered within quotes.

Syntax Options

The following options to aruser  may appear in any order on the command
line:

Table A-1 Syntax Options: User Tool

Option Function

-d The directory that the macro indicated by the -e  or -i  parameter is
located in. This parameter is optional. If it is not specified, the macro is
assumed to be in the default location for the user running the command
($ARHOME/arcmds). Use the following format: -d directory.

-e Run the indicated macro at system startup and exit the program when
the macro has been completed. This option is good for running the tool
to perform some specific operation (for example, generate a report) but
not come up interactively. This is especially useful when running the
system from a batch script.

-i Run the indicated macro at system startup and the program remains
active when the macro has been completed. This option is good for
setting the system into an initial state at startup.

-I Iconize the program at startup.

aruser [{-e | -i} < macroName> [-p param=value ...]] [-n] [-s] [-I]
[-d directory] [-x server]
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Examples Using Syntax Options

Open the User Tool with a macro running interactively:

-n Do not share an existing instance of the aruser  program even if it is
possible. Run this instance as an independent program.

By default, the system will share a running instance of the program
when run with the -i  option. This makes the system run more
efficiently by running the macro in an existing instance of the tool and
not paying the overhead penalty for an independent instance. This
option allows you to override that default operation and force an
independent instance of the tool to be run.

In general, you want to take advantage of the sharing of existing
instances as it is both faster and uses the resources on the workstation
more efficiently. This option should be used as an exception case when
and if needed.

-p Specify a value for a parameter. There may be more than one -p  option
in a command line. If the macro specified (using the -e  or -i  options)
has a parameter, a value can be supplied by naming that parameter and
assigning a value. If either the parameter name or value includes a
space or other special character that is interpreted by the command
line, the parameter must be enclosed in quotes to stop the interpretation
of the special characters. Use the following format for each parameter
that you specify:
-p parameter=value

-q This option performs no operation. It is supplied for backward
compatibility.

-s Open a submit window on the initial schema at startup. If there is no
initial schema, this option does nothing.

-x Specify the name of a server to connect to. This option may be included
more than once to connect to multiple servers.

By default, the list of servers the tool will connect to is defined in the
directory file /etc/ar . If this option is not specified, this file will be
used to determine where to connect. If this option is specified one or
more times, the servers specified in these options will be used. Use the
following format:
-x server name

Table A-1 Syntax Options: User Tool

Option Function
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Invoke a macro but run in the background and exit on completion:

Open the User Tool and run a macro, with two parameters (for example, id

and User Name ), running interactively:

Note – The example above is only an example

Using a Null Value in a Query
When you want to use a null value in a query, you have to use precise syntax
to achieve accurate results.

For example, if you have a macro that prompts for three parameters that will
be stored on a child schema:

• Status (stored a character field)

• User name (stored a character field)

• Status change date (stored a date/time field)

From the command line, the following example works:

aruser -e "storeticket" -p "status"="NEW" -p
"status change date"="11/01/95" -p "user name"="TEST USER"

However, an error occurs when there is not a value for

% <ar_run_dir>/aruser -i < macroName> &

% <ar_run_dir>/aruser -e < macroName> &

%<ar_run_dir>/aruser -i < macroName> -p id=1 -p "User
Name"="Fred Smith"&
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"status change date"
aruser -e "storeticket" -p "status"="NEW" -p
"status change date"="" -p
"user name"="TEST USER"

This gives the error 'Unrecognized command line option (ARERR 1004)

user name=TEST USER

aruser -e "storeticket" -p "status"="N EW" -p
"status change date"=""

This works OK (because there is no value behind the null value)

There is only a problem when another parameter follows the NULL value.

Instead of fighting the UNIX command line processor, separate empty
quotation to its own argument. then the parser is OK.  The string A="" is
interpreted by the command line parser as A= (a single argument consisting
of the string 'A=')

A = ""

is interpreted as

A = <empty string>    (three arguments consisting of 'A', '=' , and
<empty string> )

So, try entering

aruser -e "storeticket" -p "status" = "NEW" -p
"status change date" = "" -p
"user name" = "TEST USER"



191 Action Request System User’s Guide for OSF/Motif—January 1996

A



192

Changing Colors and Fonts B

You can change colors and fonts of the User Tool and Notification Tool on a
per-system basis, although usually the defaults supplied are sufficient. For
your reference, the default fonts and colors are provided in a sample file, called
ARSystem, located in the <ar_install_dir>/bin  directory. If you want to change
either colors or fonts, you simply update the .Xdefaults  file in your home
directory, or you can copy the sample files (ARSystem and NTSystem ) to your
home directory and change the default settings to the settings you want.

In order to have changes to the file recognized, you need to do the following:

• Run the program xrdb  as follows:

Once run, all instances of the User and Notification Tools will use the new
colors and fonts.

Customizing with Color
You can change the colors used in a number of areas of the User Tool. To see a
listing of available colors, type showrgb at the UNIX prompt.

% cd (to change to your home directory)
% xrdb -merge .Xdefaults
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AR System Resources
This section lists the default settings for colors, fonts, and dimensions used in
the AR System tools.
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aruser (User Tool) Resources

Table B-1 aruser (User Tool) Resources (1 of 2)

aruser (User Tool) Resources Default Setting

ARSystem*menubar.spacing 10

Font used for menus:
ARSystem*menubar*fontList

8x13

Default font used by AR System:
ARSystem*fontList

-adobe-helvetica-medium\
-r-*--12-*, \

-adobe-helvetica-medium\
-o-*--12-*=Italic, \

-adobe-helvetica-bold\
-r-*--12-*=Bold

Default background of all windows:
ARSystem*background

steelblue2

The background of the scrollable portion of
the Query Window:
ARSystem*Query*background

lightsteelblue

The background of the text entry fields of
the Query Window:
ARSystem*Query*XmText*background

lightsteelblue3

The background of the scrollable portion of
the Submit window:
ARSystem*Submit*background

skyblue2

The background of the text entry fields of
the Submit Window:
ARSystem*Submit*XmText*background

skyblue1

The background of the scrollable area of the
Modify window:
ARSystem*Modify*background

#9db1c5

ARSystem*Modify*XmText*background lightsteelblue

The background color of the scrollable
portion of the Display window:
ARSystem*Display*background

lightsteelblue3

The background color of the scrollable area
of the Customize View window:
ARSystem*CustomizeView*background

#c4a5a8
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NT System (Notification Tool) Resources

Font used for reports:
ARSystem*Report*fontList

8x13,8x13bold=Bold

Font used for queries:
ARSystem*QueryList*fontList

8x13

The background of the Query window:
ARSystem*QueryList*background

#9db1c5

The background of popup windows:
ARSystem*PopupWindow*background

skyblue

ARSystem*queryButtons*marginWidth 5

Table B-2 NT System (Notification Tool) Resources

Resources Default Settings

Default font used by NT System:
NTSystem*fontList

-adobe-helvetica-medium-r-*--12-*, \

-adobe-helvetica-medium-o-*--12-
*=Italic, \

-adobe-helvetica-bold-r-*--12-*=Bold

Default background of all windows:
NTSystem*background

steelblue2

The background of popup windows:
NTSystem*popupWindow*background

skyblue

NTSystem*menubar.spacing 10

Font used for menus:
NTSystem*menubar*fontList

8x13

Table B-1 aruser (User Tool) Resources (2 of 2)

aruser (User Tool) Resources Default Setting
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arimport Resources

Miscellaneous Resources

Table B-3 arimport (Import Tool) Resources

Resources Default Settings

The background color for the menu
bar:
ARSystem.menubar_bg

steelblue2

The background color for scrollable
lists on the Main and Fallback
Mappings windows:
ARSystem.fields_bg

skyblue

The background color for labels:
ARSys-
tem*display_lab.fontList

-adobe-helvetica-bold-r-*--12-*

Table B-4 Miscellaneous Resources

Resources
Default
Settings

ARSystem*IconColor green

ARSystem*hightlightColor yellow

ARSystem*selectColor orange

ARSystem*armColor red
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AR System File Locations C

This Appendix describes the various files needed by and created by the AR
System. The directory where the AR System executables are installed is
referred to here as <ar_run_dir> which is the bin  directory under
<ar_install_dir> (/usr/ar/bin  and /usr/ar  respectively, are the defaults). The
directory specified to hold the user’s configuration information is referred to
here as <ar_config_dir> (usually, this directory is /home/ <user_name>/arHome ).
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C

AR System User Tool Files

AR System Notification Tool Files

User Tool <ar_run_dir>/aruser

Configuration File <ar_config_dir>/config

User Views <ar_config_dir>/< schema_name>.arv

User Defaults <ar_config_dir>/< schema_name>.ard

Local Schema <ar_config_dir>/< schema_name>.arf

Definitions
User <ar_config_dir>/arcmds/< user_command_name>.arc

Commands
Macros <ar_config_dir>/arcmds/< macro_name>.arq

Custom Reports <ar_config_dir>/arcmds /<custom_report_name>.arr

AR Servers /etc/ar

Catalog Files /usr/share/lib/locale/LC_MESSAGES/C/arsystem.cat

(for Sun)
/usr/lib/nls/C/arsystem.cat

(for HP)
<ar_install_dir>/locale/arsystem.cat

Man Pages <ar_install_dir>/man/man1/*.1

<ar_install_dir>/man/man5/*.5

X Application /usr/lib/X11/app-defaults/ARSystem

Defaults /usr/lib/X11/app-defaults/HyperHelp

Notification Tool <ar_run_dir>/notifier

Notification Client <ar_run_dir>/ntclientd

Configuration File <nt_config_dir>/config

Notification Servers /etc/ar

X Application /usr/lib/X11/app-defaults/NTSystem

Defaults /usr/lib/X11/app-defaults/HyperHelp

Saved Notification Log <nt_config_dir>/config.lst
Catalog Files /usr/share/lib/locale/LC_MESSAGES/C/ntsystem.c

at

(for Sun)
/usr/lib/nls/C/ntsystem.cat

(for HP)
<ar_install_dir>/locale/ntsystem.cat
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C

AR System Import Tool Files
Import Tool <ar_run_dir>/arimport

Saved Import Log /tmp/arimport.log

Mapping file <ar_config_dir>//arcmds/mapping.arm

X Application /usr/lib/X11/app-defaults/ARSystem

Defaults /usr/lib/X11/app-defaults/HyperHelp
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Procedures D

Here is a list of procedures and thepages on which they are located.

To start the User Tool  10
To change the current login  21
To select a schema  24
To set user preferences  27
To set an alternate configuration directory  34
To submit an action request  43
To type and edit information in a field  49
To use selection menus  50
To use selection radio buttons  50
To use the Text Edit window  53
To use the Diary Entry window  54
To use a Selection List window  59
To query the database  61
To define query criteria  65
To enter information in the query bar  71
To specify query operations sorting order  82
To use the Query List window  86
To use the Display Window  89
To view the status history of an AR  90
To modify individual ARs  93
To show the status history of an AR  93
To modify all selected ARs  94
To re-display query criteria  94
To display query list  94
To submit a similar AR  94
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To add a new diary entry  95
To delete ARs  96
To generate a report  106
To select fields for a report  107
To specify the report layout  111
To define report preferences  113
To specify report sorting and grouping order  117
To specify statistics  120
To save a custom report  124
To use a custom report  126
To modify a custom report  126
To modify a report’s name or help text  127
To delete a custom report  129
To display a report to the screen  130
To send the report to a file  130
To print a report  132
To record a macro that performs a query  136
To record a macro with variables  140
To execute a macro  142
To edit the name or description  144
To delete a macro  146
To define default field values  148
To change the location of fields on the schema  151
To set custom view properties  153
To select the alignment method  153
To change the properties of a field or active link button  154
To restore the previous view or the administrator’s view 156
To restore a view backup file  158
To create a user command  163
To modify a user command  164
To delete a user command  165
To execute user commands  165
To execute administrator commands  167
To start the Notification Tool  169
To change the current login  170
To use the notice window  171
To view the AR related to a notification  172
To delete notifications  173
To set Notification Tool properties  175
To set an alternate configuration directory  175
Using an Email Tool  183

To start the User Tool  10
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D

Using a Text Editor  184
To start the User Tool  10
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Glossary

action request
AR. A collection of information that describes an event (transaction), such as a
problem or a service request.

access control
Security feature that lets you limit the access users have to specific fields
within a schema and to specific functions within the system.
See also access control group, permissions.

access control group
Facility of the Action Request System used primarily to define user access to
the contents of a schema field. Each group can have its own member list
defining users who belong to that group. The AR System defines five special
groups: Public, Administrator, Customize, Submitter, and Assignee. You can
define additional groups through the Group schema. Once you have defined a
group, you can specify the type of access that the group will have to specific
fields within a schema. See also access control, permissions.

access permissions
See permissions.

active link
A cause and effect relationship that you define on a per schema basis. Active
links cause the Action Request System to perform specific operations in
response to specific user actions. The AR System administrator can define
active links that run macros, set fields to specified values, run independent
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system processes, send an interactive message to the user, change field
characteristics, or execute a DDE operation on a Windows User Tool. Active
links run on the client machine.

administrator
Individual responsible for the management of the AR System, including setting
up schemas, setting access rights for users, and designing the workflow
process.

administrator default
Value that the administrator assigns to a field while designing the schema.
When the user sets defaults, this value is used unless the user has assigned
their own default. When a user submits an AR, the AR System automatically
enters this value in the field unless the user has assigned their own default or
has entered a different value.

administrator command
Menu extension defined by the AR System administrator using the
Administrator Tool. Administrator commands allow users to invoke specific
commands running on the server. (Administrator commands are not available
from PC or Macintosh clients.) See also user command.

Administrator group
One of five special access control groups provided by the AR System. Members
of this group have full and unlimited access to the AR System. You must be a
member of this group to be able to create schemas, filters, active links, menus,
and administrator commands.

Administrator Tool
The part of the AR System used exclusively by administrators to set up the
system for use by support staff and end users. This includes setting up
schemas, setting access permissions (users and groups), and creating filters,
active links, menus, and administrator commands.

administrator view
The layout of a schema that was designed by the AR System administrator.
This is the view that users will see unless they customize their view.

API
Application program interface. A set of functions that provide application
programmers with access to the full functionality of a product. The AR System
API provides a complete interface to the AR System server.
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AR
See action request.

ARWeb license
Fixed or floating license that allows a user access to the ARWeb product.

AR System client
1. Subset of AR System software necessary to allow a user to access an AR
System server on the network and run the AR System tools on the local
workstation.
2.Hardware (workstation, terminal, Macintosh, or PC) running the AR System
client software.

AR System server
1.Full set of AR System software. When installed on a workstation on the
network, the server software provides access to the full feature set of the AR
System and can be accessed by workstations, Macintoshs, terminals and PCs
on the network that are running the AR System client software.
2.Hardware (workstation) running the AR System server software.

assignee
The person who is assigned responsibility for resolving an action request.

Assignee group
One of five special access control groups provided by the AR System. This is an
implicit group; users automatically belong to this group and, if they have a
valid AR System license, are granted change access for ARs for which they
have been assigned responsibility (their name is in the Assigned-to field).

character data type
Data type used for fields where you will be entering text data. The AR System
administrator can specify a maximum length for the field or leave the length
unlimited. The administrator can also specify a pattern to restrict the data that
users can enter or attach a character menu to the field.

character menu
A type of menu that opens up to different levels as you “pull” a selected item
to the right using the mouse. You can create a character menu and attach it to
any character-type data field.

client
See AR System client.
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command line options
Parameters that you can combine with the commands to start the User,
Administrator, and Notification Tools that allow you to specify how the tools
will run. For the User Tool, you can execute a macro or open to the Query or
Submit window. For the Administrator Tool, you can attach to a specific server
or open the tool with a specific category displayed.

core field
One of a set of basic fields that are common to all AR System schemas.
Additional limits, such as fixed or maximum sizes, are placed on some core
fields.

configuration
1.The process of setting up hardware and/or software so that it operates in a
manner consistent with the needs of a location.
2.The physical setup of a device or devices.
3.The operating characteristics of software.

custom extension
See administrator command, user command.

Customize group
One of five special access control groups provided by the AR System. This
group grants users the right to customize their schema layout and create
custom commands in the User Tool.

database
A collection of information maintained in the form of individual entries. The
AR System allows you to create and maintain a history of trouble reporting
information.

data type
Property of a field that determines what type of information the field contains.
The choices are character, date and time, diary, integer, real, and selection.

date and time data type
Fields with this data type are limited to calendar dates and time.

DDE
Dynamic Date Exchange. This is a standard inter-application communication
feature used in Windows applications. For more information, see your
Windows documentation.
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default
System or user defined setting or value that automatically applies to a field if
users do not supply a different setting or value when submitting a new action
request.

diary data type
Fields with this data type allow you to capture a history of the actions taken
for an AR. Each multiple character entry is stamped with the time, date, and
name of the user who entered the item.

dynamic menu
Menu that performs a query at the time a user selects the menu icon and uses
the results of the query to build the list of menu items from which the user
chooses.

end user
In the AR System, an end user is the person who is responsible for notifying
support staff of problems and service requests by submitting ARs.

email
Electronic mail. The AR System allows you to set up an electronic mail handler
so that users can submit ARs through email if they do not have access to a User
Tool or if the AR server is inaccessible. (If you are running the client tools on a
PC, your PC must be equipped with an SMTP gateway to allow email
submissions.)

export
Facility that lets you move schemas, filters, active links, menus, administrator
commands, and mail templates to a file. Exporting is useful if you want to
share schemas with another server or generate mail templates.

extension
See user command, administrator command.

filter
Facility that tests every server transaction to see if certain conditions are met
and responds to the conditions by taking a specific action or actions. The AR
System administrator can define filters that set fields to specified values, run
independent system processes, send an interactive message to the user, notify
the user when the state of an AR changes, or make an entry in an audit trail
log. Filters run on the server.
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fixed license
Write license that is permanently assigned to a user so that the user always has
access to the AR System.
See also floating license, write license.

Flashboards license
Fixed or floating license that allows a user access to the AR System
Flashboards product.

floating license
Write license that exists on a server and is allocated to any user who requests a
license and who is defined in the User database as having a floating license
type. If no floating license is available at the time of the user request, the user
must wait until a license becomes available.
See also fixed license, write license.

FTS
See full text search.

FTS license
Fixed or floating license that allows a user to perform a full text search in any
large text or diary field indexed for FTS.

full text search (FTS)
Facility that allows a user to quickly search for information in large text or
diary fields. The fields must be indexed and FTS-enabled by the AR System
administrator, and the user must have an FTS license.

group access
See group type.

Group schema
Schema that lets you add new groups and modify group permissions.

group type
The maximum permission type allowed for a group. May be None, View, or
Change. (Note that permission may be set below the group’s maximum at the
field level.)

guest user
An unregistered user with a limited set of capabilities (submit ARs and
possibly review those ARs). Unregistered users may not be allowed at your
site.
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hidden field
A field that exists but is not visible in a user’s view of the schema.

Import Tool
Facility that lets you share schemas, filters, active links, menus, and
administrator commands that were created on another server. First, you must
export the definitions from the server on which they were created to an ASCII
file, then you can import the file to your own server.

integer data type
Fields with this data type contain numeric values between
-2147483648 and 2147483647. (The range for a particular field may be limited
by the administrator.)

license
See fixed license, floating license, read license, write license.

login window
Window that allows you to login to the AR System when you first start an AR
System tool.

macro
A set of operations recorded for later execution. Macros are useful for
automating frequently used or complex query operations.

mail template
Template that contains the fields that you need to fill in to submit an action
request using electronic mail. Templates are generated by the administrator
from existing schema using the export facility. (If you are running the client
tools on a PC, your PC must be equipped with an SMTP gateway to allow
email submissions.)

notification
An alert that tells you that an AR System event has occurred. The alert may be
a system beep, flash, the display of a notice window, or the opening of the
Notification Tool.

Notification Tool
The part of the AR System that alerts you when specific changes are made to
ARs. Also referred to as the Notifier.
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operator
One of a number of functions that let you define complex queries or build filter
qualifications. The AR System operators are available through use of the query
bar palette or the filter qualification palette or you can type them in directly.

permissions
Field property setting that allows you to control who can view and change
individual fields of a schema. Permissions are defined for each access control
group. View permission limits group members to reading the contents of a
field. Change permission allows group members to read and write the contents
of a field. See also access control group.

pick list
See selection list.

property
An attribute that is defined. For example, the properties of a field include its
data type, physical characteristics such as length, and whether it is required or
optional.

Public group
One of five special access control groups provided by the AR System. Every
user is automatically a member of this view only group.

pull-right menu
See character menu.

query
Process that lets you select a subset of ARs according to search criteria that you
define and then perform one of several operations on the selected ARs. See also
query operation.

query bar
Part of the Query window, Active Link Qualification window, and the Filter
Qualification window that lets you define complex query criteria. Includes a
palette of operators that you can use in the query you build.

query list
A list that includes a one-line summary of each AR matching a query.

query operation
Action that you can perform on the entries that match the criteria defined in a
query. The possible operations are: Query List, Display, Modify, Report, and
Delete.
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query statement
A complete definition of query criteria constructed in the query bar.

Query window
The User Tool window that lets you search the database for ARs that match
specific criteria and display the results of the search. You also use the Query
window to view or modify an existing AR. See also Submit window.

range
Defines the upper and lower limits of acceptable values. For example, if a
field’s range is -10 to 100, you will be able to enter any number from negative
10 to positive 100 inclusive.

read license
License that allows a user to query the AR System schemas and submit new
ARs but does not allow the user to modify or save data on existing ARs. See
also write license.

real data type
Fields with this data type contain a floating-point number. The range is set by
the administrator.

report format
The layout that you specify when you generate a report from an AR System
query. You can format a report in columns or as a list of records. You can also
choose selected fields to print or print them all. To create a more sophisticated
layout, you can export the report to a file and import the file into a desktop
publishing application.

reserved field
One of a set of fields defined with specific interpretations. You can use these
fields in any schema, if desired.

schema
The definition of the data fields in a database. Each schema represents a
database on an AR System server. The AR System comes with several sample
schemas and you can build as many additional schemas as needed.
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scroll bar
Window element that appears when there is more information to view than
will fit in the window. You use the mouse to slide the scroll bar and shift the
view area. A scroll bar at the bottom of the window lets you move the viewing
area left and right. A scroll bar on the right side of the window lets you move
the viewing area up and down.

selection data type
Fields with this data type present a set of mutually exclusive choices from
which the user is to choose. The selections are displayed as checkbox items or
as options on a menu.

selection list
List that appears as a result of an active link that performs a query that returns
more than one AR. The selection list lets the user pick the appropriate AR.

server
See AR System Server.

status field
Core field that lets you keep a record as an AR moves through the various
stages of the process you are using to resolve ARs. The defined states should
reflect the workflow process.

status history
Information that shows the progress that has been made on an AR. You can
view status history from the Display or Modify window.

Submit window
The User Tool window that lets you enter the appropriate information to create
and submit a new AR. See also Query window.

submitter
The person who submits an action request. The submitter’s name is entered in
the Submitter field.

Submitter group
One of five special access control groups provided by the AR System. This is an
implicit group; users submitting ARs automatically belong to this group and, if
they have a valid AR System license, are granted change access for ARs that
are submitted with their name in the Submitter field.
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support staff
Person or group responsible for resolving action requests. They assign and are
assigned ARs, log their progress in appropriate fields, and use information
stored in previous ARs to help resolve problems.

user default
Value that a user who has customize permission can assign to a field. When the
user sets defaults, the AR System loads this value into the field. When the user
submits an AR, the AR System automatically loads this value into the field
unless the user has entered a different value.

user command
Facility that allows you to invoke an operating system command (or
application capable of being run from an operating system command line)
from the Execute menu of the Query window. Each user can define their own
set of user commands. (User commands are not available from PC or
Macintosh clients.) See also administrator command.

User schema
Schema that lets you add users to the AR System and specify the type of access
each user will have.

User Tool
The part of the AR System that lets users enter new ARs and track them
through the troubleshooting process. Users can also query the database for
ARs that match specified criteria, generate reports, and modify existing ARs
with the User Tool.

user view
What the user sees when they bring up a schema. If users have permission to
customize their views, they are able to change the physical layout and other
properties of the schema and schema fields as they appear for that user.

variable
Data element that changes according to user input. In macros, you can include
variable definitions that will cause the AR System to prompt the user for
certain information when the macro executes.

version
The system release number. To display the version of the AR System that you
are running, select AboutOn Version under the FileHelp menu in the User Tool.
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view layout
The location of fields in a user’s view of a schema.

wild card
Character that you can enter to represent other characters in a search string. In
query statements, for example, you can use wild card characters to match
single characters, strings, or characters within a range or set.

write license
License that allows a user to modify and save data on existing ARs as field and
schema permission settings allow. Write licenses may be either fixed
(permanently attached to a single user) or floating (allocated to users as
required).
See also fixed license, floating license, read license.
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Symbols
!=

not-equal-to relational operator, 66
$DATE$, 50
$DEFAULT$, 50
$GROUP$, 50
$HARDWARE$, 50
$NULL$, 51

default value, 148
$OS$, 51
$SCHEMA$, 51
$SERVER$, 51
$TIME$, 51
$TIMESTAMP$, 51
$USER$, 51
$WEEKDAY$, 51
%

wild card symbol, 67
.Xdefaults, 192
/usr/ar/bin, 169
<

less-than relational operator, 66
<=

less-than-or-equal-to relational
operator, 66

=

equal-to relational operator, 66
>

greater-than relational operator, 66
>=

greater-than-or-equal-to relational
operator, 66

[ ] (brackets)
wild card symbol, 68

[^] (brackets with caret), 68
_ (underscore)

wild card symbol, 67

A
About window, 177
accelerator keys, 16
access

complete, 45
conditional, 45
permissions, 9, 169

see also Administrator’s Guide
access control, 3, 9, 169

customizing views, 150
fields, 45
see also Administrator’s Guide

access permissions, 3
accrue operator in full text searches,

using, 99, 100
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action
default, 9

Action on New Message
Notification Tool property, 174

action request
changing, 92
creating, 43
definition, 22
deleting, 18, 77, 96
displaying, 87
displaying a subset, 87
displaying a summary, 77
editing, 77
history of, 95
listing, 84
modifying, 60, 92
modifying a subset, 92
modifying all selected, 94
modifying individual, 93
modifying multiple, 77
paging through, 88
reviewing, 60
submitting, 42
submitting similar, 94

Action Request System, 1
action requests

definition, 42
Actions menu, 19
active link, 3, 55

and multi-line text, 56
changing properties, 154
example, 57
help, 32
pick list, 57
selection list, 57

active schema list, 17
active window, 9
activities

administrator, 22
user, 22

adding
a diary entry, 95
field names to query bar, 71
user commands, 163

admin commands
executing, 19, 167

administrator
activities, 22
commands, 4

Administrator Tool, 3
see also Administrator’s Guide

administrator’s view, 156
restoring, 156

alerting
users of status of ARs, 3

alignment method, 153
Always prompt for Login

preference, 30
AND logical operator, 72
Anywhere search style, 63
APIs, 6
AR, 198

blank template, 93
AR export format, 106
AR System, 169

administrator activities, 5
management of, 2
tools, 2
users, 1

AR System administrator, 1
AR System sub-administrator, 1
ar_install_dir, 192
ar_run_dir, 9, 169
archived views, 156
ARDATE

dates, 37
environment variable, 37
errors in formatting, 40
examples, 40
field descriptors, 38
time, 37

ARHOME, 34
arHome directory, 21, 33
arimport

resources, 196
arithmetic operator, 73
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ARPATH environment variable, 34
defining, 35

ARs
initiating, 2
resolving, 2
specifying a maximum number of, 84
viewing related to notifications, 172

ARSystem sample files, 192
aruser

syntax options, 187
ascending order, 79

sorting, 115
assigning

action requests, 6
audit trail log file, 175
automatic execution, 55
automatically updating

query list, 86
automating

frequent operations, 6
operations, 134

Available Schemas list, 25
average

statistical operation, 119

B
backup file

view, 158
beeper

see Notification Tool, 3
begin recording a macro, 19
blank AR template, 93
bottom margin of report, 114
box

submission confirmation, 45
button

Next, 88, 92
Poll, 86
Previous, 88, 92
Refresh, 86
Show Status History, 89

C
calling Customer Support, 32, 176
case-sensitive, 9

fields values, 71
changing

action requests, 92
active link properties, 154
ARHOME environment variable, 34
colors and fonts, 192
field properties, 154
key bindings, 27
login information, 20, 170
macro name or description, 144
the current login, 170

character data type, 47
character menus, 47
Chars per Line

report preference, 114
choices

exclusive, 48
circulating

through open windows, 15
Clear All command, 17
clearing

all fields, 28, 29
all query fields, 65
all submit fields, 44
contents of all fields, 17

clicking
on field label, 71

color variables
User Tool, 194

colors
changing, 192
customizing, 192

Column titles report preference, 116
comma separated format, 106
command

Clear All, 17
Copy to Submit, 19, 89, 94
Create Command, 19
Customize Defaults, 19
Customize View, 19
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Delete, 18
Display, 18, 87
Edit Macros, 19
Exit, 17
Goto Query List, 94
Index, 20
List, 18
Login, 16
Modify All, 18, 94
Modify Individual, 18
On Context, 20, 32
On Version, 20, 32, 176
On Window, 20, 32
Open Schema, 16
Open Submit, 14, 16
Preferences, 17
Record Sort Options, 115
Report, 18
Run Admin Command, 19
Run Command, 19
Run Macro, 19
Set to Defaults, 17
Sort Options, 19, 78
Start Recording, 19
Statistics Options, 119
Stop Recording, 19
user, 164

command line
starting tools from, 186
syntax, 186

Command Type
Notification Tool property, 175

commands
creating administrator, 4
Using Help, 31

comments in email, 180
complex

criteria, 65
query operations, 134

compressed text format, 106
conditional access, 45
configuration directory

default location, 169
setting alternate, 33, 175

Confirm to exit AR System
preference, 30

Confirmation upon successful submit
preference, 29

context sensitive help
displaying, 20

control access, 169
controlling

operations, 14
the behavior of the User Tool, 17, 27

conventions, 75
in the AR System, 8
Motif, 8

Copy to Submit command, 19, 89, 94
copying

custom reports, 34
Display window contents, 89, 94
files, 35
macros, 34, 146
user commands, 34
values to a Submit window, 19

copyright information
displaying, 32, 176

count
statistical operation, 119

Create Command command, 19
creating

administrator commands, 4
an action request, 43
custom reports, 104
dynamic menus, 3
macros, 134
reports, 104
static menus, 3
user commands, 19, 162

criteria
complex, 65

CSV format, 106
custom reports

copying, 34
deleting, 129
modifying, 126
saving, 124
sharing, 34
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using, 123, 126
custom view properties, 152
Custom View Properties dialog box, 152
Customer Support

information to supply, 32, 176
Customize Defaults

command, 19
window, 148

Customize View
command, 19

customizing
advanced, 192
colors, 192
default field values, 147
field display length, 155
field label positions, 155
field labels, 155
field type, 155
field visibility, 156
fonts, 192
number of rows, 155
schema layout, 150
the environment, 147
views, 156

access control, 150
x and y field location, 156
your schema view, 19

D
data entry, 49

special, 51
data type, 47, 49

character, 47
date/time, 48
diary, 47
integer, 48
real, 48
selection, 48

database
definition, 3
problem solving, 1
querying, 60
see schemas

date
format, 48
searching for action requests created

after, 67
date format

ARDATE, 37
defining, 40

date/time data type, 48
default

action, 9
configuration directory, 169
directories, 33, 175
file names, 35
search style, 63
value

$NULL$, 148
view

see views
Default Schema View

preferences, 31
default values

hidden fields, 149
loading, 28, 29
setting, 17
specifying, 19, 51

defaults
Query window, 65, 148
Submit window, 44, 148

Define menu, 115
defining

ARDATE environment variable, 40
ARPATH environment variable, 35
default field values, 147
queries, 69
query criteria, 62, 65
report preferences, 112

Delete
command, 18, 96
query operation, 77
window, 97

deleting
a custom report, 129
action requests, 18, 77, 96
macros, 146
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notifications, 173
user commands, 165

descending order, 79, 115
describing

a problem, 14
a support request, 14

de-selecting
query list items, 86

designing
reports, 106

dialog box
Export View, 160

dialog boxes
listing all open, 20

diary data type, 47
diary entries

adding, 95
reviewing, 91
viewing, 91

Diary Entry window, 47, 49, 53, 95
Diary field pop-up icon, 91, 95
directory

ar_config_dir, 148
ar_install_dir, 192
ar_run_dir, 169
arHome, 21, 33
default, 33, 175
home, 33

Display
command, 18, 87
query operation, 77
window, 15, 88

opening, 18
triggering active links, 89
using, 89

displaying
a grid, 153
a schema, 16
a submit footer message, 29
a subset of matching action

requests, 87
a summary of each action request, 77
action requests, 87
action requests as read-only, 77

both a footer and confirmation
message, 29

context sensitive help, 20
copyright information, 32, 176
current window help, 32
environment information, 32, 176
help, 20, 31
help on current field or active link, 32
next action request, 89
previous action request, 89
product version, 32, 176
query bar, 71
reports, 130
search style information, 64
status history, 90
tool name, 32, 176
UNIX manual pages, 33
version number, 32, 176

displaying help
on help, 31

division operator, 73
double quotes

query bar conventions, 75
using, 71

double-click, 8
Double-click action on query

preference, 29
drag, 8
dynamic menus, 3, 47

E
Edit Macros

command, 19
window, 145

Edit menu, 17
editing

action requests, 77
fields, 49
information in a field, 49
macros, 19

electronic mail, see email
email, 178

comments, 180
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entering values in fields, 181
fields and values, 181
header block, 180
mail handler, 179
mail template, 178, 179
responding to submissions, 185
submitting, 183
submitting ARs, 178
template components, 179
using a text editor, 184

email notifications
receiving, 185

empty strings in macros, 144
enabling grid, 153
end user, 2

activities, 4
entering

data in fields, 49
field values using email, 181
help for user commands, 164
information in a field, 49
information in the query bar, 71

environment
customizing, 147
information, 32, 176

environment variable, 176
ARDATE, 37
ARHOME, 34
ARPATH, 34

Equal search style, 63
equal-to, 74

operator, 66
query bar operator, 74

example
active link operation, 57
email template, 181
query statements, 76

examples
ARDATE environment variable, 40

exclusive choices, 48
executing

admin commands, 19, 167
macros, 142
user commands, 19, 165

execution
automatic, 55

Exit command, 17
exiting

Notification Tool, 170
the User Tool, 17, 21

explicit characters
using wild cards, 68

Export View dialog box, 160
exporting statistics, 123

F
field descriptors

ARDATE, 38
fields

access control, 45
and values in email ARs, 181
case-sensitive, 71
changing properties, 154
clearing, 29
clearing all, 28
clearing contents, 17
customizing

labels, 155
layout, 150

customizing default values, 147
data entry, 49
data types, 47
defining default values, 147
editing, 49
filling in, 45
font style, 45
help, 32
hidden default values, 149
keep previous values, 28, 29
label

clicking on, 71
selecting, 70

layout in view, 149
length, 155
narrative history, 53
number of rows, 155
optional, 46
pull-right selection menu, 71
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read only, 45
required, 45
selecting to include in a report, 107
setting default, 65
space sensitive, 71
system-maintained fields, 46
types by typeface, 45

file
audit trail log, 175

File menu, 16
file name extension

.arc, 35, 162

.arq, 35

.arr, 35

.arv, 156
file names

default, 35
file protections

UNIX, 36
files

copying, 35
fill-in aid, 47
filter, 3
fixed license, 12
floating license, 12
font style for fields, 45
fonts

changing, 192
footer of report, 114
format

AR export, 106
comma separated, 106
compressed text, 106
CSV, 106
query bar, 72
time and date, 48

formatting
a report by columns, 109
a report by records, 108
a report to export ARs, 111
a report to use in another

application, 110
conventions

query bar, 71
formatting errors

ARDATE, 40
full text search

accrue operator, using, 99
capabilities, 98
how to, 99
ignore words list, 102
importing data (when to rebuild), 102
licenses, fixed and floating, 98
limits, 101
using, 97
using indexed fields in queries, 99

G
generating

a report, 18, 77, 104
report output, 129
reports, 104
statistics in a report, 119

generic macro, 139
Get Details button, 171
getting

help, 20
started with the User Tool, 7

Goto Query List command, 94
greater-than

operator, 66
query bar operator, 74

greater-than-or-equal-to
operator, 66
query bar operator, 74

grid, 153
grouping report records, 115
groups, see access control and

Administrator’s Guide
guest

privileges, 10
user, 10, 12

H
header
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block (email), 180
of report, 114

Help
using help, 20

help
displaying, 20, 31
for macros, 145
on schema, 20
user commands, 164
using, 20

Help menu, 20
help, using help, 31
hidden field

customizing, 156
default values, 149

hiding
the query bar, 29, 71

history
of action requests, 95
of resolved problems, 6

home directory, 33
horizontal grid, 153

I
iconize windows, 15
ID field, 75
ignore words list

using, 102
Import Tool, 4
importing

rebuilding FTS index after importing
data, 102

Index
command, 20

indicating a range, 68
initiating ARs, 2
integer data type, 48
invalid

password, 12
user name, 12

K
keeping previous field values, 28, 29
key bindings

changing, 27
keyword, 50

$DATE$, 50
$DEFAULT$, 50
$GROUP$, 50
$HARDWARE$, 50
$NULL$, 51
$OS$, 51
$SCHEMA$, 51
$SERVER$, 51
$TIME$, 51
$TIMESTAMP$, 51
$USER$, 51
$WEEKDAY$, 51
in report headers and footers, 114

L
label, 155
label positions

customizing, 155
layout of report

specifying, 108
layout of view, 149
Leading search style, 63
left alignment of fields, 153
left margin of report, 114
length of text field, 155
less-than, 74

operator, 66
query bar operator, 74

less-than-or-equal-to
operator, 66
query bar operator, 74

license, 12
fixed, 12
floating, 12
read, 12

licenses
full text search, 98
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LIKE operator, 73
Lines per Page

report preference, 114
List

command, 18
query operation, 77

listing
action requests, 84
all open windows, 20
most recently used schemas, 17

loading
default values, 29
field default values, 28

local User Tool configuration
information, 34

log file
audit trail, 175

Log Notifications to File
Notification Tool property, 174

logical operators, 71
login

to User Tool, 9
Login command, 16
login information

changing, 20, 170
Login window

Notification Tool, 169
opening, 16
User Tool, 11

M
macros, 134

containing variables, 139
copying, 34, 146
deleting, 146
editing, 19
empty strings in, 144
executing, 19, 142
generic, 139
parameters, 139
powerful, 136
providing help text, 145
recording, 134, 136

recording with a variable, 140
running, 19
running from command line, 189
sharing, 34, 135, 146
start recording, 19
stop recording, 19, 137
supplying variables during

playback, 143
using prompts, 139
variables in, 139

Macros menu, 19
mail

handler, 179
template, 178

making
menu selections, 8, 16
query bar visible, 29

management of the AR System, 2
manual pages

displaying, 33
manually updating

query list, 86
matching

a single character, 67, 68
any string, 67

Max in active schema list
preference, 28

Max in query
preference, 28, 78

maximum
number of ARs, 84
statistical operation, 119

Maximum Notifications in Window
Notification Tool property, 174

menu, 50
Actions, 19
bar, 14
character, 47
creating, 3
Define, 115
dynamic, 47
Edit, 17
File, 16
Help, 20
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Macros, 19
Query, 18, 77
static, 47
Windows, 15, 20

menu items
selecting, 16
User Tool, 16

menu selections
making, 16

Menu Style
preferences, 31

menus
User Tool, 14

minimum
statistical operation, 119

Minutes field, 87
Modify All

command, 18, 94
query operation, 77
window, 15

Modify Individual
command, 18
query operation, 77
window, 15, 93

modifying
a subset of action requests, 92
action requests, 60
all selected action requests, 94
custom report, 126
individual action requests, 93
multiple action requests, 77
report name or help text, 127
user commands, 164

modulo operator, 74
Motif conventions, 8
mouse

using, 8
multi-line text

active links, 56
multiple windows, 14, 15
multiplication operator, 73

N
narrative history field, 53
network management platforms, 6
Next button, 88, 92
non-numeric query bar values, 75
NOT operator, 73
not-equal-to

operator, 66
query bar operator, 74

notice window
Notification Tool, 171

notification
prompt, 168

Notification Log window, 172
Notification Tool, 3, 168, 171

exiting, 170
Get Details button, 171
notice window, 171
Properties window, 174
running multiple, 170
setting properties, 173
starting, 169

Notification Tool property
Action on New Message, 174
Command Type, 175
Log Notifications to File, 174
Maximum Notifications in

Window, 174
Save Notifications between runs, 174

notifications
deleting, 173
log, 172
receiving, 171
reviewing, 172

Notifier
see Notification Tool, 168

NTHOME, 34, 176
default directory, 175

NTSystem sample files, 192
null value, in queries, 189
NULL values in query statements, 75
number

of field rows, 155
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numeric value, 75

O
On Context command, 20, 32
On Version command, 20, 32, 176
On Window command, 20, 32
Open Schema command, 16
Open Submit command, 14, 16
open windows

circulating through, 15
opening

a Display window, 18
a help topic window, 20
a Login window, 16
a Modify All Selected window, 18
a Query List window, 18
a Submit window, 16
multiple submit windows, 42

operation
automating, 134
status, 14

OPERATION keyword, 51
operator

in the query bar, 72
precedence, 74
relational, 65

optional fields, 46
OR logical operator, 73
overriding

search style, 64, 69

P
Page break report preference, 116
page breaks in reports, 114
paging through action requests, 88
parameters in macros, 139
password, 9, 169

invalid, 12
valid, 12

permissions, 9
access, 169
setting access, 3

pick list
in active link, 57

Poll button, 86
pop-up icon

Diary field, 91, 95
position of windows, 8
powerful macros, 136
precedence of query bar operators, 74
precise query, 64
Preferences

command, 17
window, 27

preferences
Always prompt for Login, 30
Confirm to exit AR System, 30
Confirmation upon successful

submit, 29
Default Schema View, 31
defining for reports, 112
Double-click action on query, 29
Max in active schema list, 28
Max in query, 28
Menu Style, 31
Prior to new Query, 28
Prior to new submission, 29
Query Bar, 29
Query window, 103
setting, 27
Submit window, 59
Text Edit/Diary window Apply

action, 30
user, 27

press, 8
Previous button, 88, 92
previous view, 156

restoring, 156
printing

a report, 132
Prior to new Query

preference, 28
Prior to new submission

preference, 29
problem
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history, 6
solving database, 1

program
xrdb, 192

prompt
notification, 168
text, 139

prompting in macros, 139
properties

Notification Tool, 173
pull-right, 8

menus, 50
selection menu, 71
selection menus, 47

Q
queries, from command line, 189
queries, using FTS-indexed fields in, 99
Query

menu, 18
query

defining, 69
precise, 64
recording a macro, 136

Query Bar
preference, 29

query bar, 14, 65
adding field names, 71
arithmetic operator, 73
division operator, 73
entering information, 71
format, 72
formatting conventions, 71
hiding, 29
hiding or displaying, 71
making visible, 29
modulo operator, 74
operators used in, 72
statement, 75
subtraction operator, 73
syntax, 72
using, 69
using wild card symbols, 69

query bar operator, 74
AND, 72
greater-than, 74
greater-than-or-equal-to, 74
less-than-or-equal-to, 74
LIKE, 73
multiplication, 73
NOT, 73
not-equal-to, 74
OR, 73

query criteria
defining, 62, 65
re-displaying, 86, 89, 94
refining, 85

query list
manually updating, 86

query list items
de-selecting, 86
performing another operation on

selected, 86
selecting, 86
selecting multiple, 86

Query List window, 14, 84, 86
opening, 18
returning, 89, 94

Query menu, 77
query operation, 189

complex, 134
Delete, 77
Display, 77
List, 77
Modify All, 77
Modify Individual, 77
Report, 77
sorting order, 82

query results
sorting, 19

query statement examples, 76
Query window, 14, 60

clearing all fields, 65
default values, 65
defaults, 148
preferences, 103
using defaults, 65
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query, using a null value
null values in queries, 189

query-by-example, 60
defining, 62

querying, 60
defining a query-by-example, 62
defining query criteria, 62
for NULL values, 75
general steps, 61
status history, 65, 75
the database, 60
using the query bar, 65

R
radio buttons

using, 50
range

indicating, 68
read license, 12
read-only

displaying action requests as, 77
field, 45

real data type, 48
receiving

email notifications, 185
notifications, 171

Record Sort Options
command, 115

recording
a macro, 134, 136
a macro that performs a query, 136
a macro with variables, 140

re-displaying query criteria, 86, 89, 94
refining query criteria, 85
Refresh button, 86
registered users, 10
relational operators, 65
Report

query operation, 77
Report command, 18
Report Field Sort Order window, 118
Report File window, 131

report footers, 114
report grouping, 117
report headers, 114
Report Layout

window, 107
report layout

by columns, 109
by records, 108
setting, 111
specifying, 108
to export ARs, 111
to use in another application, 110

report output, 129
report preference

Bottom Margin, 114
Chars per Line, 114
Column separator, 114
Column title separator, 114
Column titles, 116
Column titles per, 115
defining, 112
footer, 114
header, 114
Left Margin, 114
Long field format, 114
Page break, 116
Page break per, 114
Record separator, 115
Right Margin, 114
Title, 114
Top Margin, 114

Report Preferences window, 113
Report Print window, 132
report sorting order, 117
Report to Screen window, 130
Report window, 15, 105
Reports, 104
reports

column separator character, 114
column title separator character, 114
column titles, 115
copying, 34
deleting, 129
designing, 106
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displaying, 130
generating, 18, 77, 104
generating statistics, 119
grouping records, 115
Lines per Page preference, 114
modifying, 126
page numbers, 114
printing, 132
record separator character, 115
sending to a file, 130
setting report page setup, 112
sharing, 34, 123
sorting records, 115
using, 126

required fields, 45
resolving ARs, 2
responding to email submissions, 185
restoring

a view backup file, 158
administrator’s view, 156
previous view, 156
views, 156

restricting
unqualified queries, 64

returning
to the Query List window, 89, 94

reviewing
action request, 60
diary entries, 91
notifications, 172
status history, 89

right alignment of fields, 153
right margin of report, 114
Run Admin Command command, 19
Run Command command, 19
Run Macro command, 19
running

admin commands, 19
macros from the command line, 187
multiple instances of a tool, 170
Notification Tool, 169
user commands, 19
User Tool, 10

S
sample files

ARSystem and NTSystem, 192
sample schemas, 23
Save Custom Report Format window, 124
Save Notifications between runs

Notification Tool property, 174
saving

custom reports, 124
schema help

displaying, 20
Schema Item Properties window, 154
schema layout

customizing, 150
schema list

active, 17
Schema List window, 43
schema view

customizing, 19
schemas, 22

displaying, 16
listing most recently used, 17
sample, 23
selecting, 24
setting up, 3

scroll bars, 26, 45
search style

default, 63
information, 64
overriding, 64, 69

searching
for action requests by time, 67
for action requests created after date

or time, 67
the database, 60

selecting, 8
a field label, 70
a menu item, 16
a schema, 24
Administrator View, 161
fields to include in a report, 107
multiple query list items, 86
query list items, 86



233 Action Request System User’s Guide for OSF/Motif—January 1996

selection data type, 48
selection list

in active links, 57
sending

reports to a file, 130
server Information, 17, 26
Set to Defaults, 65

command, 17
setting

access permissions, 3
alternate configuration directory, 175
an alternate configuration

directory, 34
default values, 17
preferences, 27
properties of Notification Tool, 173
query default fields, 65
Query window defaults, 65
report layout, 111
report page setup, 112
submit default fields, 44
up filters and active links, 3

sharing
custom reports, 34, 123
macros, 34, 135, 146
user commands, 34, 162

shortcut key sequences, 16
Show Query button, 86
Show Status History button, 89
showrgb, 192
single character

matching, 67, 68
single quotes

query bar convention, 75
size of windows, 8
Sort Options

command, 19, 78
sorting, 115

in ascending order, 115
query operation results, 79
query results, 19
report records, 115

space sensitive fields values, 71

special characters
column separators, 114

special data entry operations, 51
specifying

a maximum number of ARs, 84
alignment method, 153
criteria by query-by-example, 60
criteria on the query bar, 60
default values, 19, 51
grid settings, 153
report grouping, 117
report layout, 108
report sorting order, 117
statistics, 120
the maximum number of ARs

returned in a query, 28
the maximum number of schemas in

list, 28
Start Recording command, 19
starting

Notification Tool, 169
tools from command line, 186
User Tool, 10

static menus, 3, 47
statistics

exporting, 123
exporting to spreadsheet, 123
specifying, 120

Statistics Options command, 119
Statistics window, 121
status

of actions requests, 6
of operation, 14

status history
querying, 65, 75
reviewing, 89
viewing, 89, 90, 93

Status History window, 90
Stop Recording

command, 19
window, 137

stop recording a macro, 19, 137
stop word list, see ignore words list
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string matching, 67
submission confirmation box, 45
Submit window, 14, 44, 46

clearing all fields, 44
copying values to, 19
default values, 44
defaults, 148
opening, 16
opening multiple, 42
preferences, 59

submitting
action requests, 42, 43, 94
email, 183

subtraction operator, 73
sum

statistical operation, 119
support staff, 1
symbols

wild card, 65
syntax

command line, 186
options for command line, 187
query bar, 72

syntax options
aruser, 187

system-maintained fields, 46

T
template

blank AR, 93
Text Edit window, 47, 49, 52

using, 52
text fill-in aid, 47
time

format, 48
searching for action requests by

time, 67
time format

ARDATE, 37
title

bar, 14
of report, 114

tool

import, 4
tools

Administrator Tool, 3
Notification Tool, 3
User Tool, 2

top margin of report, 114
triggering active links

Display window, 89
truncating

long fields in reports, 114
typing

ALT key and underscored letter, 16
F10 and the underscored letter, 16
information in a field, 49

U
UNIX

commands, 162
file protections, 36
manual pages, 33

unknown user name, 12
unqualified queries

restricting, 64
unregistered users, 10
updating

query list, 86
user commands, 164

adding, 163
copying, 34
creating, 19, 162
deleting, 165
executing, 19, 165
modifying, 164
sharing, 34, 162

User Commands window, 163, 166, 167
user name, 9, 169

invalid, 12
unknown, 12

user preferences, 27
User Tool, 2

color variables, 194
controlling behavior, 17, 27
exiting, 17, 21
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getting started, 7
local configuration information, 34
menu items, 16
menus, 14
starting, 10

users
activities, 4, 22
AR System, 1
AR System administrator, 1
AR System sub-administrator, 1
end user, 2
guest, 10, 12
support staff, 1

user-specified variables, 139
using, 53, 134

a custom report, 126
active links, 55
custom reports, 123
Diary Entry window, 54
double quotes, 71
email tool, 183
keywords, 50
macros, 134
menus, 50
Notification Tool, 168
NULL values when querying, 75
operators in the query bar, 72
pull-right selection menus, 50
query bar, 69
Query List window, 86
quotes in the query bar, 71
radio buttons, 50
the Diary Entry window, 53
the Display window, 89
the mouse, 8
the query bar, 65
the Text Edit window, 52
variables in macros, 139
wild card symbols, 67
wild cards as explicit characters, 68

using full text search, 97
Using Help, 20
using help

commands, 31

V
valid password, 12
value

numeric, 75
value left alignment of fields, 153
value right alignment of fields, 154
variable, environment

ARDATE, 37
variables

empty, 144
environment, 176
in macros, 139
supplying during playback, 143
user-specified, 139

version number
displaying, 32, 176

vertical grid, 153
view backup file

restoring, 158
viewing

ARs related to notifications, 172
diary entries, 91
status history, 89, 90
the status history of an AR, 93

views
administrator’s, 156
customizing, 19, 147
default, 156
layout, 149
restoring, 156

visible field
customizing, 156

W
wild card symbol, 65

- (hyphen), 68
%, 67
[ ] (brackets), 68
[^] (brackets with caret), 68
_ (underscore), 67
in the query bar, 69
using, 67

window
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active, 9
controlling size and position, 8
Customize Defaults, 148
Delete, 97
Diary Entry, 47, 49, 95
Display, 15, 88
Edit Macros, 145
for text editing, 52
help, 32
help topic, 20
iconize, 15
listing all open, 20
Login, 11
Modify All, 15
Modify Individual, 15, 93
multiple, 14, 15
Notification Log, 172
Notification Tool Properties, 174
Query, 13, 14
Query List, 14, 84
Report, 15, 105
Report Field Sort Order, 118
Report File, 131
Report Layout, 107
Report Preferences, 113
Report Print, 132
Report to Screen, 130
Save Custom Report Format, 124
Schema Item Properties, 154
Schema List, 43
server information, 17, 26
Statistics, 121
Status History, 90
Stop Recording, 137
Submit, 14, 44, 46
Text Edit, 47, 49
User Commands, 163, 166, 167
User Preferences, 27

Windows menu, 15, 20
workflow processes, 3
wrapping

long fields in reports, 114

X
xrdb program, 192
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